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Общие сведения
Äàííîå ðóêîâîäñòâî ïðåäíàçíà÷åíî äëÿ îçíàêîìëåíèÿ ñ ðàáîòîé ïðîãðàììíîãî îáåñïå÷åíèÿ P4800. Óïðàâëåíèå ôóíêöèÿìè äàí-
íîãî ïðèáîðà ëåãêî îñóùåñòâëÿåòñÿ ñ ïîìîùüþ ïîëüçîâàòåëüñêîãî èíòåðôåéñà. Äàííîå ïðîãðàììíîå îáåñïå÷åíèå ïîçâîëÿåò áû-
ñòðî êîíôèãóðèðîâàòü âíóòðåííþþ ìàðøðóòèçàöèþ ñèãíàëîâ è çâóêîâóþ îáðàáîòêó. Ñèñòåìíûé P4800 ïðîöåññîð ïðåäíàçíà÷åí
äëÿ ðàáîòû â ìàëûõ è ñðåäíèõ çâóêîóñèëèâàþùèõ ñèñòåìàõ, òðåáóþùèõ ýôôåêòèâíîãî è ãèáêîãî óïðàâëåíèÿ îáåñïå÷èâàåìîãî öè-
ôðîâûì ñèãíàëüíûì ïðîöåññîðîì.

Особенности и возможности
Öèôðîâîé àóäèîïðîöåñcîð P4800 èìååò 4 âõîäà è 8 âûõîäîâ. Ïðîãðàììíûé èíòåðôåéñ ïîëíîñòüþ çàìåíÿåò ýëåìåíòû óïðàâëå-
íèÿ ôðîíòàëüíîé ïàíåëè. Ïðèáîð îáåñïå÷èâàåò 24-áèòíóþ êîíâåðñèþ, ñ ÷àñòîòîé äèñêðåòèçàöèè 48 êÃö è ìèíèìàëüíûé äèíàìè-
÷åñêèé äèàïàçîí 100 äÁ.

Öèôðîâàÿ ïðîöåññîðíàÿ òåõíîëîãèÿ Soundplex îáåñïå÷èâàåò íàèëó÷øèå òåõíè÷åñêèå ïàðàìåòðû è ñòàáèëüíîñòü ñèñòåìû. Ïðî-
öåññîð P4800 îáåñïå÷èâàåò ñîõðàíåíèå îò 16 äî 128 ïîëüçîâàòåëüñêèõ óñòàíîâîê â çàâèñèìîñòè îò ñëîæíîñòè êîíôèãóðàöèé.

Программный интерфейс
Ïðîãðàììíûé èíòåðôåéñ îòîáðàæàåò ôóíêöèîíàëüíûå áëîê-ñõåìû èñïîëüçóåìûå â çâóêîâûõ ñèñòåìàõ, î÷åíü ëåãîê â èçó÷åíèè è
çíàêîì äëÿ ïðîôåññèîíàëîâ çâóêîóñèëåíèÿ.

Ñèñòåìíûå êîíôèãóðàöèè ìîãóò áûòü ïîñòðîåíû è ðåäàêòèðîâàíû íà ýêðàíå êîìïüþòåðíîãî ìîíèòîðà òðàäèöèîííûìè ñïîñîáàìè:
íàæàòèåì êíîïîê ìûøè ñ óñòàíîâêîé êóðñîðà íà îáúåêò, ïåðåòàñêèâàíèåì è òàê äàëåå. Öèôðîâîé àóäèîòðåê èìååò âûñîêóþ ñòåïåíü
ïåðåñòðàèâàåìîñòè áëàãîäàðÿ ìîäóëüíûì ñèãíàëüíûì ïðîöåññîðàì óñòàíàâëèâàåìûì â ëþáîé íåîáõîäèìîé ïîñëåäîâàòåëüíîñòè.

Модульные сигнальные процессоры
Êàæäûé ïðîöåññîðíûé ìîäóëü çàêëþ÷åí â ãðàôè÷åñêèé áëîê, êîòîðûé ìîæåò ïåðåìåùàòüñÿ ñ ïîìîùüþ êîìïüþòåðíîé ìûøè.
Äâîéíîå íàæàòèå ïî èçîáðàæåíèþ áëîêà îòêðûâàåò äîñòóï ê îêíó åãî ïàðàìåòðîâ. Óñòàíîâêè ìîãóò ñîõðàíÿòüñÿ, âûçûâàòüñÿ òðà-
äèöèîííûì îáðàçîì è êîïèðîâàòüñÿ â áëèçêèõ ïî íàçíà÷åíèþ ìîäóëÿõ.

Óñòàíîâêè ïðîöåññîðîâ ìîãóò áûòü òàêæå ñèíõðîíèçèðîâàíû. 

P4800 âêëþ÷àåò â ñåáÿ ñëåäóþùèé íàáîð ñèãíàëüíûõ ïðîöåññîðíûõ ìîäóëåé:

• Öèôðîâîé ïîäàâèòåëü ñàìîâîçáóæäåíèÿ (DFR) 

• Àâòîìàòè÷åñêèé ðåãóëÿòîð óñèëåíèÿ è óðîâíÿ ãðîìêîñòè 

• Îáúåäèíÿåìûé è íåîáúåäèíÿåìûé 10- è 30-ïîëîñíûå ãðàôè÷åñêèå ýêâàëàéçåðû 

• Ìîíî è ñòåðåî êîìïðåññîð/ëèìèòåð ñ ïëàâíî ïåðåñòðàèâàåìûì ïîðîãîì 

• 3 — 10-ïîëîñíûå ïàðàìåòðè÷åñêèå ýêâàëàéçåðû ñ îáðåçíûìè è ïîëî÷íûìè ôèëüòðàìè

• Îáðåçíîé è ïîëî÷íûé ôèëüòðû ñ êðóòèçíîé 24 äÁ/îêòàâó

• 2 — 5-ïîëîñíûå êðîññîâåðû è ñïëèòòåðû

• Ãåéò/ýêñïàíäåð 

Внешнее управление 
Èíñòàëëèðîâàííûé è çàïðîãðàììèðîâàííûé ñèñòåìíûé ïðîöåññîð P4800 ìîæåò óïðàâëÿòüñÿ íå òîëüêî ÷åðåç êîìïüþòåðíûé èí-
òåðôåéñ è MIDI, íî ÷åðåç ðàçúåìû, ðàñïîëîæåííûå íà òûëüíîé ñòîðîíå ïðèáîðà. Âõîäíûå óïðàâëÿþùèå êîíòàêòû ïðåäíàçíà÷åíû
äëÿ ïîäêëþ÷åíèÿ ðàçëè÷íûõ ïåðåêëþ÷àòåëåé è ïîòåíöèîìåòðîâ. Âûõîäíûå óïðàâëÿþùèå êîíòàêòû ìîãóò êîíôèãóðèðîâàòüñÿ äëÿ
èíäèêàöèè âêëþ÷åíèÿ ïðåñåòîâ è ìüþòà. Ê íèì òàêæå ìîãóò áûòü ïîäêëþ÷åíû óïðàâëÿþùèå ðåëå èëè äðóãîå îáîðóäîâàíèå.

Защита пресетных установок
P4800 ñíàáæåí ôóíêöèåé çàùèòû óñòàíîâîê, ïîçâîëÿþùåé ïîëíîñòüþ èñêëþ÷èòü äîñòóï ê èçìåíåíèþ ïàðàìåòðàìè ïîñòîðîííèìè
ëèöàìè. Â ýòîì ñëó÷àå ïàðàìåòðû òåêóùèõ ïðåñåòîâ ìîãóò òîëüêî âèçóàëüíî êîíòðîëèðîâàòüñÿ íà ìîíèòîðå êîìïüþòåðà. Ñ ïîìî-
ùüþ ýòîé ôóíêöèè ìîæåò áûòü òàêæå îãðàíè÷åí äîñòóï ê óïðàâëåíèþ îïðåäåëåííûìè ïàðàìåòðàìè ñ âíåøíèõ óñòðîéñòâ.

Минимальные программные требования для работы P4800
Äëÿ íàäåæíîé ðàáîòû ïðîãðàììíîãî îáåñïå÷åíèÿ Version 3 ïðîöåññîðà P4800 íåîáõîäèìî:

• 20 ìÁ ñâîáîäíîãî ïðîñòðàíñòâà íà æåñòêîì äèñêå

• CD-ROM

• Ìîíèòîð VGA ñ ðàçðåøåíèåì 640 x 480/256 öâåòîâ è âûøå



Ïàðàìåòðû êîìïüþòåðíîãî ïðîöåññîðà è îïåðàòèâíîé ïàìÿòè ìîãóò âàðüèðîâàòüñÿ â çàâèñèìîñòè îò âåðñèè Windows è êîëè÷åñò-
âà èñïîëüçóåìûõ ñîâìåñòíî ïðèëîæåíèé (ïðîãðàìì). Íàïðèìåð èñïîëüçîâàíèå ïðîãðàììíîãî îáåñïå÷åíèÿ äëÿ P4800 îäíîâðå-
ìåííî ñ òàêèìè ïðîäóêòàìè, êàê Smaart èëè TEF ìîæåò ïîòðåáîâàòü áîëåå áûñòðîãî ïðîöåññîðà è áîëüøåé îïåðàòèâíîé ïàìÿòè
äëÿ îïòèìàëüíîé ðàáîòû. Ñëåäóþùèå ìèíèìàëüíûå òðåáîâàíèÿ ê ïàðàìåòðàì êîìïüþòåðà ïðèâåäåíû äëÿ íàäåæíîé ðàáîòû
P4800 áåç èñïîëüçîâàíèÿ äðóãèõ ïðîãðàìì. 

Работа интерфейса
Èíòåðôåéñ èìååò äâà îñíîâíûõ ðåæèìà ðàáîòû: Design è Live, ïðåäñòàâëåííûõ ðàçëè÷íûìè îïöèÿìè, ïîçâîëÿþùèìè êîíôèãóðè-
ðîâàòü P4800 ïðè ïîäêëþ÷åííîì èëè îòêëþ÷åííîì êîìïüþòåðå.

Äëÿ êàæäîãî ðåæèìà ïðåäóñìîòðåíû îïðåäåëåííûå ôóíêöèè, íàçíà÷åíèå êîòîðûõ áóäåò ðàçúÿñíåíî äàëåå â ðóêîâîäñòâå.

Режим Design 
Äàííûé ðåæèì èñïîëüçóåòñÿ äëÿ ñîçäàíèÿ ïðåñåòîâ ñîõðàíÿåìûõ â ïàìÿòè ñèñòåìíîãî ïðîöåññîðà P4800. Äëÿ ðàáîòû äàííîãî
ðåæèìà ïîäêëþ÷åíèå êîìïüþòåðà íåîáÿçàòåëüíî. Ìàðøðóò ïðîõîæäåíèÿ ñèãíàëà ìîæíî ñîõðàíèòü â âèäå ôàéëà ñöåíû â êîìïüþ-
òåðå, âûçâàòü â äàëüíåéøåì è íàïðàâèòü â àïïàðàòíóþ ÷àñòü P4800 ÷åðåç ðàçúåì RS-232. Äàííûé ðåæèì ïîçâîëÿåò ñîçäàâàòü ñ
ïîìîùüþ êîìïüþòåðà ðàçëè÷íûå êîíôèãóðàöèè ïðåñåòîâ íåçàâèñèìî îò íàëè÷èÿ è ïîäêëþ÷åíèÿ ñèñòåìíîãî ïðîöåññîðà P4800.

Режим Live 
Äàííûé ðåæèì ïîçâîëÿåò îñóùåñòâëÿòü ðåãóëèðîâêè è ïåðåóñòàíîâêó ïðåñåòîâ ñèñòåìíîãî ïðîöåññîðà P4800 â ðåæèìå ðåàëüíî-
ãî âðåìåíè. Äëÿ ðàáîòû ðåæèìà íåîáõîäèìî ïîäêëþ÷åíèå êîìïüþòåðà ê ïðèáîðó P4800. Âñå èçìåíåíèÿ ïàðàìåòðîâ òåêóùåãî
ïðåñåòà áóäóò íåìåäëåííî çàïèñàíû â ïàìÿòü ñèñòåìíîãî ïðîöåññîðà P4800.

Режим Preview 
Ïðè ðàáîòå â Live Mode èìååòñÿ âîçìîæíîñòü èíäèâèäóàëüíîãî âûçîâà êàæäîãî ïðåñåòà äëÿ êîððåêöèè â ðåàëüíîì âðåìåíè. Ïðè
âûáîðå ïðåñåòà äëÿ ðàçìåùåíèÿ åãî â ñõåìå ïðîõîæäåíèÿ ñèãíàëà ïîÿâëÿåòñÿ îêíî, â êîòîðîì ïðåäîñòàâëÿåòñÿ âîçìîæíîñòü
ïðåäâàðèòåëüíîãî îáçîðà âûçâàííîãî ïðåñåòà ïåðåä åãî îêîí÷àòåëüíîé óñòàíîâêîé â ñõåìó. Ïðè îòìåíå âûáîðà èëè åãî ðåàëèçà-
öèè ñèñòåìà àâòîìàòè÷åñêè âîçâðàùàåòñÿ â ðåæèì Live.

Основное окно
Îñíîâíîå îêíî ÿâëÿåòñÿ èñõîä-
íûì ðàáî÷èì ïðîñòðàíñòâîì â
ïðîãðàììíîì èíòåðôåéñå. Åãî
ðàçìåðû ìîãóò áûòü ïðîïîðöèî-
íàëüíî èçìåíåíû. Äëÿ âûõîäà
èç ïðîãðàììû íåîáõîäèìî çà-
êðûòü îñíîâíîå îêíî.

1. Ñòðîêà íàçâàíèÿ. Èíôîðìà-
öèÿ, ðàñïîëîæåííàÿ â ñòðîêå
íàçâàíèÿ èçìåíÿåòñÿ â çàâè-
ñèìîñòè îò èñïîëüçóåìîãî ðå-
æèìà. Â ðåæèìå Design çäåñü
ðàñïîëîæåíà èíôîðìàöèÿ:
“P4800: Offline”, à óðîâåíü çà-
ùèòû âûáðàí ïî óìîë÷àíèþ. 
Â ðåæèìå Live â ýòîé ñòðîêå
îòîáðàæàåòñÿ èíôîðìàöèÿ î
ïîäêëþ÷åííîì ïðèáîðå (ðèñó-
íîê íèæå).

Èäåíòèôèêàöèîííûé íîìåð
ïðèáîðà (ID) óêàçûâàåòñÿ â
ñîîòâåòñòâèè ñ óñòàíîâêîé
DIP-ïåðåêëþ÷àòåëåé, ðàñïî-
ëîæåííûõ íà òûëüíîé ñòîðîíå
ïðèáîðà, à íàçâàíèå ïðèáîðà
è óðîâåíü çàùèòû óêàçûâàåò-
ñÿ â ñîîòâåòñòâèè ñ ìåíþ ïðè-
áîðà äîñòóïíûì â ðåæèìå Live.

2. Ãëàâíîå ìåíþ. Íåêîòîðûå îïöèè ìåíþ óêàçûâàþòñÿ â ñîîòâåòñòâèè ñ âûáðàííûì ðåæèìîì è âêëþ÷àþòñÿ òîëüêî ïðè åãî âêëþ÷å-
íèè. Êîíòåêñòíûå ìåíþ òàêæå äîñòóïíû è âûçûâàþòñÿ äâîéíûì íàæàòèåì ïðàâîé êíîïêè ìûøè ïðè óñòàíîâêå êóðñîðà íà ñõåìå
ïðîõîæäåíèÿ ñèãíàëà.

3. Ïàíåëü óïðàâëåíèÿ. Äàííûé ðàçäåë îêíà èçìåíÿåòñÿ â çàâèñèìîñòè îò èñïîëüçóåìîãî ðåæèìà óïðàâëåíèÿ. Â ðåæèìå Live ïà-
íåëü óïðàâëåíèÿ ýìóëèðóåò èçìåðèòåëè ôðîíòàëüíîé ïàíåëè P4800 (ðèñóíîê âíèçó).

Èçìåðèòåëè ìîãóò âêëþ÷àòüñÿ è îò-
êëþ÷àòüñÿ íàæàòèåì ïî íèì ëåâîé
êíîïêè ìûøè èëè âûáîðîì 
View > Enable I/O Meters â ãëàâíîì
ìåíþ.
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Â ðåæèìå Preview, êàê ïîêàçàíî íà ðèñóíêå íèæå, óïðàâëÿþùàÿ ïàíåëü ïðåäîñòàâëÿåò âîçìîæíîñòü âûáîðà ïðåñåòîâ äëÿ ââî-
äà. Ïðè ñáðîñå äàííîé îïåðàöèè îñóùåñòâëÿåòñÿ àâòîìàòè÷åñêèé âîçâðàò ê òåêóùåìó ïðåñåòó.

4. Êíîïêà Live Mode. Íàæàòèåì äàííîé êíîïêè îñóùåñòâëÿåòñÿ âêëþ÷åíèå ðåæèìà Live, ïîçâîëÿþùåãî ïðåäâàðèòåëüíî îçíàêî-
ìèòüñÿ ñ ëþáûì ñîõðàíåííûì â P4800 ïðåñåòîì è ðåäàêòèðîâàòü åãî. Äëÿ ðàáîòû ðåæèìà íåîáõîäèìî, ÷òîáû êîìïüþòåð áûë
ïîäêëþ÷åí ê ñèñòåìíîìó ïðîöåññîðó P4800.

5. Êíîïêà Design Mode. Íàæàòèåì äàííîé êíîïêè îñóùåñòâëÿåòñÿ âêëþ÷åíèå ðåæèìà Design. Ïðåñåò, èñïîëüçîâàâøèéñÿ â ðå-
æèìå Live îñòàíåòñÿ ââåäåííûì â ñõåìó ïðîõîæäåíèÿ ñèãíàëà è ìîæåò ñëóæèòü øàáëîíîì äëÿ ñîçäàíèÿ íîâûõ ïðåñåòîâ, ñî-
õðàíÿåìûõ â P4800.

6. Èíôîðìàöèîííîå îêíî. Çäåñü îòîáðàæàåòñÿ äåòàëüíàÿ èíôîðìàöèÿ (íàçâàíèå, äàòà ïîñëåäíåãî ñîõðàíåíèÿ è îïèñàíèå) î ïðå-
ñåòå èëè ôàéëå ñöåíû âûâåäåííîì íà ýêðàí. Â ðåæèìå Live Mode, ïðè îòêðûòèè ñòðîêè íàçâàíèÿ ïðåñåòà ïîÿâëÿåòñÿ âåñü ñïèñîê
ïðåñåòîâ ñîõðàíåííûõ â P4800. 

7. Êíîïêà Store Preset. Äàííàÿ êíîïêà äîñòóïíà òîëüêî â ðåæèìå Design. Îíà ïîçâîëÿåò ñîõðàíèòü òåêóùóþ ñõåìó ïðîõîæäåíèÿ
ñèãíàëà â P4800 â âèäå ïðåñåòà.

8. Êíîïêà Recall Preset. Äàííàÿ êíîïêà äîñòóïíà òîëüêî â ðåæèìå Design. Åå íàæàòèåì ïðåñåò ñèñòåìíîãî ïðîöåññîðà P4800
ââîäèòñÿ â ñõåìó ïðîõîæäåíèÿ ñèãíàëà.

9. Êíîïêà Save As. Íàæàòèåì äàííîé êíîïêè ìîæíî ñîõðàíèòü òåêóùóþ ñõåìó ïðîõîæäåíèÿ ñèãíàëà è åå óñòàíîâêè â âèäå ôàéëà
ñöåíû.

10. Êíîïêà Open. Äàííàÿ êíîïêà äîñòóïíà òîëüêî â ðåæèìå Design. Åå íàæàòèåì îñóùåñòâëÿåòñÿ ââîä ïàðàìåòðîâ ôàéëà ñöåíû â
ñõåìó ïðîõîæäåíèÿ ñèãíàëà.

11. Ñõåìà ïðîõîæäåíèÿ ñèãíàëà. Äàííàÿ ñõåìà ïîêàçûâàåò ìàðøðóò ïðîõîæäåíèÿ àóäèîñèãíàëà (ñëåâà íàïðàâî, îò âõîäà ê âû-
õîäó) ÷åðåç ðàçëè÷íûå îáðàáîòêè ñèñòåìíîãî ïðîöåññîðà P4800. Êàæäàÿ êàíàëüíàÿ ëèíåéêà ñîäåðæèò ôèêñèðîâàííûå êîìïî-
íåíòû äëÿ ðåãóëèðîâêè óñèëåíèÿ è ìèêñèíãà. Çäåñü òàêæå ïðåäóñìîòðåíû íåçàïîëíåííûå âèðòóàëüíûå ñëîòû äëÿ óñòàíîâêè
ðàçëè÷íûõ òèïîâ ìîäóëüíûõ ïðîöåññîðîâ.

12. Âõîäíàÿ êàíàëüíàÿ ëèíåéêà. Âõîäíûå êàíàëüíûå ëèíåéêè ñîîòâåòñòâóþò ÷åòûðåì âõîäíûì êàíàëàì ñèñòåìíîãî ïðîöåññîðà
P4800. Êàæäàÿ ëèíåéêà âìåùàåò â ñåáÿ äî 5 ðàçëè÷íûõ îáðàáîòîê.

13. Íàçâàíèå âõîäíîãî êàíàëà. Îòîáðàæàåò íàçâàíèå êàíàëà âûáðàííîãî â îêíå ÷óâñòâèòåëüíîñòè âõîäà.

14. Áëîê âõîäíîãî óñèëåíèÿ. Âõîäíîé êàñêàä óñèëèòåëüíîé ñòðóêòóðû ñèñòåìíîãî ïðîöåññîðà P4800. Ïðè äâîéíîì íàæàòèè ëå-
âîé êíîïêè ìûøè ïî äàííîìó áëîêó îòêðûâàåòñÿ îêíî ÷óâñòâèòåëüíîñòè âõîäà ïðåäëàãàþùåãî ñëåäóþùèå îïöèè: âûáîð ÷óâñò-
âèòåëüíîñòè â øêàëàõ –10dBV/+4dBu, ìüþòèðîâàíèå êàíàëà, èçìåíåíèå ïîëÿðíîñòè è ôåéäåðíóþ ðåãóëèðîâêó óðîâíÿ ñèãíàëà
â ïðåäåëàõ +/–30 äÁ äëÿ êàæäîãî âõîäíîãî êàíàëà. Çäåñü òàêæå ìîæíî ïðèñâîèòü íàçâàíèÿ âõîäíûì êàíàëàì.

15. Èíäèêàòîð ðåæèìà. Äàííûé èíäèêàòîð îòîáðàæàåò íàçâàíèå èñïîëüçóåìîãî ðåæèìà â ñõåìå ïðîõîæäåíèÿ ñèãíàëà.

16. Ñåëåêòîðû âõîäà. Íàæàòèåì íà ïðîíóìåðîâàííûé ñåëåêòîð îñóùåñòâëÿåòñÿ àâòîìàòè÷åñêîå ïîäêëþ÷åíèå ëèíåéêè êàæäîãî
âûõîäíîãî êàíàëà ê ñîîòâåòñòâóþùåé ìèêøåðíîé òî÷êå ëèíåéêè âõîäíîãî êàíàëà. 

17. Ìàòðè÷íûé ìèêøåð. Ïðîìåæóòî÷íîå çâåíî óñèëèòåëüíîé ñòðóêòóðû P4800. Ïðè äâîéíîì íàæàòèè íà ýòîò áëîê îòêðûâàåòñÿ
îêíî ìàòðè÷íîãî ìèêøåðà, ãäå ìîæíî ìàðøðóòèçèðîâàòü ñèãíàë îò ëþáîé âõîäíîé ëèíåéêè ê ëþáîé âûõîäíîé êàíàëüíîé ëè-
íåéêå è óñòàíîâèòü ôåéäåðàìè îòíîñèòåëüíûå óðîâíè ñèãíàëîâ. Â äàííîì îêíå ïðåäóñìîòðåíû îòäåëüíûå çàêëàäêè äëÿ êàæ-
äîé âûõîäíîé êàíàëüíîé ëèíåéêè ãäå îòîáðàæåíû ðåãóëÿòîðû óñèëåíèÿ, ïåðåêëþ÷àòåëè ïîëÿðíîñòè è ìüþòèðîâàíèÿ äëÿ ïîä-
êëþ÷åííîé âõîäíîé êàíàëüíîé ëèíåéêè.

18. Íîìåðà êàíàëîâ. Äàííûå íîìåðà ñîîòâåòñòâóþò ÷åòûðåì âõîäíûì è âîñüìè âûõîäíûì êàíàëàì P4800.

19. Ìèêøåðíûå òî÷êè. Íàæàòèåì íà äàííûå òî÷êè îñóùåñòâëÿåòñÿ ñîåäèíåíèå âõîäíûõ è âûõîäíûõ êàíàëüíûõ ëèíååê. Ïîÿâëÿþ-
ùèåñÿ ìåæäó òî÷êàìè ñîåäèíèòåëüíûå ëèíèè îçíà÷àþò ïðîõîæäåíèå ñèãíàëà. Êàæäàÿ âõîäíàÿ êàíàëüíàÿ ëèíåéêà ìîæåò áûòü
ñîåäèíåíà ñ ëþáîé âûõîäíîé ëèíåéêîé.

20. Âèðòóàëüíûé ñëîò. Äàííûå ñëîòû ñëóæàò äëÿ ðàçìåùåíèÿ ðàçëè÷íûõ ïðîöåññîðíûõ ìîäóëåé, êîòîðûå óñòàíàâëèâàþòñÿ ìå-
òîäîì ïåðåòàñêèâàíèÿ èç èíñòðóìåíòàëüíîé ïàíåëè ñ ïîìîùüþ îïöèè Add Processor â ãëàâíîì ìåíþ èëè êîíòåêñòíîì ìåíþ
(îòêðûâàåìîì íàæàòèåì ïðàâîé êíîïêè ìûøè).

21. Áëîê âûõîäíîãî óñèëåíèÿ. Âûõîäíîé êàñêàä óñèëèòåëüíîé ñòðóêòóðû P4800. Ïðè äâîéíîì íàæàòèè íà ýòîò áëîê îòêðûâàåòñÿ
îêíî âûõîäíîãî óñèëåíèÿ, îáåñïå÷èâàþùåãî ñëåäóþùèå îïöèè: âûáîð óñèëåíèÿ â øêàëàõ -10dBV/+4dBu, ìüþòèðîâàíèå êàíà-
ëà, âûáîð ïîëÿðíîñòè, àòòåíþàöèþ –20 äÁ è ôåéäåðíóþ ðåãóëèðîâêó ãðîìêîñòè â ïðåäåëàõ +/-30 äÁ äëÿ êàæäîãî âûõîäíîãî
êàíàëà. Çäåñü òàêæå ìîæíî ïðèñâàèâàòü íàçâàíèÿ âûõîäíûì êàíàëàì.

22. Íàçâàíèå âûõîäíîãî êàíàëà. Çäåñü îòîáðàæàåòñÿ íàçâàíèå âûõîäíîãî êàíàëà, ïðèñâîåííîå â îêíå áëîêà âûõîäíîãî óñèëåíèÿ.

23. Âûõîäíàÿ êàíàëüíàÿ ëèíåéêà. Êàæäàÿ âûõîäíàÿ ëèíåéêà ìîæåò âìåñòèòü äî øåñòè ìîäóëåé è ñîîòâåòñòâóåò îäíîìó èç
âîñüìè âûõîäíûõ êàíàëîâ ñèñòåìíîãî ïðîöåññîðà P4800. 

24. Ìüþòèðîâàíèå âñåõ âõîäîâ. Íàæàòèåì íà ýòîò ïåðåêëþ÷àòåëü ìüþòèðóþòñÿ âñå âõîäíûå êàíàëû.

25. Ìüþòèðîâàíèå âñåõ âûõîäîâ. Íàæàòèåì íà ýòîò ïåðåêëþ÷àòåëü ìüþòèðóþòñÿ âñå âûõîäíûå êàíàëû.

26. Èçìåðèòåëü èñïîëüçîâàíèÿ ðåñóðñîâ DSP. Äàííûé èçìåðèòåëü ïðåäíàçíà÷åí äëÿ èíäèêàöèè îáúåìà çàäåéñòâîâàííûõ ñè-
ñòåìíûõ ðåñóðñîâ P4800 â äàííîé êîíôèãóðàöèè â ïðîöåíòíîì ñîîòíîøåíèè. 

27. Èçìåðèòåëü ïàìÿòè çàäåðæêè. Äàííûé èçìåðèòåëü ïðåäíàçíà÷åí äëÿ èíäèêàöèè îáúåìà çàäåéñòâîâàííîé ïàìÿòè çàäåðæ-
êè òðåáóåìîé äëÿ ðàáîòû ïðîöåññîðîâ çàäåðæêè çàäåéñòâîâàííûõ â òåêóùåé ñõåìå ïðîõîæäåíèÿ ñèãíàëà. 
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Инструментальная панель
Èíñòðóìåíòàëüíàÿ ïðîöåññîðíàÿ ïàíåëü ïîÿâëÿåòñÿ ðÿäîì ñ îñíîâíûì îêíîì ïðè
âêëþ÷åíèè ïðîãðàììû. Â ýòîì îêíå îòîáðàæàåòñÿ áèáëèîòåêà ïðîöåññîðíûõ ìîäó-
ëåé, êîòîðûå ìîãóò áûòü ïåðåíåñåíû è óñòàíîâëåíû â ïóñòûå âèðòóàëüíûå ñëîòû.
Äàííîå îêíî ìîæåò áûòü ðàçäâèíóòî ïî âåðòèêàëè ïåðåíîñîì íèæíåé ãðàíèöû. 

Вызов и закрытие
Èíñòðóìåíòàëüíàÿ ïðîöåññîðíàÿ ïàíåëü âñåãäà íàõîäèòñÿ ïîâåðõ îñòàëüíûõ îêîí
ïðîãðàììû. Çàêðûòèå ïàíåëè èíñòðóìåíòîâ îñóùåñòâëÿåòñÿ íàæàòèåì êíîïêè â
ïðàâîì âåðõíåì óãëó ñòîêè íàçâàíèÿ. Äëÿ âûçîâà ïàíåëè âûáåðèòå 
View > Show Processor Toolbox â ãëàâíîì ìåíþ. 

Процессорные модули
Ïðîöåññîðíûå ìîäóëè ïðåäñòàâëåíû â èíñòðóìåíòàëüíîé ïàíåëè â âèäå áëîêîâ.
Ïîñëå ðàçìåùåíèÿ ìîäóëåé â ñõåìå ïðîõîæäåíèÿ ñèãíàëà äîñòóï ê èõ ïàðàìåò-
ðàì îñóùåñòâëÿåòñÿ äâîéíûì íàæàòèåì íà èçîáðàæåíèå áëîêà.

Подключение P4800 и обзор его функций 
Ìíîãèå èç îïèñàííûõ íèæå øàãîâ ìîæíî îñóùåñòâèòü áåç ïîäêëþ÷åíèÿ P4800. Ñîõðàíåííûå â êîìïüþòåðå óñòàíîâêè ìîæíî ïîç-
æå çàãðóçèòü â ñèñòåìíûé ïðîöåññîð. Òåì íå ìåíåå, â öåëÿõ ïîëíîãî îçíàêîìëåíèÿ ñ ðàáîòîé è âîçìîæíîñòÿìè ñèñòåìíîãî ïðî-
öåññîðà P4800 äàëåå ïîäðàçóìåâàþòñÿ ñëåäóþùèå óñëîâèÿ:

• P4800 ïîäêëþ÷åí ê êîìïüþòåðó

• Èíñòàëëÿöèÿ âêëþ÷àåò â ñåáÿ âîçìîæíîñòü âíåøíåãî óïðàâëåíèÿ

• Òðåáóåòñÿ çàùèòà ïàðàìåòðîâ P4800

Установка программного обеспечения 
Åñëè ïðîãðàììíîå îáåñïå÷åíèå, íåîáõîäèìîå äëÿ ðàáîòû P4800 íå óñòàíîâëåíî, ñëåäóéòå ïðèâåäåííîé íèæå èíñòðóêöèè.

Установка программного обеспечения с CD
1. Óñòàíîâèòå CD â CD-ROM êîìïüþòåðà.

2. Åñëè óñòàíîâêà ïðîãðàììû íà÷íåòñÿ àâòîìàòè÷åñêè ñëåäóéòå ïîÿâëÿþùèìñÿ íà ýêðàíå óêàçàíèÿì.

Åñëè àâòîìàòè÷åñêàÿ óñòàíîâêà ïðîãðàììû íå íà÷íåòñÿ:

1. Íàæìèòå êíîïêó Start íà èíñòðóìåíòàëüíîé ïàíåëè Windows è âûáåðèòå Run íà ïîÿâèâøåìñÿ ìåíþ.

2. Íàáåðèòå ñòðîêó "D:\setup" (ãäå "D" — CD-ROM êîìïüþòåðà).

3. Íàæìèòå OK è ñëåäóéòå èíñòðóêöèÿì èíñòàëëÿöèîííîé ïðîãðàììû.

Ïðè çàãðóçêå êîïèè íàéäèòå ôàéë ñ ðàñøèðåíèåì ".exe" ñ ïîìîùüþ Windows Explorer è îòêðîéòå åãî. Äàëåå ñëåäóéòå èíñòðóê-
öèÿì èíñòàëëÿöèîííîé ïðîãðàììû.

Установка коммуникаций
1. Ïîäêëþ÷èòå ïîðò COM êîìïüþòåðà ê ðàçúåìó RS-232, ðàñïîëîæåííîìó íà òûëüíîé ñòîðî-

íå P4800.

2. Âêëþ÷èòå ïðîãðàììó.

3. Âûáåðèòå ïîðò COM îäíèì èç ñëåäóþùèõ ñïîñîáîâ:

à. Âûáåðèòå Devices>Select COM Port â ãëàâíîì ìåíþ.

á. Îòêðîéòå ñïèñîê âñåõ äîñòóïíûõ ïîðòîâ COM, êàê ïîêàçàíî íà ðèñóíêå ñïðàâà.

â. Âûáåðèòå ïîðò COM, ê êîòîðîìó ïîäêëþ÷åí âûõîä RS-232 ñèñòåìíîãî ïðîöåññîðà è
íàæìèòå OK.

4. Âêëþ÷èòå ðåæèì Live:

à. Íàæìèòå êíîïêó Live Mode íà ïàíåëè óïðàâëåíèÿ îñíîâíîãî îêíà.

á. Îòêðîåòñÿ äèàëîãîâîå îêíî Select Devices ñî ñïèñêîì âñåõ äîñòóïíûõ ïðèáîðîâ (ñìîòðè
ðèñóíîê ñïðàâà). Èäåíòèôèêàöèîííûé íîìåð êàæäîãî ïðèáîðà ïîêàçàí ñëåâà â ñïèñêå è
óñòàíàâëèâàåòñÿ ïåðåêëþ÷àòåëÿìè DIP, ðàñïîëîæåííûìè íà òûëüíîé ñòîðîíå.

â. Âûáåðèòå ñèñòåìíûé ïðîöåññîð è íàæìèòå Connect.

ã. Ïðîãðàììíûé èíòåðôåéñ ïåðåêëþ÷èòñÿ â ðåæèì Live, ïðè ýòîì ñõåìà ïðîõîæäåíèÿ ñèã-
íàëà è èçìåðèòåëè óðîâíÿ îêðàñÿòñÿ â ñèíèé öâåò.

5. Ïðèñâîåíèå íàçâàíèÿ ïðèáîðó

à. Âûáåðèòå Devices>Name Device â ãëàâíîì ìåíþ.

á. Îòêðîåòñÿ äèàëîãîâîå îêíî Name Devices, êàê ïîêàçàíî íà ðèñóíêå ñïðàâà.

â. Ââåäèòå èìÿ ïðèáîðà, ñîñòîÿùåå íå áîëåå ÷åì èç 15 ñèìâîëîâ è íàæìèòå Name.

ã. Èìÿ ïðèáîðà ïîÿâèòñÿ â ñòðîêå çàãîëîâêà îñíîâíîãî îêíà â ðåæèìå Live Mode.

Конфигурирование внешнего управления
Â ñëó÷àå ïîäêëþ÷åíèÿ âíåøíèõ óñòðîéñòâ óïðàâëåíèÿ íåîáõîäèìî ñêîíôèãóðèðîâàòü P4800 äëÿ ðàñïîçíàâàíèÿ âíåøíèõ êîíòðîë-
ëåðîâ. Êîíôèãóðàöèÿ ñîõðàíÿåòñÿ â ïàìÿòè è äîëæíà áûòü îñóùåñòâëåíà ïåðåä ñîçäàíèåì ïðåñåòîâ. Êîíôèãóðàöèÿ ìîæåò áûòü
ñîçäàíà ïðè îòêëþ÷åííîì P4800 è çàãðóæåíà â íåãî ïîçæå ÷åðåç ðàçúåì RS-232.

Íèæå îïèñàí ïðîöåññ êîíôèãóðàöèè:

1. Âêëþ÷èòå ðåæèì Design íàæàòèåì êíîïêè Design Mode, ðàñïîëîæåííîé íà ïàíåëè óïðàâëåíèÿ îñíîâíîãî îêíà.

2. Ñêîíôèãóðèðóéòå óïðàâëÿþùèå êîíòàêòû. Äëÿ ýòîãî âûáåðèòå Devices>Control Pin Configuration â îñíîâíîì ìåíþ, ïîñëå ÷åãî
îòêðîåòñÿ îêíî Control Pins. Íà÷íèòå ñ óñòàíîâêè êîëè÷åñòâà óïðàâëÿåìûõ ïðåñåòîâ è òèï êîäèðîâêè èñïîëüçóåìîé äëÿ èõ ïåðå-
êëþ÷åíèÿ. Çàòåì îïðåäåëèòå îñòàëüíûå ôóíêöèè.
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3. Ñîõðàíèòå óñòàíîâêè â ñèñòåìíîì ïðîöåññîðå P4800 èëè êîìïüþòåðå. Äëÿ ýòîãî âûáåðèòå Configuration>Store to Device èëè
Configuration>Save to PC â ìåíþ.

Ïðèìå÷àíèå: Åñëè òðåáóåòñÿ îñóùåñòâèòü ïåðåêëþ÷åíèå ïðåñåòîâ ñ êîìïüþòåðíîãî èíòåðôåéñà ïîñëå êîíôèãóðàöèè óïðàâëÿþ-
ùèõ êîíòàêòîâ, íåîáõîäèìî ñíà÷àëà îòêëþ÷èòü óñòàíîâëåííûå ñîåäèíåíèÿ â îêíå Control Pins.

Создание шаблона схемы прохождения сигнала
Ñîçäàíèå øàáëîíà ìîæåò îñóùåñòâëÿòüñÿ â ðåæèìå Live èëè Design. Ïðè ñîõðàíåíèè íåñêîëüêèõ ïðåñåòîâ â P4800 ìîæíî ñýêîíî-
ìèòü ìíîãî âðåìåíè ïðè èñïîëüçîâàíèè øàáëîíà, ñîäåðæàùåãî âñå íåîáõîäèìûå îáùèå àòðèáóòû. Øàáëîí ìîæåò âûçûâàòüñÿ èç
P4800 èëè îòêðûâàòüñÿ êàê êîìïüþòåðíûé ôàéë ñöåíû, ðåäàêòèðîâàòüñÿ è çàòåì ñîõðàíÿòüñÿ â âèäå íîâîãî ïðåñåòà.

1. Ïðèñâîåíèå íàçâàíèÿ âõîäíûì è âûõîäíûì êàíàëàì. Äâîéíûì íàæàòèåì íà âõîäíîé èëè âûõîäíîé áëîêè óñèëåíèÿ îò-
êðîéòå îêíî ïàðàìåòðîâ è ââåäèòå èìÿ êàíàëà â ñòðîêå, ðàñïîëîæåííîé ïîä ðåãóëÿòîðîì óñèëåíèÿ. 

2. Ðàçìåùåíèå ìîäóëåé â ñõåìå. Ðàçìåñòèòå íåîáõîäèìûå ìîäóëè â ñõåìå ïðîõîæäåíèÿ ñèãíàëà ìåòîäîì ïåðåòàñêèâàíèÿ èç
ïðîöåññîðíîé ïàíåëè èíñòðóìåíòîâ. 

3. Ñîçäàíèå îáúåäèíåííûõ ãðóïï. Íàæàòèåì ïðàâîé êíîïêè ìûøè ïðè íàæàòîé êíîïêå CTRL âûáåðèòå ïðîöåññîðû îäíîãî òè-
ïà êîòîðûìè íåîáõîäèìî îäíîâðåìåííî óïðàâëÿòü ïðè ðàáîòå ñî ñòåðåîïàðàìè, àêóñòè÷åñêèìè êëàñòåðàìè, çîíàëüíûìè ñèñ-
òåìàìè è òàê äàëåå. Òàêèì æå îáðàçîì ìîæíî îñóùåñòâèòü îáúåäèíåííîå óïðàâëåíèå óñèëåíèåì äëÿ êîíòðîëÿ çà îáùåé ãðîì-
êîñòüþ ñèñòåìû.

4. Óñòàíîâêà âûõîäíîãî óðîâíÿ. Äâîéíûì íàæàòèåì íà âûõîäíîé áëîê óñèëåíèÿ îòêðîéòå îêíî Output Gain. Ñíèçüòå âûõîäíîå
óñèëåíèå êàæäîãî êàíàëà äî –30 äÁ äëÿ ïðåäîòâðàùåíèÿ ïðîõîæäåíèÿ ñèãíàëà íåäîïóñòèìî âûñîêîãî óðîâíÿ ÷åðåç ñèñòåìó.
Åñëè âûõîäíûå êàíàëû îáúåäèíåíû, òî èõ âûõîäíîé óðîâåíü ìîæíî èçìåíèòü ôåéäåðîì îäíîãî êàíàëà.

5. Ìàðøðóòèçàöèÿ ñèãíàëà ìåæäó âõîäíûì è âûõîäíûì êàíàëîì. Ñîåäèíåíèå îñóùåñòâëÿåòñÿ íàæàòèåì è ïåðåòàñêèâàíè-
åì âûõîäíîé òî÷êè âõîäíîé ëèíåéêè ê âõîäíîé òî÷êå âûõîäíîé ëèíåéêè ÷åðåç ìàòðè÷íûé ìèêøåð.

6. Óñòàíîâêà ïàðàìåòðîâ ìîäóëüíîãî ïðîöåññîðà. Äâîéíûì íàæàòèåì íà áëîê îòêðîéòå îêíî ïàðàìåòðîâ ïðîöåññîðà è ïðî-
èçâåäèòå íóæíûå ðåãóëèðîâêè. Ïðè ðàáîòå â ðåæèìå Design Mode, ñîõðàíåííûå ïàðàìåòðû ìîãóò áûòü çàãðóæåíû â P4800
ïîçæå. 

7. Êàðòà ñîåäèíåíèé óïðàâëÿþùèõ êîíòàêòîâ. Êàæäûé ïðåñåò äîëæåí ñîäåðæàòü êàðòó ñîåäèíåíèé óïðàâëÿþùèõ êîíòàêòîâ ñ
âíåøíèìè óñòðîéñòâàìè. Äëÿ åå ñîçäàíèÿ îòêðîéòå îêíî Control Pin è âûáåðèòå ïóíêò, ðàñïîëîæåííûé ïîñëå âõîäíûõ è âûõîä-
íûõ êàíàëîâ ê êîòîðûì áóäóò àäðåñîâàíû ñîåäèíåíèÿ. 

8. Áëîêèðîâàíèå ïðîöåññîðîâ ñ îáåñïå÷åíèåì òîëüêî äîñòóïà äëÿ ÷òåíèÿ. Äàííàÿ
ôóíêöèÿ äîñòóïíà òîëüêî ïîñëå óñòàíîâêè ïàðàìåòðîâ çàùèòû äëÿ êîíå÷íîãî ïîëüçîâàòå-
ëÿ. Ïàðàìåòðû çàùèòû ñîõðàíÿþòñÿ â êàæäîì ïðîöåññîðíîì ìîäóëå íà óðîâíå ïðåñåòà.
Âûáåðèòå ìîäóëüíûé ïðîöåññîð, ïàðàìåòðû êîòîðîãî íå äîëæåí èçìåíÿòü êîíå÷íûé ïîëü-
çîâàòåëü è çàòåì âûáåðèòå Security>Level 2>Lock Selected â ãëàâíîì ìåíþ. 

9. Ïðèñâîåíèå íàçâàíèÿ ïðåñåòó. Íàæàòèåì ëåâîé êíîïêè ìûøè íà èíôîðìàöèîííûé áëîê
â öåíòðå ïàíåëè óïðàâëåíèÿ îòêðîéòå äèàëîãîâîå îêíî ïðåñåòíîé èíôîðìàöèè (Preset
Information), êàê ïîêàçàíî íà ðèñóíêå ñïðàâà. Ââåäèòå íàçâàíèå ïðåñåòà (äî 15 ñèìâîëîâ)
è åãî îïèñàíèå. Çàòåì íàæìèòå OK. 

10. Ñîõðàíåíèå ñîçäàííîãî ïðåñåòà â P4800. Ïðè ðàáîòå â ðåæèìå Live ïðåñåò àâòîìàòè÷åñêè ñîõðàíÿåòñÿ â P4800. Äëÿ ñî-
õðàíåíèÿ ïðåñåòà â ðåæèìå Design íàæìèòå êíîïêó Store Preset íà ïàíåëè óïðàâëåíèÿ â ãëàâíîì îêíå. Äóáëèêàöèÿ ïðåñåòà
ïðîèçâîäèòñÿ â ðåæèìå Design ïîâòîðíûì íàæàòèåì êíîïêè [Store Preset]. Òàêèì îáðàçîì ìîæíî ñîçäàòü ëþáîå êîëè÷åñòâî
äóáëèêàòîâ ïðåñåòîâ.

11. Àêòèâàöèÿ ôóíêöèè âíåøíåãî óïðàâëåíèÿ. Äëÿ âêëþ÷åíèÿ ôóíêöèè âíåøíåãî óïðàâëåíèÿ îòêðîéòå îêíî Control Pins è àêòè-
âèðóéòå åå.

Обеспечение защиты
1. Äëÿ óñòàíîâêè çàùèòû âêëþ÷èòå P4800 â ðåæèì Live (åñëè ñèñòåìà íàõîäèòñÿ â ðåæèìå Design íàæìèòå êíîïêó Live Mode íà

ïàíåëè óïðàâëåíèÿ îñíîâíîãî îêíà).

2. Âûáåðèòå Security>Set Password â ãëàâíîì ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ äèàëîãîâîå îêíî ñîçäàíèÿ ïàðîëÿ (Create Password).
Íàáåðèòå ïàðîëü è ïîäòâåðäèòå åãî. Ïî îêîí÷àíèè ïðîöåäóðû íàæìèòå OK.

3. Âûáåðèòå Security>Set Level â ãëàâíîì ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ äèàëîãîâîå îêíî óñòàíîâêè óðîâíÿ çàùèòû (Set Security).
Âûáåðèòå òðåáóåìûé óðîâåíü äîñòóïà äëÿ êîíå÷íîãî ïîëüçîâàòåëÿ è íàæìèòå OK.

Создание конфигураций
Êîíôèãóðàöèÿ âêëþ÷àåò â ñåáÿ îïðåäåëåííóþ êîìáèíàöèþ ìàðøðóòèçàöèè ñèãíàëà, ïîçèöèîíèðîâàíèå ìîäóëüíûõ ïðîöåññîðîâ è
èõ ïàðàìåòðû. Ñîçäàíèå êîíôèãóðàöèè îñóùåñòâëÿåòñÿ â îñíîâíîì îêíå è ñîõðàíÿåòñÿ â P4800 è â êîìïüþòåðå.

ССттррууккттуурраа  ууссииллеенниияя
Ñèñòåìíûé ïðîöåññîð P4800
ïðåäóñìàòðèâàåò ðåãóëèðîâêó
óñèëåíèÿ íà òðåõ ñòàäèÿõ ïðî-
õîæäåíèÿ ñèãíàëà: âõîäíîå óñè-
ëåíèå, ìàòðè÷íûé ìèêøåð è âû-
õîäíîå óñèëåíèå. Íåîáõîäèìî
âíèìàòåëüíî ðàçîáðàòüñÿ ñî
ñòðóêòóðîé óñèëåíèÿ ïðîöåññî-
ðà äëÿ ïðåäîòâðàùåíèÿ âûõîäà
èç ñòðîÿ ïîäêëþ÷åííîãî ê âûõî-
äàì P4800 îáîðóäîâàíèÿ. 
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Ñîåäèíåíèå âõîäíîãî
è âûõîäíîãî êàíàëîâ

Ðåãóëèðîâêà óðîâíÿ 
ñèãíàëà ïîñëå åãî 
êîíâåðòàöèè è äî 

ïðîöåññîðíîé îáðàáîòêè 

Ìàðøðóòèçàöèÿ ñèãíàëà
îò âõîäíîãî êàíàëà ê 

âûõîäíîìó

Çàêëþ÷èòåëüíàÿ ðåãóëèðîâêà
îáðàáîòàííîãî ñèãíàëà ïåðåä 

êîíâåðòàöèåé 



Входное усиление
Ïðè äâîéíîì íàæàòèè ìûøè íà ëþáîé áëîê âõîäíîãî óñèëåíèÿ (Input Gain) îòêðûâàåòñÿ îêíî åãî ïàðàìåòðîâ, ñîäåðæàùåå ðåãóëÿ-
òîðû óðîâíÿ âñåõ ÷åòûðåõ âõîäíûõ êàíàëîâ. Çäåñü òàêæå ïðåäóñìîòðåíà óñòàíîâêà ïîëÿðíîñòè è âîçìîæíîñòü ìàðêèðîâêè êàæäîé
âõîäíîé ëèíåéêè 

Ïðèìå÷àíèå: Íåäîïóñòèìî âûñîêèé óðîâåíü ñèãíàëà ìîæåò ïðèâåñòè ê çàïèðàíèþ âõîäíîãî ÀÖ-êîíâåðòåðà. Ïðèåìëåìûé óðî-
âåíü âõîäíîãî ñèãíàëà â ýòîì ñëó÷àå óñòàíàâëèâàåòñÿ íà èñòî÷íèêå.

Ïîñëå âõîäíîãî óñèëèòåëüíîãî ìîäóëÿ ñèãíàë ïîñòóïàåò â öåïü ïîñëåäîâàòåëüíî ñîåäèíåííûõ ìîäóëüíûõ ïðîöåññîðîâ âõîäíîé
ëèíåéêè è äàëåå îí ïîïàäàåò íà ìèêøåðíóþ òî÷êó, ãäå ìîæåò áûòü íàçíà÷åí íà ëþáîé âõîä âûõîäíîé ëèíåéêè èëè íà âñå ëèíåéêè
îäíîâðåìåííî ÷åðåç ìàòðè÷íûé ìèêøåð.

Матричный микшер
Ïîñëå òîãî, êàê ñèãíàë áûë íàçíà÷åí íà îïðåäåëåííóþ âûõîäíóþ ëèíåéêó îí ïîñòóïàåò â êàñêàä óñèëåíèÿ ìàòðè÷íîãî ìèêøåðà.
Äâîéíûì íàæàòèåì íà ëþáîé ìèêøåðíûé áëîê îòêðûâàåòñÿ îêíî ìàòðè÷íîãî ìèêøåðà, ãäå ïðåäóñìîòðåíà ðåãóëèðîâêà ïîëÿðíîñ-
òè è óðîâíåé ñèãíàëîâ íàçíà÷åííûõ íà âûõîäíûå ëèíåéêè. Ïîñëå ìàòðè÷íîãî ìèêøåðà ñèãíàë ïîñòóïàåò â öåïü ïîñëåäîâàòåëüíî
ñîåäèíåííûõ ïðîöåññîðíûõ ìîäóëåé, íàçíà÷àåìûõ ïîëüçîâàòåëåì è çàòåì â áëîê âûõîäíîãî óñèëåíèÿ.

Выходное усиление
Ýòî ôèíàëüíàÿ ñòàäèÿ ðåãóëèðîâêè óñèëåíèÿ â P4800. Äâîéíûì íàæàòèåì íà áëîê âûõîäíîãî óñèëåíèÿ îòêðûâàåòñÿ îêíî åãî ïàðà-
ìåòðîâ, ãäå âîçìîæíà ðåãóëèðîâêà óñèëåíèÿ, ïîëÿðíîñòè è âêëþ÷åíèå îïöèîíàëüíîãî àòòåíþàòîðà -20 äÁ íà êàæäîì êàíàëå.
Çäåñü òàêæå ìîæíî îñóùåñòâèòü ìàðêèðîâêó âûõîäíîé ëèíåéêè.

Ïîñëå ïðîõîæäåíèÿ áëîêà âûõîäíîãî óñèëåíèÿ ñèãíàë ïîñòóïàåò íà ÖÀ-êîíâåðòåð è äàëåå íà àóäèîâûõîä ïðèáîðà.

Мьютирование каналов
Ïðåäóñìîòðåíî íåñêîëüêî âàðèàíòîâ ìüþòèðîâàíèÿ
âõîäíûõ è âûõîäíûõ êàíàëîâ ñèãíàëüíîãî ïðîöåññîðà
P4800. Ìüþòèðîâàííûå êàíàëû èìåþò ñîîòâåòñòâóþ-
ùóþ ìàðêèðîâêó â ñõåìå ïðîõîæäåíèÿ ñèãíàëà (ñìîòðè
òàáëèöó ñïðàâà).

Мьютирование всех входов или выходов
Ïðîèçâîäèòñÿ ñëåäóþùèìè ñïîñîáàìè:

• Íàæàòèåì ïåðåêëþ÷àòåëÿ ìüþòèðîâàíèÿ âñåõ âõîäîâ èëè âûõîäîâ, ðàñïîëîæåííîãî â íèæíåé ÷àñòè îñíîâíîãî îêíà.

• Âûáîðîì Processor>Mute All Inputs èëè Processor>Mute All Outputs â ìåíþ.

• Îòêëþ÷åíèå ïèòàíèÿ P4800 òàêæå ìüþòèðóåò âñå åãî âûõîäû.

Мьютирование индивидуальных каналов
1. Äâîéíûì íàæàòèåì ëåâîé êíîïêè ìûøè îòêðîéòå îêíî áëîêà âõîäíîãî óñèëåíèÿ, ìàòðè÷íîãî ìèêøåðà èëè âûõîäíîãî óñèëåíèÿ.

2. Íàæìèòå êíîïêó ìüþòèðîâàíèÿ ñîîòâåòñòâóþùåãî êàíàëà.

3. Íà áëîêå ïîÿâèòñÿ êðàñíàÿ ìàðêèðîâêà "M", îçíà÷àþùàÿ òî, ÷òî êàíàë çàìüþòèðîâàí.

Присвоение названия входным и выходным каналам
Ïðè ñîçäàíèè íîâûõ ôàéëîâ ñöåí âõîäû íå èìåþò íàçâàíèé. Ïðèñâîåííûå íàçâàíèÿ ñîõðàíÿþòñÿ â äàëüíåéøåì âìåñòå ñ ïðåñåòà-
ìè èëè ôàéëàìè ñöåí.

Äëÿ èçìåíåíèÿ íàçâàíèÿ êàíàëà:

1. Íàæìèòå äâàæäû íà êàíàëüíûé áëîê óñèëåíèÿ.

2. Â îòêðûâøåìñÿ îêíå íàéäèòå ñòðîêó íàçâàíèÿ êàíàëà.

3. Ââåäèòå íàçâàíèå êàíàëà (íå áîëåå 15 ñèìâîëîâ).

4. Çàêðîéòå îêíî.

Маршрутизация сигнала
Создание соединений в схеме прохождения сигнала
Ïðåäóñìîòðåíû ñëåäóþùèå íàèáîëåå ïðîñòûå ñïîñîáû ñîåäèíåíèÿ âõîäíûõ è âûõîäíûõ êàíàëîâ ñ ïîìîùüþ ìûøè.

Íàæàòèå íà ìèêøåðíóþ òî÷êó:

1. Íàæìèòå íà ìèêøåðíóþ òî÷êó âõîäíîãî êàíàëà.

2. Èçîáðàæåíèå êóðñîðà èçìåíèòñÿ. Ýòî çíà÷èò, ÷òî íåîáõîäèìî íàçíà÷èòü ñîîòâåòñòâóþùóþ ìèêøåðíóþ òî÷êó âûõîäíîãî êàíàëà.

3. Íàæìèòå íà âûáðàííóþ òî÷êó âûõîäíîãî êàíàëà.

Ïðèìå÷àíèå: Îòìåíèòü äàííóþ ïðîöåäóðó ïîñëå âûáîðà ìèêøåðíîé òî÷êè âõîäíîãî êàíàëà ìîæíî íàæàòèåì êëàâèøè Esc êëàâèàòóðû.

Ïåðåòàñêèâàíèå:

1. Íàæìèòå íà ìèêøåðíóþ òî÷êó âõîäíîãî êàíàëà è ïåðåòàùèòå åå íà òðåáóåìóþ òî÷êó âûõîäíîãî êàíàëà ñ ïîìîùüþ ìûøè.

2. Ìåæäó äâóìÿ òî÷êàìè ïîÿâèòñÿ ëèíèÿ, ñèìâîëèçèðóþùàÿ ñîåäèíåíèå. 

Ïðèìå÷àíèå: ëèíèÿ ãîðèò çåëåíûì öâåòîì ïðè àêòèâàöèè äàííîãî ñîåäèíåíèÿ.

3. Îòïóñòèòå êíîïêó ìûøè.

Íàæàòèå íà ñåëåêòîðû âõîäîâ:

1. Íàæìèòå íà ïðîíóìåðîâàííûé ñåëåêòîð âõîäà âûõîäíîãî êàíàëà äëÿ ñîåäèíåíèÿ ñ ñîîòâåòñòâóþùèì âõîäíûì êàíàëîì.

2. Ìåæäó ìèêøåðíûìè òî÷êàìè ïîÿâèòñÿ ñîåäèíèòåëüíàÿ ëèíèÿ, à ñåëåêòîð âõîäà îñòàíåòñÿ âûäåëåííûì.

Создание соединений в матричном микшере
Ñîçäàíèå áîëåå êîìïëåêñíûõ ñîåäèíåíèé ìîæåò òàêæå îñóùåñòâëÿòüñÿ â îêíå ìàòðè÷íîãî ìèêøåðà. Äëÿ ýòîãî:

1. Îòêðîéòå îêíî ìàòðè÷íîãî ìèêøåðà äâîéíûì íàæàòèåì ìèêøåðíîãî áëîêà íóæíîãî âûõîäíîãî êàíàëà.

2. Â îòêðûâøåìñÿ îêíå íàæìèòå êíîïêó íàïðîòèâ âûáðàííîãî âõîäíîãî êàíàëà äëÿ ñîçäàíèÿ ñîåäèíåíèÿ.
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Âõîäíîé áëîê
óñèëåíèÿ 

Âõîäû 3 è 4
íà ìàòðè÷íûé

ìèêøåð

Âûõîä ìàòðè÷íîãî
ìèêøåðà

Âûõîäû 
êðîññîâåðà



3. Ìåæäó ìèêøåðíûìè òî÷êàìè íàçíà÷åííûõ êàíàëîâ ïîÿâèòñÿ ñîåäèíèòåëüíàÿ ëèíèÿ. Ñåëåêòîð âõîäà áóäåò âûäåëåí äëÿ êàæäîãî
àêòèâíîãî ñîåäèíåíèÿ.

Отмена соединений
Îòìåíà ñîåäèíåíèé ìîæåò îñóùåñòâëÿòüñÿ ñëåäóþùèìè ñïîñîáàìè:

• Íàæìèòå îäèí ðàç íà ñîåäèíèòåëüíóþ ëèíèþ è íàæìèòå êëàâèøó Delete êëàâèàòóðû.

• Íàæìèòå îäèí ðàç íà ñåëåêòîð âõîäà âûõîäíîãî êàíàëà. Ýòî îòêëþ÷èò ñîåäèíåíèå.

• Íàæìèòå îäèí ðàç íà ñîåäèíèòåëüíóþ ëèíèþ. Íàæàòèåì ïðàâîé êíîïêè ìûøè îòêðîéòå êîíòåêñòíîå ìåíþ è ñ åãî ïîìîùüþ îò-
êëþ÷èòå ñîåäèíåíèå.

Ïðèìå÷àíèå: âûáîð íåñêîëüêèõ ëèíèé îñóùåñòâëÿåòñÿ ïðè íàæàòîé êëàâèøå Ctrl êëàâèàòóðû.

Èíôîðìàöèîííàÿ ïàíåëü, ðàñïîëîæåí-
íàÿ â öåíòðå ïàíåëè óïðàâëåíèÿ îñíîâ-
íîãî îêíà ñîäåðæèò ñâåäåíèÿ î ïðåñåòå
èëè ôàéëå ñöåíû.

Íàçâàíèå ââîäèìîå çäåñü, ÿâëÿåòñÿ íà-
çâàíèåì ïðåñåòà (ïðè ñîõðàíåíèè â P4800) è íàçâàíèåì ôàéëà ñöåíû (ïðè ñîõðàíåíèè â êîìïüþòåðå). Ñâåäåíèÿ î ïðåñåòàõ è
ôàéëàõ ìîãóò ïðè íåîáõîäèìîñòè áûòü èçìåíåíû â ðåæèìå Live èëè Design.

Äëÿ ïðèñâîåíèÿ íàçâàíèÿ:

1. Îäíèì íàæàòèåì ëåâîé êíîïêè ìûøè â îáëàñòè èíôîðìàöèîííîé ïàíåëè îòêðîéòå èíôîð-
ìàöèîííîå äèàëîãîâîå îêíî.

2. Ââåäèòå íàçâàíèå (íå áîëåå 15 ñèìâîëîâ) è îïèñàíèå ôàéëà (íå áîëåå 80 ñèìâîëîâ).

3. Íàæìèòå OK.

Конфигурирование модульных процессоров
Ïðåäóñìîòðåíî äâà óðîâíÿ êîíôèãóðèðîâàíèÿ ìîäóëüíûõ ïðîöåññîðîâ: óñòàíîâêà ðàçëè÷íûõ
òèïîâ ïðîöåññîðîâ â ïðåäåëàõ ñõåìû ïðîõîæäåíèÿ ñèãíàëà è óñòàíîâêà ïàðàìåòðîâ êàæäîãî âûáðàííîãî ïðîöåññîðà (äâîéíîå
íàæàòèå ïî ìîäóëüíîìó áëîêó). 

Типы процессоров
Â P4800 èìååòñÿ äâà òèïà ïðîöåññîðîâ óñòàíàâëèâàåìûõ â ñõåìó ïðîõîæäåíèÿ ñèãíàëà: ìîäóëüíûå è ôèêñèðîâàííûå. Îñíîâíûì
îòëè÷èåì ìåæäó íèìè ÿâëÿåòñÿ òî, ÷òî ôèêñèðîâàííûå ïðîöåññîðû ÿâëÿþòñÿ ÷àñòüþ óñèëèòåëüíîé ñòðóêòóðû P4800 è ïîýòîìó ÿâ-
ëÿþòñÿ íåîòúåìëåìîé ÷àñòüþ êàæäîé êîíôèãóðàöèè. Ìîäóëüíûå æå ïðîöåññîðû óñòàíàâëèâàþòñÿ â áëîêè ñõåìû â ñîîòâåòñòâèè ñ
êîíêðåòíûìè òðåáîâàíèÿìè.

Фиксированные процессоры
Ê ôèêñèðîâàííûì ïðîöåññîðàì îòíîñÿòñÿ áëîêè ìèêøåðîâ è óñèëåíèÿ, ðàñïîëîæåííûå âî âõîäíûõ è âûõîäíûõ ëèíåéêàõ. Îíè íå
ìîãóò áûòü óäàëåíû, ñêîïèðîâàíû èëè ïåðåìåùåíû. Òåì íå ìåíåå ôèêñèðîâàííûå ïðîöåññîðû ìîãóò áûòü îáúåäèíåíû, à èõ ïà-
ðàìåòðû ìîãóò ñîõðàíÿòüñÿ è âûçûâàòüñÿ ïðè íåîáõîäèìîñòè. 

Модульные процессоры
Ìîäóëüíûå ïðîöåññîðû ìîãóò áûòü ñêîïèðîâàíû, óäàëåíû è ðàçìåùåíû â ëþáûõ ñâîáîäíûõ ñëîòàõ (èñêëþ÷àÿ êðîññîâåðû è
ñïëèòòåðû). Êàæäûé ìîäóëüíûé ïðîöåññîð ôóíêöèîíèðóåò íåçàâèñèìî îò äðóãèõ. Èçìåíèòü óñòàíîâêè ìîäóëüíîãî ïðîöåññîðà
ìîæíî îòêðûâ îêíî åãî ïàðàìåòðîâ, çà èñêëþ÷åíèåì ñèòóàöèé, êîãäà ìîäóëü èñïîëüçóåòñÿ êàê îäèí êàíàë ñòåðåîïàðû èëè ÿâëÿåò-
ñÿ ñîñòàâíîé ÷àñòüþ îáúåäèíåííîé ãðóïïû ìîäóëåé.

Добавление процессоров
Êàæäàÿ êàíàëüíàÿ ëèíåéêà èìååò íåñêîëüêî ñëîòîâ, ïðåäíàçíà÷åííûõ äëÿ óñòàíîâêè áëîêîâ ìîäóëüíûõ ïðîöåññîðîâ. Ìîäóëüíûå ïðî-
öåññîðû (çà èñêëþ÷åíèåì êðîññîâåðîâ è ñïëèòòåðîâ) ìîãóò ïîâòîðÿòüñÿ è óñòàíàâëèâàòüñÿ â ñëîòû â ëþáûõ ïîñëåäîâàòåëüíîñòÿõ. 

Íåçàïîëíåííûå ñëîòû íå îêàçûâàþò âîçäåéñòâèÿ íà ñèãíàë è íå èìåþò ïàðàìåòðîâ íàñòðîéêè 

Óñòàíîâëåííûé â ñëîò ìîäóëüíûé ïðîöåññîð èìååò íàñòðîéêè ïî óìîë÷àíèþ, êîòîðûå ìîãóò áûòü èçìåíåíû â îêíå ïàðàìåòðîâ
êàæäîãî ìîäóëÿ. Ïðè êîïèðîâàíèè èëè ïåðåìåùåíèè â äðóãîé ñëîò ìîäóëüíîãî ïðîöåññîðà åãî óñòàíîâêè ñîõðàíÿþòñÿ. 

Установка модульных процессоров
Ìîäóëüíûå ïðîöåññîðû ìîãóò äîáàâëÿòüñÿ â ñõåìó ïðîõîæäåíèÿ ñèãíàëà ñ èñïîëüçîâà-
íèåì ïðîöåññîðíîé ïàíåëè èíñòðóìåíòîâ èëè ìåíþ êîìàíä. 

Установка с помощью процессорной панели инструментов
Îñóùåñòâëÿåòñÿ íàçíà÷åíèåì ïðîöåññîðíîãî áëîêà èç ïðîöåññîðíîé ïàíåëè èíñòðó-
ìåíòîâ ñ ïîìîùüþ ìûøè. Âèä êóðñîðà ìåíÿåòñÿ â çàâèñèìîñòè îò òîãî, íà êàêîì îáúåê-
òå îí íàõîäèòüñÿ (ñìîòðè ðèñóíîê ñïðàâà).

Âûáîð è íàçíà÷åíèå ïðîöåññîðíîãî ìîäóëÿ îñóùåñòâëÿþòñÿ îäíèì èç ñëåäóþùèõ ñïîñîáîâ:

• Óñòàíîâèòå êóðñîð íà ìîäóëü è íàæìèòå ëåâóþ êíîïêó ìûøè. Ïåðåòàùèòå ìîäóëü íå îòïóñêàÿ êíîïêó â íóæíûé ñëîò ñõåìû. Óñòà-
íîâèâ êóðñîð â íåîáõîäèìîå ìåñòî îòïóñòèòå êíîïêó ìûøè.

Èëè

• Óñòàíîâèòå êóðñîð íà ïðîöåññîðíûé ìîäóëü, ðàñïîëîæåííûé â ïàíåëè èíñòðóìåíòîâ è íàæìèòå îäèí ðàç ëåâóþ êíîïêó ìûøè.
Äàëåå óñòàíîâèòå êóðñîð íà íåîáõîäèìûé ïóñòîé ñëîò è íàæìèòå ëåâóþ êíîïêó åùå ðàç.

Ïðèìå÷àíèå: Äëÿ îòìåíû êîìàíäû âûáîðà ìîäóëüíîãî ïðîöåññîðà äî åãî óñòàíîâêè â ïóñòîé ñëîò íàæìèòå êíîïêó Esc.
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Èíôîðìàöèîííàÿ ïàíåëüПрисвоение названия пресету или файлу сцены

Ìåñòî äëÿ óñòàíîâêè
ïðîöåññîðà 

Íåäîïóñòèìîå ðàñïîëîæåíèå 
äëÿ âûáðàííîãî ïðîöåññîðà



Установка с помощью меню команд
Óñòàíîâêà îäíîãî ìîäóëüíîãî ïðîöåññîðà:

1. Óñòàíîâèòå êóðñîð íà ïóñòîé ñëîò è íàæìèòå ëåâóþ êíîïêó ìûøè îäèí ðàç.

2. Íàæàòèåì ïðàâîé êíîïêè ìûøè îòêðîéòå êîíòåêñòóàëüíîå ìåíþ è âûáåðèòå íóæíûé ïðîöåññîð.

Èëè

3. Èñïîëüçóéòå îïöèþ äîáàâëåíèÿ ïðîöåññîðîâ Processor>Add â ãëàâíîì ìåíþ.

Óñòàíîâêà íåñêîëüêèõ ìîäóëüíûõ ïðîöåññîðîâ îäíîãî òèïà:

Ïðåèìóùåñòâîì âûáîðà ïðîöåññîðà èç ìåíþ êîìàíä ÿâëÿåòñÿ òî, ÷òî â ðàçëè÷íûå ñëîòû îäíîé ñõåìû ïðîõîæäåíèÿ ñèãíàëà ìîãóò
áûòü óñòàíîâëåíû ïðîöåññîðû îäíîãî òèïà ñ ïîìîùüþ îäíîé êîìàíäû. Äëÿ ýòîãî:

1. Ïðè íàæàòîé êíîïêå Ctrl âûáåðèòå ìûøüþ íåîáõîäèìûå ïóñòûå ñëîòû.

2. Íàæàòèåì ïðàâîé êíîïêè ìûøè îòêðîéòå êîíòåêñòóàëüíîå ìåíþ è íàçíà÷üòå ïðîöåññîðû îäíîãî òèïà â êàæäûé èç âûáðàííûõ
ïóñòûõ ñëîòîâ.

Èëè 

3. Èñïîëüçóéòå îïöèþ äîáàâëåíèÿ ïðîöåññîðîâ Processor>Add â ãëàâíîì ìåíþ.

Стереопроцессоры
Ñòåðåîïðîöåññîðû ðàçìåùàþòñÿ â ñõåìàõ òàêèì æå îáðàçîì, êàê
è äðóãèå ìîäóëüíûå ïðîöåññîðû. Êàæäûé êàíàë ñòåðåîïðîöåññî-
ðà ãðàôè÷åñêè èçîáðàæåí â âèäå îòäåëüíîãî ìîäóëÿ. Äëÿ äîñòóïà
ê ïàðàìåòðàì îáîèõ êàíàëîâ óñòàíîâèòå êóðñîð íà îäèí èç áëîêîâ
è íàæìèòå äâàæäû ëåâóþ êíîïêó ìûøè.

Установка стереопроцессора с использованием процессорной панели инструментов:
1. Óñòàíîâèòå êóðñîð íà íóæíûé ïðîöåññîðíûé áëîê è íàæìèòå ëåâóþ êíîïêó ìûøè. Íà

ðèñóíêàõ â ïðèâåäåííîé òàáëèöå ïðåäñòàâëåí âèä êóðñîðà ïîñëå âûáîðà ñòåðåîïðî-
öåññîðà.

2. Äîáàâüòå ïåðâûé êàíàë ñòåðåîïàðû ñëåäóþùèìè ñïîñîáàìè:

Ìåòîäîì "ïåðåòàñêèâàíèÿ" ïåðåíåñèòå ïðîöåññîðíûé áëîê èç ïðîöåññîðíîé ïàíå-
ëè èíñòðóìåíòîâ â ñõåìó ïðîõîæäåíèÿ ñèãíàëà. 

Èëè

Íàæìèòå îäèí ðàç ëåâóþ êíîïêó ìûøè óñòàíîâèâ êóðñîð íà íóæíûé ñòåðåîïðîöåññîð ïàíåëè èíñòðóìåíòîâ è çàòåì ïîâòîðèòå
íàæàòèå óñòàíîâèâ êóðñîð íà ñîîòâåòñòâóþùèé ïóñòîé ñëîò ñõåìû.

3. Çàòåì ðàçìåñòèòå âòîðîé êàíàë ïðîöåññîðà óñòàíîâèâ êóðñîð íà ñîîòâåòñòâóþùèé ïóñòîé ñëîò è íàæàâ îäèí ðàç ïðàâóþ êíîïêó
ìûøè.

Установка стереопроцессора с использованием меню:
1. Îäíèì íàæàòèåì ëåâîé êíîïêè ìûøè ïðè íàæàòîé êëàâèøå Ctrl âûáåðèòå ïóñòûå ñëîòû â äâóõ ðàçëè÷íûõ êàíàëàõ.

2. Íàæàòèåì ïðàâîé êíîïêè îòêðîéòå êîíòåêñòíîå ìåíþ è ïîìåñòèòå îáà êàíàëà ñòåðåîïðîöåññîðà â âûáðàííûå ñëîòû.

Èëè

Èñïîëüçóéòå îïöèþ äîáàâëåíèÿ ïðîöåññîðîâ Processor>Add â ãëàâíîì ìåíþ.

Кроссоверы и сплиттеры
Ïîñêîëüêó êðîññîâåðû è ñïëèòòåðû ÿâëÿþòñÿ èñêëþ÷èòåëüíî âûõîäíûìè ïðîöåññîðàìè, òî îíè ìîãóò óñòàíàâëèâàòüñÿ òîëüêî â
âûõîäíîé êàíàëüíîé ëèíåéêå ñ ó÷åòîì ñëåäóþùåãî:

• Ïðè óñòàíîâêå êðîññîâåðà èëè ñïëèòòåðà íåîáõîäèìî ïðåäóñìàòðèâàòü äîñòàòî÷íîå êîëè÷åñòâî âûõîäîâ.

• Äëÿ êðîññîâåðîâ èëè ñïëèòòåðîâ ìîãóò èñïîëüçîâàòüñÿ òîëüêî ñîñåäíèå âûõîäû.

• Íà âñåõ çàäåéñòâîâàííûõ êðîññîâåðîì èëè ñïëèòòåðîì âûõîäíûõ êàíàëüíûõ ëèíåéêàõ âõîäíûå ìèêøåðíûå òî÷êè è ñëîòû àâòî-
ìàòè÷åñêè îòêëþ÷àþòñÿ (êðîìå ñàìîé âåðõíåé). 

• Ðàçìåùåíèå äðóãèõ ïðîöåññîðîâ è ñîåäèíåíèå ìèêøåðíûõ òî÷åê îñóùåñòâëÿåòñÿ ïîñëå óñòàíîâêè êðîññîâåðîâ èëè ñïëèòòåðîâ.

Замена модульных процессоров
Â êàæäîì ñëîòå ìîæåò ðàçìåùàòüñÿ òîëüêî îäèí ïðîöåññîð. Äëÿ çàìåíû íåîáõîäèìî óäàëèòü óñòàíîâëåííûé ïðîöåññîð è çàòåì
íàçíà÷èòü íîâûé ìåòîäàìè îïèñàííûìè âûøå.

Управление ресурсами DSP (цифровой сигнальной обработки)
Размещение ресурсов
Ïðè óñòàíîâêå áîëüøîãî êîëè÷åñòâà ïðîöåññîðîâ â êàíàëüíûõ ëèíåéêàõ íåîáõîäèìî ñòðåìèòñÿ ê òîìó, ÷òîáû êàæäûé èç ïðîöåñ-
ñîðîâ çàíèìàë ìèíèìàëüíîå êîëè÷åñòâî îáùèõ ïðîöåññîðíûõ ðåñóðñîâ íåîáõîäèìîå äëÿ âûïîëíåíèÿ çàäà÷è.

Íàïðèìåð, ïðè óñòàíîâêå 10-ïîëîñíîãî ïàðàìåòðè÷åñêîãî ýêâàëàéçåðà â êàíàëüíóþ ëèíåéêó áóäóò èñïîëüçîâàíû ðåñóðñû íåîáõî-
äèìûå äëÿ ðàáîòû âñåõ 10 ôèëüòðîâ íåçàâèñèìî îò êîëè÷åñòâà èñïîëüçóåìûõ ïîëîñ. È â ýòîì ñëó÷àå, åñëè èñïîëüçóåòñÿ òîëüêî
òðè ïîëîñû ïðîöåññîð áóäåò èñïîëüçîâàòü íåîïðàâäàííî âûñîêèé óðîâåíü ðåñóðñîâ. 

Память задержки
Ñèñòåìíûé ïðîöåññîð P4800 èìååò áóôåðíóþ ïàìÿòü, îáåñïå÷èâàþùóþ äî 20 ñåê ñóììàðíîé çàäåðæêè ñèãíàëà. Ðàçëè÷íûå ïðî-
öåññîðíûå ìîäóëè èìåþò ðàçíîå ìàêñèìàëüíîå âðåìÿ çàäåðæêè Ê ïðèìåðó, åñëè òðåáóåòñÿ çàäåðæêà 45 ìñåê íå ñòîèò èñïîëüçî-
âàòü ïðîöåññîð ñ ìàêñèìàëüíûì âðåìåíåì çàäåðæêè 2 ñåê. Òàêæå êàê è â ñëó÷àå ñ ýêâàëàéçåðîì, íåïðàâèëüíî ïîäîáðàííûé ïðî-
öåññîð çàäåðæêè áóäåò èñïîëüçîâàòü ëèøíþþ ïàìÿòü çàäåðæêè.
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Ïðåäóñìîòðåíû ñëåäóþùèå òèïû ñòåðåîïðîöåññîðîâ:

Ìåñòî ðàñïîëîæåíèÿ ïåðâîãî 
êàíàëà ñòåðåîïðîöåññîðà

Ìåñòî ðàñïîëîæåíèÿ âòîðîãî
êàíàëà ñòåðåîïðîöåññîðà



Измерители объема задействованных ресурсов DSP
Äàííûå èçìåðèòåëè íàõîäÿòñÿ â îñíîâàíèè îñíîâíîãî îêíà è ïðåäíàçíà÷åíû äëÿ èíäèêàöèè êîëè÷åñòâà çàäåéñòâîâàííûõ ðåñóð-
ñîâ DSP è ïàìÿòè çàäåðæêè â äàííîé êîíôèãóðàöèè â ïðîöåíòíîì ñîîòíîøåíèè. Ìîæíî âèäåòü, êàê ïðè óñòàíîâêå èëè óäàëåíèè
ìîäóëüíîãî ïðîöåññîðà â ñõåìå ïðîõîæäåíèÿ ñèãíàëà èçìåíÿþòñÿ ïîêàçàíèÿ èçìåðèòåëÿ DSP.

Оптимизация ресурсов DSP
Åñëè ïðè óñòàíîâêå ïðîöåññîðà â ñõåìó ïðîõîæäåíèÿ ñèãíàëà ïîÿâëÿåòñÿ ñîîáùåíèå (ñìîòðè
ðèñóíîê) ìîæíî îïòèìèçèðîâàòü êîíôèãóðàöèþ äëÿ îñâîáîæäåíèÿ äîïîëíèòåëüíûõ ðåñóðñîâ. 

Äëÿ ýòîãî:

• Ïåðåìåñòèòå ïðîöåññîðíûå áëîêè ñ îäíîé ñòîðîíû ìàòðè÷íîãî ìèêøåðà íà äðóãóþ íà÷èíàÿ ñ
ïðîöåññîðîâ èñïîëüçóþùèõ íàèáîëüøåå êîëè÷åñòâî ñèñòåìíûõ ðåñóðñîâ (äàííûå ïðåäñòàâ-
ëåíû â êîíöå äàííîãî ðóêîâîäñòâà).

Íàïðèìåð, åñëè ïðîöåññîð DFR10 óñòàíîâëåí â âûõîäíîì êàíàëå ñõåìû, ïåðåìåñòèòå åãî âî
âõîäíîé èëè íàîáîðîò. 

• Îáúåäèíèòå ýêâàëàéçåðû ïî âîçìîæíîñòè â îäèí ìîäóëü, åñëè îíè íàõîäÿòñÿ â îäíîì çâóêîâîì òðåêå. 

Íàïðèìåð: äëÿ ðàáîòû äâóõ PEQ3 òðåáóåòñÿ áîëüøå ñèñòåìíûõ ðåñóðñîâ ÷åì äëÿ ðàáîòû îäíîãî PEQ7. Ïðè÷åì âî âñåõ PEQ äî-
ñòóïíû îáðåçíûå è ïîëî÷íûå ôèëüòðû, íàëè÷èå êîòîðûõ ïîçâîëÿåò çíà÷èòåëüíî ýêîíîìèòü ñèñòåìíûå ðåñóðñû. 

• Îáúåäèíèòå ïðîöåññîðû çàäåðæêè ïî âîçìîæíîñòè â îäèí ìîäóëü, åñëè îíè íàõîäÿòñÿ â îäíîì çâóêîâîì òðåêå. 

Íàïðèìåð, äëÿ îáåñïå÷åíèÿ çàäåðæêè 7 ìñåê ëó÷øå èñïîëüçîâàòü äâà ïðîöåññîðà DLY5ms ÷åì îäèí ïðîöåññîð DLY150ms.

• Ïî âîçìîæíîñòè ðàçìåùàéòå ïðîöåññîðû âî âõîäíîì êàíàëå.

• Óäàëÿéòå ïðîöåññîðû èç âñåõ íåèñïîëüçóåìûõ êàíàëîâ.

• Èñïîëüçóéòå ñïëèòòåðû äëÿ îáúåäèíåíèÿ âûõîäíûõ êàíàëîâ ñ èäåíòè÷íîé îáðàáîòêîé ñèãíàëà.

• Ïî âîçìîæíîñòè èñïîëüçóéòå ýêâàëàéçåð PEQ10 âìåñòî GEQ30. Â áîëüøèíñòâå ñëó÷àåâ âñå òðèäöàòü ôèëüòðîâ íå èñïîëüçóþòñÿ,
à äëÿ ðàáîòû PEQ10 òðåáóåòñÿ â äâà ðàçà ìåíüøå ðåñóðñîâ  DSP.

• Çàìåíÿéòå DFR ïàðàìåòðè÷åñêèìè ýêâàëàéçåðàìè ïîñëå çàâåðøåíèÿ ôîðìèðîâàíèÿ ñèñòåìû.

Íàïðèìåð: â ñèñòåìå ñ èñïîëüçîâàíèåì íåñêîëüêèõ DFR óñòàíîâëåííûõ íà âõîäàõ äëÿ óëó÷øåíèÿ õàðàêòåðèñòèê ñèãíàëà ïåðåä
âîçáóæäåíèåì, ñíà÷àëà íåîáõîäèìî èñïîëüçîâàòü DFR íà êàæäîì âõîäå äëÿ îáùåé íàñòðîéêè ñèñòåìû. Ïîñëå íàñòðîéêè ôèëüò-
ðîâ íåîáõîäèìî ñêîïèðîâàòü ôèëüòðû DFR è âñòàâèòü èõ â PEQ. Ïîñëå ýòîãî DFR íåîáõîäèìî óäàëèòü. Äàííàÿ ïðîöåäóðà ìîæåò
áûòü ïîâòîðåíà äëÿ êàæäîãî âõîäà. Ðåêîìåíäóåòñÿ îñòàâëÿòü òîëüêî îäèí DFR äëÿ àâòîìàòè÷åñêîãî îïðåäåëåíèÿ âîçáóæäåíèÿ â
íàèáîëåå ïîäâåðæåííîì ýòîìó ýôôåêòó êàíàëå.

Копирование и вставка
Âûïîëíåíèå òðàäèöèîííûõ ôóíêöèé êîïèðîâàíèÿ, âûðåçàíèÿ è âñòàâêè äîñòóïíû ëèøü ïðè ðàáîòå ñ áëîêàìè ìîäóëüíûõ ïðîöåñ-
ñîðîâ. Ýòî íàèëó÷øèé ñïîñîá äóáëèêàöèè ìîäóëåé ñ ñîõðàíåíèåì èõ ïàðàìåòðîâ ïðè êîíôèãóðàöèè íåñêîëüêèõ êàíàëîâ.

Äëÿ êîïèðîâàíèÿ è âñòàâêè ïðîöåññîðíîãî áëîêà:

1. Îäíîêðàòíûì íàæàòèåì ëåâîé êíîïêè ìûøè âûáåðèòå íóæíûé ïðîöåññîðíûé áëîê.

2. Âûáåðèòå êîìàíäó êîïèðîâàíèÿ îäíèì èç ñëåäóþùèõ ñïîñîáîâ:

• Ñ ïîìîùüþ êîíòåêñòíîãî ìåíþ (îäíîêðàòíîå íàæàòèå ïðàâîé êíîïêè ìûøè).

• Ñ ïîìîùüþ êîìàíäû Edit>Copy â ãëàâíîì ìåíþ.

• Íàæàòèåì êëàâèø Ctrl+C êëàâèàòóðû.

3. Âûáåðèòå ïóñòîé ñëîò.

4. Âûáåðèòå êîìàíäó âñòàâêè èñïîëüçóÿ ìåíþ èëè íàæàòèåì êëàâèø Ctrl+V êëàâèàòóðû.

Ïðèìå÷àíèå: äàííûå êîìàíäû íå ðàáîòàþò ïðè îäíîâðåìåííîì âûáîðå íåñêîëüêèõ îáúåêòîâ.

Удаление процессора из слота
Áëîêè ìîäóëüíûõ ïðîöåññîðîâ ìîãóò áûòü óäàëåíû èç êîíôèãóðàöèè áåç âîçäåéñòâèÿ íà îñòàëüíûå ïðîöåññîðû êîíôèãóðàöèè.

Äëÿ óäàëåíèÿ ïðîöåññîðíîãî áëîêà:

1. Îäíîêðàòíûì íàæàòèåì ëåâîé êíîïêè ìûøè âûáåðèòå íóæíûé ïðîöåññîðíûé áëîê.

2. Âûáåðèòå êîìàíäó óäàëåíèÿ îäíèì èç ñëåäóþùèõ ñïîñîáîâ:

• Ñ ïîìîùüþ êîíòåêñòíîãî ìåíþ (îäíîêðàòíîå íàæàòèå ïðàâîé êíîïêè ìûøè).

• Ñ ïîìîùüþ êîìàíäû Edit> Delete â ãëàâíîì ìåíþ.

• Íàæàòèåì êëàâèøè Delete êëàâèàòóðû.

Объединение процессоров
Íåñêîëüêî ïðîöåññîðíûõ áëîêîâ îäíîãî òèïà ìîãóò áûòü îáúåäèíåíû, ïðè ýòîì èçìåíåíèÿ ïàðàìåòðîâ îäíîãî ïðîöåññîðà ïîâëå-
êóò çà ñîáîé èçìåíåíèÿ ïàðàìåòðîâ âñåõ îñòàëüíûõ îáúåäèíåííûõ ïðîöåññîðîâ.

Âî âåõ îáúåäèíåííûõ ïðîöåññîðàõ îñòàþòñÿ íåçàâèñèìûìè ñëåäóþùèå ôóíêöèè:

1. Óäàëåíèå, êîïèðîâàíèå è âñòàâêà.

2. Ïåðåìåùåíèå áëîêà â äðóãîé ñëîò èëè êàíàëüíóþ ëèíåéêó.

3. Ïåðåèìåíîâàíèå îêíà ïàðàìåòðîâ ïðîöåññîðà.

Ôèêñèðîâàííûå ïðîöåññîðû îäíîé ñòðóêòóðû ìîãóò áûòü òàêæå îáúåäèíåíû, ïðè ýòîì îáåñïå÷èâàåòñÿ ñèíõðîííàÿ ðåãóëèðîâêà
óðîâíÿ ñèãíàëà âñåõ îáúåäèíåííûõ êàíàëîâ. Íàïðèìåð, ìîãóò áûòü îáúåäèíåíû âõîäíûå áëîêè óñèëåíèÿ äâóõ êàíàëîâ äëÿ îáåñïå-
÷åíèÿ îäíîâðåìåííîé ðåãóëèðîâêè óðîâíÿ ñòåðåîïàðû. Òàêæå ìîãóò áûòü îáúåäèíåíû âûõîäíûå áëîêè óñèëåíèÿ äëÿ îäíîâðåìåí-
íîé ðåãóëèðîâêè îáùåé ãðîìêîñòè.

Ïðèìå÷àíèå: îáúåäèíåíû ìîãóò áûòü òîëüêî ïðîöåññîðû îäíîãî òèïà.
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Создание объединенной группы A
Â îáúåäèíåííîé ãðóïïå ïðîöåññîðîâ ìîãóò áûòü èñïîëüçîâàíû êàê ïîëüçîâàòåëüñêèå óñòà-
íîâêè ïàðàìåòðîâ òàê è ïî óìîë÷àíèþ. 

Äëÿ ñîçäàíèÿ îáúåäèíåííîé ãðóïïû:

1. Âûáåðèòå íàæàòèåì ëåâîé êíîïêè ìûøè ïðè íàæàòîé êëàâèøå Ctrl íåîáõîäèìûå ïðîöåñ-
ñîðíûå áëîêè.

2. Âûáåðèòå Processor >Link>New Link Group â ãëàâíîì ìåíþ èëè Link>New Link Group â êîí-
òåêñòíîì ìåíþ (îäíîêðàòíîå íàæàòèå ïðàâîé êíîïêè ìûøè).

3. Îòêðîåòñÿ äèàëîãîâîå îêíî Create Link Group, êàê ïîêàçàíî íà ðèñóíêå ñïðàâà.

4. Ââåäèòå èìÿ ãðóïïû, ñîñòîÿùåå èç äâóõ ñèìâîëîâ.

5. Âûáåðèòå èñòî÷íèê óñòàíîâêè ïàðàìåòðîâ âñåõ ïðîöåññîðîâ ãðóïïû.

6. Ïîäòâåðäèòå âûáîð íàæàòèåì êíîïêè OK.

7. Íà áëîêå ïðîöåññîðà è â îêíå ïàðàìåòðîâ ïîÿâèòñÿ íàçâàíèå ãðóï-
ïû (ðèñóíîê ñïðàâà).

Добавления процессоров в группу
Ê ãðóïïå ìîãóò áûòü äîáàâëåíû ïðîöåññîðû ïðè óñëîâèè, ÷òî îíè îäíîãî è òîãî æå òèïà è íå
èñïîëüçóþòñÿ â äðóãèõ ãðóïïàõ. Êàæäûé äîáàâëÿåìûé â ãðóïïó ïðîöåññîð àâòîìàòè÷åñêè ïðè-
íèìàåò óñòàíîâêè ïàðàìåòðîâ ãðóïïû.

Äëÿ äîáàâëåíèÿ ïðîöåññîðà ê ñóùåñòâóþùåé ãðóïïå:

1. Íàæàòèåì ëåâîé êíîïêè ìûøè âûáåðèòå áëîê ïðîöåññîðà (âûáîð íåñêîëüêèõ áëîêîâ îñóùå-
ñòâëÿåòñÿ ñ îäíîâðåìåííûì íàæàòèåì êëàâèøè Ctrl).

2. Âûáåðèòå Processor>Link>Add To â ãëàâíîì ìåíþ èëè Link>Add To â êîíòåêñòíîì ìåíþ.

3. Íà ýêðàíå ïîÿâèòñÿ äèàëîãîâîå îêíî Add to Link, êàê ïîêàçàíî íà ðèñóíêå ñïðàâà, â êîòîðîì
áóäóò ïåðå÷èñëåíû òîëüêî ãðóïïû âêëþ÷àþùèå â ñåáÿ ïðîöåññîðû òîãî æå òèïà, ÷òî è âûáðàííûé. 

4. Âûáåðèòå ãðóïïó.

5. Íàæìèòå OK. 

Разгруппирование процессорных блоков
Äëÿ óäàëåíèÿ ïðîöåññîðíûõ áëîêîâ èç ãðóïïû:

1. Íàæàòèåì ëåâîé êíîïêè ìûøè âûáåðèòå áëîê ïðîöåññîðà (âûáîð íåñêîëüêèõ áëîêîâ îñóùåñòâëÿåòñÿ ñ îäíîâðåìåííûì íàæàòè-
åì êëàâèøè Ctrl).

2. Âûáåðèòå Processor>Link>Unlink â ãëàâíîì ìåíþ èëè Link>Unlink â êîíòåêñòíîì ìåíþ.

Режим Bypass
Ëþáîé ïðîöåññîðíûé ìîäóëüíûé áëîê ìîæåò áûòü âêëþ÷åí â ðåæèì bypass, ÷òî ïîçâîëÿåò îöåíèòü
çâóêîâîé òðàêò ñ ïîìîùüþ âðåìåííîãî îòêëþ÷åíèÿ ïðîöåññîðà. Âêëþ÷åíèå ðåæèìà bypass ñîïðî-
âîæäàåòñÿ óñòàíîâêîé æåëòîãî ôëàæêà îêîëî ñîîòâåòñòâóþùåãî áëîêà (ñìîòðè ðèñóíîê).

Âêëþ÷åíèå è îòêëþ÷åíèå ðåæèìà bypass:

1. Íàæàòèåì ëåâîé êíîïêè ìûøè âûáåðèòå áëîê ïðîöåññîðà (âûáîð íåñêîëüêèõ áëîêîâ îñóùåñòâ-
ëÿåòñÿ ñ îäíîâðåìåííûì íàæàòèåì êëàâèøè Ctrl).

2. Âêëþ÷èòå ðåæèì bypass îäíèì èç ñëåäóþùèõ ìåòîäîâ:

• Íàæìèòå êëàâèøè Ctrl+B êëàâèàòóðû.

• Âûáåðèòå Processor>Bypass Selected â ãëàâíîì ìåíþ.

• Èñïîëüçóéòå êîíòåêñòíîå ìåíþ

Ïðèìå÷àíèå: Êðîññîâåðû è ñïëèòòåðû íå ìîãóò áûòü âêëþ÷åíû â ðåæèì bypass.

Сохранение конфигурации
Файл сцены
Ìîæíî ñîçäàòü öåëóþ áèáëèîòåêó ðàçëè÷íûõ êîíôèãóðàöèé ñõåì ïðîõîæäåíèÿ ñèãíàëà íå ïîäêëþ÷àÿñü ê P4800. Êîíôèãóðàöèè â
âèäå ôàéëîâ ñöåí ñ ðàñøèðåíèåì “.scn” ñîõðàíÿþòñÿ â êîìïüþòåðå. Îíè äîñòóïíû äëÿ ìîäèôèêàöèè è ìîãóò áûòü ïîçäíåå çàãðó-
æåíû â P4800 â âèäå ïðåñåòîâ.

Сохранение созданной сцены
Äëÿ ñîõðàíåíèÿ ñîçäàííîé ñöåíû:

1. Â ãëàâíîì ìåíþ îñíîâíîãî îêíà âûáåðèòå File>Save As Scene File èëè íàæìèòå êíîïêó Save As íà ïàíåëè óïðàâëåíèÿ.

2. Îòêðîåòñÿ äèàëîãîâîå îêíî Save Scene As.

3. Âûáåðèòå äèðåêòîðèþ äëÿ ñîõðàíåíèÿ íîâîãî ôàéëà.

4. Ïðè íåîáõîäèìîñòè ââåäèòå íàçâàíèå ôàéëà è åãî îïèñàíèå.

5. Íàæìèòå Save.

Ïðèìå÷àíèå: Ôàéëû ñöåí äëÿ äðóãèõ öèôðîâûõ ñèãíàëüíûõ ïðîöåññîðîâ Shure (íàïðèìåð DFR11EQ èëè DP11) òàêæå èìåþò ðàñ-
øèðåíèå “.scn”. Äëÿ óäîáñòâà ðåêîìåíäóåòñÿ ðàñïîëàãàòü ôàéëû ñöåí äëÿ ðàçëè÷íûõ òèïîâ ïðîöåññîðîâ â ðàçíûõ äèðåêòîðèÿõ.
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Îêíî ïàðàìåòðîâ ïðîöåññîðà Ñõåìà ïðîõîæäåíèÿ ñèãíàëà

Áëîê â ðåæèìå bypass



Использование поля для описания
Â îïöèîíàëüíîì ïîëå äëÿ îïèñàíèÿ ðàçìåùàåòñÿ ïîëåçíàÿ èíôîðìàöèÿ î ôàéëå êîòîðàÿ ñîõðàíÿåòñÿ ïðè çàãðóçêå â P4800 â âèäå
ïðåñåòà.

Изменение файлов сцен
Èçìåíåííûé ôàéë ìîæíî ñîõðàíèòü êàê ïîä ñòàðûì, òàê è ïîä íîâûì èìåíåì.

Äëÿ èçìåíåíèÿ ôàéëà ñöåíû:

1. Âûáåðèòå â ãëàâíîì ìåíþ File>Open Scene File èëè íàæìèòå êíîïêó Open íà ïàíåëè óïðàâëåíèÿ.

2. Îòêðîåòñÿ äèàëîãîâîå îêíî Open Scene.

3. Âûáåðèòå äèðåêòîðèþ ñîäåðæàùóþ òðåáóåìûé ôàéë. 

4. Îòêðîéòå ôàéë âûäåëèâ åãî è íàæàâ êíîïêó Open.

5. Îñóùåñòâèòå íåîáõîäèìûå èçìåíåíèÿ.

6. Âûáåðèòå File>Save As Scene â ãëàâíîì ìåíþ èëè íàæìèòå êíîïêó Save As íà ïàíåëè óïðàâëåíèÿ.

7. Îòêðîåòñÿ äèàëîãîâîå îêíî Save Scene As.

8. Âûáåðèòå ïðåæíåå íàçâàíèå ôàéëà è íàæìèòå Save.

9. Ïîäòâåðäèòå êîìàíäó ïåðåçàïèñè óæå èìåþùåãîñÿ ôàéëà ñöåíû íàæàòèåì êíîïêè Yes â äèàëîãîâîì îêíå.

Управление пресетами
Ñèñòåìíûé ïðîöåññîð P4800 ïîçâîëÿåò ñîõðàíèòü îò 16 äî 128 ïðåñåòîâ â çàâèñèìîñòè îò êîìïëåêòàöèè. Ñîõðàíåííûé â P4800
ïðåñåò ìîæåò áûòü ïåðåèìåíîâàí, óäàëåí è òàê äàëåå. 

Сохранение песета в P4800
Ñîõðàíåíèå ïðåñåòà îñóùåñòâëÿåòñÿ â ðåæèìå Design Mode ïðè ïîäêëþ÷åííîì ê êîìïüþòåðó P4800.

4. Îòêðîåòñÿ äèàëîãîâîå îêíî Store Preset, êàê ïîêàçàíî íà ðèñóíêå ñïðàâà.

5. Ââåäèòå íàçâàíèå ïðåñåòà (íå áîëåå 15 ñèìâîëîâ).

6. Ââåäèòå íîìåð ïðåñåòà èëè îñòàâüòå åãî íîìåð ïî óìîë÷àíèþ.

7. Ââåäèòå äîïîëíèòåëüíóþ èíôîðìàöèþ (îïöèîíàëüíî).

8 Íàæìèòå Store.

Переименование пресета
Íàçâàíèå ñîõðàíåííîãî â P4800 ïðåñåòà è åãî îïèñàíèå ìîæåò áûòü èçìåíåíî â ëþáîé ìîìåíò â ðåæèìå Live Mode.

Äëÿ ïåðåèìåíîâàíèÿ ïðåñåòà:

1. Íàæìèòå êíîïêó Live Mode íà ïàíåëè óïðàâëåíèÿ.

2. Âûáåðèòå íóæíûé ïðåñåò èç ìåíþ èíôîðìàöèîííîãî ïîëÿ íà ïàíåëè óïðàâëåíèÿ.

3. Îñíîâíîå îêíî âêëþ÷èòñÿ â ðåæèì ïðîñìîòðà âûáðàííîãî ïðåñåòà.

4. Íàæìèòå êíîïêó Load íà ïàíåëè óïðàâëåíèÿ.

5. Óñòàíîâèòå êóðñîð íà èíôîðìàöèîííîå ïîëå è íàæìèòå îäèí ðàç ëåâóþ êíîïêó ìûøè.

6. Îòêðîåòñÿ äèàëîãîâîå îêíî Rename Preset, êàê ïîêàçàíî íà ðèñóíêå ñïðàâà.

7. Ââåäèòå íîâîå èìÿ ïðåñåòà è åãî îïèñàíèå.

8. Íàæìèòå OK.

Удаление пресета
Íåíóæíûé ïðåñåò ìîæíî óäàëèòü èç P4800 â ðåæèìå Design Mode.

Äëÿ óäàëåíèÿ ïðåñåòà:

1. Íàæìèòå êíîïêó Design Mode ïàíåëè óïðàâëåíèÿ.

2. Âûáåðèòå File>Delete Preset.

3. Îòêðîåòñÿ äèàëîãîâîå îêíî Select Devices.

4. Âûáåðèòå èç ñïèñêà äîñòóïíûå ïðèáîðû è íàæìèòå Connect.

5. Îòêðîåòñÿ äèàëîãîâîå îêíî Delete Preset, êàê ïîêàçàíî íà ðèñóíêå.

6. Âûáåðèòå óäàëÿåìûé ïðåñåò (âûáîð íåñêîëüêèõ ïðåñåòîâ îñóùåñòâëÿ-
åòñÿ ñ íàæàòèåì êëàâèøè Shift).

7. Íàæìèòå Delete.

Ïðèìå÷àíèå: âêëþ÷åííûé äëÿ ïðîñëóøèâàíèÿ ïðåñåò íå ìîæåò áûòü óäà-
ëåí. Äëÿ åãî óäàëåíèÿ âûáåðèòå äëÿ ïðîñëóøèâàíèÿ äðóãîé ïðåñåò.
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Äëÿ ñîõðàíåíèÿ ïðåñåòà:

1. Â ãëàâíîì ìåíþ îñíîâíîãî îêíà âûáåðèòå
File>Store As Preset èëè íàæìèòå êíîïêó
Store Preset ïàíåëè óïðàâëåíèÿ â ðåæèìå
Design Mode.

2. Îòêðîåòñÿ äèàëîãîâîå îêíî Select Devices,
êàê ïîêàçàíî íà ðèñóíêå ñëåâà.

3. Âûáåðèòå èç ñïèñêà äîñòóïíûå ïðèáîðû è
íàæìèòå Connect.



Резервное копирование
Âñå ñîõðàíåííûå â ïðèáîðå ïðåñåòû ìîæíî çàðåçåðâèðîâàòü â îäíîì àðõèâå
è âîññòàíîâèòü åãî çàòåì â íóæíûé ìîìåíò. Ðåçåðâíàÿ êîïèÿ ñîçäàåòñÿ èëè
âûçûâàåòñÿ â ðåæèìå Design Mode.

Äëÿ ñîçäàíèÿ ðåçåðâíîé êîïèè:

1. Íàæìèòå êíîïêó Design Mode ïàíåëè óïðàâëåíèÿ.

2. Âûáåðèòå File>Backup Device â ãëàâíîì ìåíþ.

3. Îòêðîåòñÿ äèàëîãîâîå îêíî Select Devices.

4. Âûáåðèòå èç ñïèñêà äîñòóïíûå ïðèáîðû è íàæìèòå Connect.

5. Îòêðîåòñÿ äèàëîãîâîå îêíî Backup Device, êàê ïîêàçàíî íà ðèñóíêå ñïðàâà.

6. Íàæìèòå Backup Device.

7. Îòêðîåòñÿ äèàëîãîâîå îêíî Save Backup, êàê ïîêàçàíî íà ðèñóíêå íèæå.

8. Âûáåðèòå íóæíóþ äèðåêòîðèþ è ââåäèòå íàçâàíèå ôàéëà.

9. Íàæìèòå Save.

Äëÿ âîññòàíîâëåíèÿ çàðåçåðâèðîâàííûõ ïðåñåòîâ:

Возможности и особенности процессоров
Â äàííîé ãëàâå îïèñàíû îáùèå ïàðàìåòðû äëÿ ìíîãèõ ïðîöåññîðîâ èñïîëüçóåìûõ â P4800. 

Фейдеры
Ôåéäåðû ïðåäíàçíà÷åíû äëÿ ðåãóëèðîâêè óñèëåíèÿ è ïðèâîäÿòñÿ â äâèæåíèå ñ ïîìîùüþ ìûøè. Öèôðîâîå çíà÷åíèå óðîâíÿ ñèã-
íàëà ìîæåò áûòü òàêæå óñòàíîâëåíî â ñîîòâåòñòâóþùåé ñòðîêå. 

Выбор фейдера
Âûáîð ôåéäåðà îñóùåñòâëÿåòñÿ óñòàíîâêîé êóðñîðà íàä ãðàôè÷åñêîé ðóêîÿòêîé ôåé-
äåðà è íàæàòèåì ëåâîé êíîïêè ìûøè èëè íàæàòèåì íà ñòðîêó óðîâíÿ ðàñïîëîæåííóþ
ïîä ôåéäåðîì. Ïåðåìåùåíèå ìåæäó íåñêîëüêèìè ôåéäåðàìè ìîæåò òàêæå îñóùåñòâ-
ëÿòüñÿ íàæàòèåì êëàâèø Tab èëè Shift + Tab êëàâèàòóðû.

Установка уровня
Äëÿ óñòàíîâêè óðîâíÿ ñ ïîìîùüþ ìûøè:

• Óñòàíîâèòå êóðñîð íà ðóêîÿòêó ôåéäåðà, íàæìèòå ëåâóþ êíîïêó ìûøè è íå îòïóñêàÿ åå
ïåðåìåñòèòå ðóêîÿòêó â íóæíóþ ïîçèöèþ.

• Óñòàíîâèòå êóðñîð íà íåîáõîäèìîì óðîâíå ëèíåéêè ôåéäåðà è íàæìèòå îäèí ðàç ëå-
âóþ êíîïêó ìûøè.

• Îäíîêðàòíûì íàæàòèåì ïðàâîé êíîïêè ìûøè ìîæíî óñòàíîâèòü ðóêîÿòêó ôåéäåðà íà
óðîâåíü 0 äÁ.

Óñòàíîâêà óðîâíÿ êëàâèøàìè êëàâèàòóðû:

1. Âûáåðèòå íóæíûé ôåéäåð.

2. Èñïîëüçóÿ ñëåäóþùèå êëàâèøè êëàâèàòóðû óñòàíîâèòå òðåáóåìûé óðîâåíü ãðîìêîñòè.

Панель значений
Êàæäûé ôåéäåð èìååò ñîîòâåòñòâóþùóþ åìó ïàíåëü öèôðîâûõ çíà÷åíèé, ïîçâîëÿþùóþ óñòàíàâëèâàòü íóæíûé óðîâåíü ñèãíàëà ñ
øàãîì 0,1 äÁ. Â áîëüøèíñòâå ñëó÷àåâ ïàíåëü çíà÷åíèé ðàñïîëàãàåòñÿ íåïîñðåäñòâåííî ïîä ôåéäåðîì. Êàê èñêëþ÷åíèå, â ïðî-
öåññîðàõ GEQ10 è GEQ30 ïðåäóñìîòðåíî ïî îäíîé ïàíåëè çíà÷åíèé äëÿ âñåõ ôåéäåðîâ. Çäåñü, ñíà÷àëà âûáèðàåòñÿ íóæíûé ôåé-
äåð è çàòåì â îáùåé ïàíåëè óñòàíàâëèâàåòñÿ íóæíîå çíà÷åíèå. 
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1. Âûáåðèòå File>Restore Device â ãëàâíîì ìåíþ.

2. Îòêðîåòñÿ äèàëîãîâîå îêíî Open Backup (ïîõîæåå íà Save Backup, îïèñàííîå â
ïðåäûäóùåì ðàçäåëå).

3. Âûáåðèòå íóæíóþ äèðåêòîðèþ è ðåçåðâíûé íàáîð ïðåñåòîâ èç ñïèñêà.

4. Íàæìèòå Open.

5. Îòêðîåòñÿ äèàëîãîâîå îêíî Select Devices.

6. Âûáåðèòå íóæíûé äîñòóïíûé ïðèáîð è íàæìèòå Connect. Ïîñëå ýòîãî âûáðàííûé
ðåçåðâíûé íàáîð ïðåñåòîâ áóäåò çàãðóæåí â ïðèáîð.

Ôåéäåð â àêòèâíîì ðåæèìå

Ôåéäåð â ïàññèâíîì ðåæèìå

Ëèíåéêà
ôåéäåðà

Ðóêîÿòêà
ôåéäåðà 

Êíîïêè
óâåëè÷åíèÿ è 

ïîíèæåíèÿ
âåëè÷èíû

Öèôðîâàÿ
ïàíåëü



Кнопки изменения величины
Äàííûå êíîïêè ðàñïîëîæåíû â ëåâîé ÷àñòè ïàíåëè è òàêæå îáåñïå÷èâàþò óäîáíûé ñïîñîá óñòàíîâêè óðîâíÿ ñèãíàëà.

Äëÿ èçìåíåíèÿ çíà÷åíèÿ óðîâíÿ:

• Îäíîêðàòíîå íàæàòèå îäíîé èç êíîïîê ïîçâîëÿåò èçìåíèòü çíà÷åíèå óðîâíÿ ñèãíàëà íà +/–0.5 äÁ.

• Ïðîäîëæèòåëüíîå íàæàòèå íà îäíó èç êíîïîê ïîçâîëÿåò ïëàâíî èçìåíÿòü çíà÷åíèå óðîâíÿ â òó èëè äðóãóþ ñòîðîíó. Ïðè áîëåå
ïðîäîëæèòåëüíîì íàæàòèè ñêîðîñòü èçìåíåíèÿ çíà÷åíèÿ óâåëè÷èâàåòñÿ.

Сохранение и вызов установок
Óñòàíîâêè ïàðàìåòðîâ ëþáîãî ìîäóëüíîãî ïðîöåññîðà ìîãóò áûòü ñîõðàíåíû â êîìïüþòåðå è èñïîëüçîâàíû â äàëüíåéøåì äëÿ
êîíôèãóðèðîâàíèÿ ÷àñòî èñïîëüçóåìûõ ïðîöåññîðîâ. Äëÿ ñîõðàíåííûõ óñòàíîâîê ïàðàìåòðîâ ïðîöåññîðîâ ðåêîìåíäóåòñÿ ñî-
çäàòü îòäåëüíóþ äèðåêòîðèþ.

Äëÿ ñîõðàíåíèÿ óñòàíîâîê:

1. Äâîéíûì íàæàòèåì ëåâîé êíîïêè ìûøè îòêðîéòå îêíî ïàðàìåòðîâ ïðîöåññîðà.

2. Âûáåðèòå File>Save Settings â ìåíþ èëè íàæìèòå êëàâèøè Ctrl + S êëàâèàòóðû.

3. Ââåäèòå íàçâàíèå ôàéëà.

4. Íàæìèòå Save.

Äëÿ âûçîâà óñòàíîâîê:

1. Äâîéíûì íàæàòèåì ëåâîé êíîïêè ìûøè îòêðîéòå îêíî ïàðàìåòðîâ ïðîöåññîðà.

2. Âûáåðèòå File>Recall Settings â ìåíþ èëè íàæìèòå êëàâèøè Ctrl + R êëàâèàòóðû.

3. Âûáåðèòå íóæíûé ôàéë.

4. Íàæìèòå Open.

Ïðèìå÷àíèå: ôàéëû ìîãóò îòêðûâàòüñÿ òîëüêî ïðîöåññîðàìè èäåíòè÷íûìè òåì, íà êîòîðûõ îíè áûëè ñîçäàíû.

Присвоение имени окну параметров процессора
Êàæäîìó îêíó ïàðàìåòðîâ ìîäóëüíûõ ïðîöåññîðîâ, íàõîäÿùèõñÿ â ñõåìå ïðîõîæäåíèÿ ñèãíàëà ìîæåò áûòü ïðèñâîåíî ñâîå èìÿ.
Ýòî çíà÷èòåëüíî îáëåã÷àåò ïîèñê ïðè íåñêîëüêèõ îòêðûòûõ îêíàõ. Èìÿ îêíà ïðîöåññîðà ïî óìîë÷àíèþ âêëþ÷àåò â ñåáÿ íàçâàíèå
îñíîâíîãî ïðîöåññîðà è ìàðêèðîâêó êàíàëüíîé ëèíåéêè â êîòîðîé ðàçìåùåí ïðîöåññîð.

Íîâîå èìÿ îêíà ïîÿâëÿåòñÿ êàê íà òèòóëüíîé ïàíåëè, òàê è íà ïàíåëè çàäà÷ (ïðè ìèíèìèçàöèè îêíà ïàðàìåòðîâ).

Äëÿ ïåðåèìåíîâàíèÿ îêíà ïàðàìåòðîâ ïðîöåññîðà:

1. Îòêðîéòå îêíî ïàðàìåòðîâ ïðîöåññîðà äâîéíûì íàæàòèåì ëåâîé êíîïêè ìûøè.

2. Âûáåðèòå Options>Name â ìåíþ.

3. Ââåäèòå íîâîå íàçâàíèå (äî 15 ñèìâîëîâ).

4. Íàæìèòå OK.

Ïðèìå÷àíèå: ñ ïîìîùüþ äàííîé ïðîöåäóðû ìîæíî èçìåíèòü òîëüêî íàçâàíèå îêíà ïàðàìåòðîâ. Íàçâàíèå ïðîöåññîðíîãî áëîêà
â ýòîì ñëó÷àå îñòàåòñÿ íåèçìåííûì.

Моментальный снимок
Âîçìîæíîñòü ñîçäàíèÿ ìîìåíòàëüíîãî ñíèìêà äîñòóïíà â ëþáîì îêíå ïàðàìåòðîâ ïðîöåññîðîâ ïðåäóñìàòðèâàþùåãî íàëè÷èå
÷àñòîòíîé õàðàêòåðèñòèêè ñèãíàëà. Äàííàÿ ôóíêöèÿ ïîçâîëÿåò ôèêñèðîâàòü òåêóùóþ õàðàêòåðèñòèêó è çàòåì èñïîëüçîâàòü äëÿ
ñðàâíåíèÿ ïðè êîððåêöèè óñòàíîâîê ïðîöåññîðà. Âíîâü ñîçäàííûé ìîìåíòàëüíûé ñíèìîê àâòîìàòè÷åñêè ñòèðàåò ïðåäûäóùèé.

Ñëåäóþùèå ïðèìåðû ïðèâåäåíû ñ èñïîëüçîâàíèåì îêíà ïàðàìåòðîâ
5-ïîëîñíîãî ïàðàìåòðè÷åñêîãî ýêâàëàéçåðà ñ îáðåçíûì è ïîëî÷íûì
ôèëüòðàìè (PEQ5+CS).

Äëÿ ñîçäàíèÿ ìîìåíòàëüíîãî ñíèìêà:

1. Íàæìèòå êíîïêó TAKE, êàê ïîêàçàíî íà ðèñóíêå ñïðàâà. Äàííàÿ
êîìàíäà çàôèêñèðóåò òåêóùóþ êðèâóþ ÷àñòîòíîé õàðàêòåðèñòèêè. 

2. Íàæìèòå êíîïêó SHOW. Äàííàÿ êîìàíäà ñëóæèò äëÿ
îòðàæåíèÿ êðèâîé íà ýêðàíå. Ïîñëå ÷åãî âêëþ÷èòñÿ
çåëåíûé èíäèêàòîð äàííîé êíîïêè (ðèñóíîê ñïðàâà).

3. Èçìåíèòå óñòàíîâêè ïðîöåññîðà. Ïîñëå îáíîâëåíèÿ êðèâîé ïîÿâëÿ-
åòñÿ âîçìîæíîñòü ñðàâíåíèÿ åå ñ ïðåäûäóùåé, ïîêàçàííîé íà çàä-
íåì ïëàíå (ñìîòðè ðèñóíîê ñïðàâà).

Фиксированные процессоры
Ôèêñèðîâàííûå ïðîöåññîðû ÿâëÿþòñÿ ñîñòàâíûìè ÷àñòÿìè òðåõêàñêàäíîé ñòðóêòóðû óñèëåíèÿ ñèñòåìíîãî ïðîöåññîðà P4800 è
íå ìîãóò áûòü óäàëåíû èëè ïåðåìåùåíû â äðóãèå áëîêè.
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4. Ïîâòîðíûì íàæàòèåì êíîïêè SHOW ìîæíî âêëþ÷àòü è îòêëþ÷àòü
èçîáðàæåíèå ìîìåíòàëüíîãî ñíèìêà (ðèñóíîê ñëåâà).



Блок входного усиления
Ïðîöåññîð âõîäíîãî óñèëåíèÿ ñîäåðæèò èíäèâèäóàëüíûå ðåãóëÿòîðû äëÿ âñåõ ÷åòûðåõ âõîäíûõ êàíàëîâ. Óñòàíîâèòå êóðñîð íà
îäèí èç âõîäíûõ áëîêîâ óñèëåíèÿ è äâîéíûì íàæàòèåì ëåâîé êíîïêè ìûøè îòêðîéòå îêíî âõîäîâ (ñìîòðè ðèñóíîê ñïðàâà). 

Âûáîð ÷óâñòâèòåëüíîñòè. Äàííûå ïåðå-
êëþ÷àòåëè ïðåäíàçíà÷åíû äëÿ ñîãëàñîâà-
íèÿ âõîäà êàíàëà ñ óðîâíåì âõîäíîãî ñèãíà-
ëà ïîäêëþ÷àåìîãî îáîðóäîâàíèÿ è îáåñïå-
÷èâàþò âûáîð ìåæäó óðîâíÿìè -10 dBV è 
+4 dBu. Óñòàíîâêà ïî óìîë÷àíèþ: +4 dBu.

Ïåðåêëþ÷àòåëü ïîëÿðíîñòè ñèãíàëà. Íà-
æàòèåì äàííîãî ïåðåêëþ÷àòåëÿ ìîæíî èí-
âåðòèðîâàòü âõîäíîé ñèãíàë êàíàëà. Óñòà-
íîâêà ïî óìîë÷àíèþ: íåèíâåðòèðîâàííûé
ñèãíàë.

Ðåãóëÿòîðû óñèëåíèÿ. Äàííûå ðåãóëÿòîðû ïðèìåíÿþòñÿ äëÿ óñòàíîâêè ñîîòâåòñòâóþùåãî óðîâíÿ íà êàæäîì âõîäíîì êàíàëå.
Äëÿ ðåãóëèðîâêè íåîáõîäèìî âûáðàòü ðóêîÿòêó ôåéäåðà è ïåðåìåñòèòü åå ñ ïîìîùüþ ìûøè èëè êëàâèàòóðû. Íóæíûé óðîâåíü
ìîæíî òàêæå óñòàíîâèòü è íà ïàíåëè ÷èñëîâûõ çíà÷åíèé (êàê áûëî îïèñàíî ðàíåå). Äèàïàçîí ðåãóëèðîâêè îáåñïå÷èâàåòñÿ â äèà-
ïàçîíå îò +30 äÁ äî –30 äÁ (óñòàíîâêà ïî óìîë÷àíèþ: 0 äÁ).

Ïðèìå÷àíèå: Ðåãóëÿòîðû óðîâíÿ âõîäíûõ êàíàëîâ ðàñïîëîæåíû â öåïè ïîñëå ÀÖ-êîíâåðòåðîâ. Ïîýòîìó, åñëè âõîäíîé ñèãíàë èç-
íà÷àëüíî ïðåâûøàåò äîïóñòèìûé óðîâåíü, òî îí äîëæåí ðåãóëèðîâàòüñÿ íåïîñðåäñòâåííî íà
èñòî÷íèêå.

Ïåðåêëþ÷àòåëè ìüþòèðîâàíèÿ êàíàëîâ. Íàæàòèåì äàííûõ ïåðåêëþ÷àòåëåé (ðèñóíîê
ñïðàâà) ìîæíî çàìüþòèðîâàòü íóæíûé êàíàë. Óñòàíîâêà ïî óìîë÷àíèþ: êàíàë ðàçìüþòèðîâàí.

Ìàðêèðîâêà êàíàëà. Äàííàÿ òåêñòîâàÿ ïàíåëü èñïîëüçóåòñÿ äëÿ ìàðêèðîâêè âõîäíîé êàíàëü-
íîé ëèíåéêè. Óñòàíîâêà ïî óìîë÷àíèþ: íåìàðêèðîâàííûé âõîä (“Untitled In”) äëÿ êàæäîãî
êàíàëà.

Èíäèêàòîð îáúåäèíåíèÿ êàíàëà. Äàííûé èíäèêàòîð âêëþ÷åí, åñëè âõîäíîé êàíàë ðà-
áîòàåò â îáúåäèíåííîì ðåæèìå (ñìîòðè ðèñóíîê ñïðàâà).

Матричный микшер
Îòêðûòèå îêíà ìàòðè÷íîãî
ìèêøåðà îñóùåñòâëÿåòñÿ óñ-
òàíîâêîé êóðñîðà íà ëþáîé
ìèêøåðíûé áëîê è äâîéíûì
íàæàòèåì ëåâîé êíîïêè ìûøè.

Âõîäíîé ñåëåêòîð. Íàæàòè-
åì äàííîãî ïåðåêëþ÷àòåëÿ
îñóùåñòâëÿåòñÿ ïîäêëþ÷åíèå
ê âûõîäó ñîîòâåòñòâóþùåé
âõîäíîé êàíàëüíîé ëèíåéêè.
Óñòàíîâêà ïî óìîë÷àíèþ: îò-
êëþ÷åí.

Ïåðåêëþ÷àòåëü ïîëÿðíîñòè.
Íàæàòèåì äàííîãî ïåðåêëþ÷à-
òåëÿ îñóùåñòâëÿåòñÿ èíâåðòè-
ðîâàíèå ñèãíàëà (ðèñóíîê
âíèçó). Óñòàíîâêà ïî óìîë÷à-
íèþ: ñèãíàë íå èíâåðòèðîâàí.

Ðåãóëÿòîðû óñèëåíèÿ. Äàííûå ðåãóëÿòîðû ïðåäíàçíà÷åíû äëÿ óñòàíîâêè íåîáõîäèìîãî
óðîâíÿ ñèãíàëà êàæäîãî êàíàëà ñ ïîìîùüþ ìûøè èëè ïàíåëè öèôðîâûõ çíà÷åíèé (êàê îïèñà-
íî ðàíåå). Ðåãóëèðîâêà îñóùåñòâëÿåòñÿ â äèàïàçîíå îò +10 äÁ äî áåñêîíå÷íî ìàëûõ âåëè÷èí.
Óñòàíîâêà ïî óìîë÷àíèþ: 0 äÁ.

Ïåðåêëþ÷àòåëü ìüþòèðîâàíèÿ êàíàëà. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ îñóùåñòâëÿåòñÿ
ìüþòèðîâàíèå êàíàëà. Óñòàíîâêà ïî óìîë÷àíèþ: êàíàë ðàç ìüþòèðîâàí.

Ìàðêèðîâêà êàíàëà. Äàííàÿ òåêñòîâàÿ ïàíåëü èñïîëüçóåòñÿ äëÿ ìàðêèðîâêè êàíàëà.
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Íàçâàíèå
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Çàêëàäêè âõîäîâ

Âõîäíûå ðåãóëÿòîðû Âûõîäíûå
ðåãóëÿòîðû

Èíäèêàòîð
îáúåäèíåíèÿ
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ïàíåëü

Íîìåðà
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Ìüþò âûêëþ÷åí



Èíäèêàòîð îáúåäèíåíèÿ êàíàëà. Äàííûé èíäèêàòîð âêëþ÷åí, åñëè
âõîäíîé êàíàë ðàáîòàåò â îáúåäèíåííîì ðåæèìå.

Ïðèìå÷àíèå: ïðè îáúåäèíåíèè ìàòðè÷íîãî ìèêøåðà åãî âõîäíûå ðåãó-
ëÿòîðû óðîâíÿ ðàáîòàþò íåçàâèñèìî.

Çàêëàäêè îêíà ìèêøåðà. Íàæàòèåì íà ðàçëè÷íûå çàêëàäêè ìèêøåðíîãî
îêíà îáåñïå÷èâàåòñÿ äîñòóï ê ðåãóëÿòîðàì ðàçëè÷íûõ ìèêøåðíûõ òî÷åê.
Ïðè èñïîëüçîâàíèè êðîññîâåðà â çàêëàäêàõ îòðàæàþòñÿ âñå èñïîëüçóå-
ìûå âûõîäíûå êàíàëüíûå ëèíåéêè, êàê ïîêàçàíî íà ðèñóíêå ñïðàâà.

Блок выходного усиления
Ïðîöåññîð âûõîäíîãî óñè-
ëåíèÿ ñîäåðæèò èíäèâèäó-
àëüíûå ðåãóëÿòîðû äëÿ
âñåõ âîñüìè âûõîäíûõ êà-
íàëîâ. Îáùåå îêíî ïàðà-
ìåòðîâ îòêðûâàåòñÿ ïðè
äâîéíîì íàæàòèè íà ëþáîé
èç âîñüìè âûõîäíûõ áëî-
êîâ óñèëåíèÿ (ñìîòðè ðèñó-
íîê ñïðàâà).

Ïåðåêëþ÷àòåëè óðîâíÿ.
Äàííûå ïåðåêëþ÷àòåëè èñ-
ïîëüçóþòñÿ äëÿ óñòàíîâêè
óðîâíÿ âûõîäíîãî ñèãíàëà
(-10dBV èëè +4dBu). Óñòà-
íîâêà ïî óìîë÷àíèþ: +4dBu
(ðèñóíîê âíèçó). 

Ïåðåêëþ÷àòåëü ïîëÿðíî-
ñòè ñèãíàëà. Íàæàòèåì
äàííîãî ïåðåêëþ÷àòåëÿ
ìîæíî èíâåðòèðîâàòü âûõîäíîé ñèãíàë êàíàëà. Óñòàíîâêà ïî óìîë÷àíèþ: íåèíâåðòèðîâàííûé
ñèãíàë (ðèñóíîê ñïðàâà).

Ðåãóëÿòîðû óñèëåíèÿ. Äàííûìè ðåãóëÿòîðàìè îñóùåñòâëÿåòñÿ óñòàíîâêà óðîâíÿ ñèãíàëà êàæäîãî âûõîäíîãî êàíàëà â äèàïàçîíå
îò +30 äÁ äî -30 äÁ. Óñòàíîâêà ïî óìîë÷àíèþ: 0 äÁ.

Âûõîäíîé àòòåíþàòîð. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ îñóùåñòâëÿåòñÿ îñëàáëåíèå âûõîä-
íîãî ñèãíàëà íà –20 äÁ. Óñòàíîâêà ïî óìîë÷àíèþ: ðåæèì îòêëþ÷åí (ðèñóíîê ñïðàâà).

Ïåðåêëþ÷àòåëè ìüþòèðîâàíèÿ êàíàëîâ. Íàæàòèåì äàííûõ ïå-
ðåêëþ÷àòåëåé ìîæíî çàìüþòèðîâàòü íóæíûé êàíàë. Óñòàíîâêà ïî óìîë÷àíèþ: êàíàë ðàçìüþòèðîâàí
(ðèñóíîê ñëåâà).

Ìàðêèðîâêà êàíàëà. Äàííàÿ òåêñòîâàÿ ïàíåëü èñïîëüçóåòñÿ äëÿ ìàðêèðîâêè âûõîäíîé êàíàëüíîé ëèíåéêè. Óñòàíîâêà ïî óìîë÷à-
íèþ: íåìàðêèðîâàííûé âûõîä (“Untitled Out”) äëÿ êàæäîãî êàíàëà.

Èíäèêàòîð îáúåäèíåíèÿ êàíàëà. Äàííûé èíäèêàòîð âêëþ÷åí, åñëè âûõîäíîé êàíàë ðàáîòàåò â
îáúåäèíåííîì ðåæèìå (ðèñóíîê ñïðàâà).

Модульные процессоры
Автоматический регулятор усиления/выравниватель уровня сигнала (AGC)
Àâòîìàòè÷åñêèé ðåãóëÿòîð óñèëåíèÿ èñïîëüçóåòñÿ â òåõ ñèòóàöèÿõ, ãäå íåîáõîäèìî ïîääåðæèâàòü ïîñòîÿííûé óðîâåíü ñèãíàëà.
Ýòî ìîãóò áûòü çâóêîóñèëèâàþùèå ñèñòåìû ñ èñïîëüçîâàíèåì ïîäèóìíûõ è êîíôåðåíöèîííûõ ìèêðîôîíîâ, ðàññòîÿíèå îò êîòî-
ðûõ äî äèêòîðà èëè âåäóùåãî ïîñòîÿííî èçìåíÿåòñÿ. Äàííûé ïðîöåññîð îñóùåñòâëÿåò àâòîìàòè÷åñêóþ ðåãóëèðîâêó óñèëåíèÿ ïðè
íåäîñòàòêå èëè ïåðåèçáûòêå óðîâíÿ ñèãíàëà. 

Окно параметров
Îêíà ïàðàìåòðîâ ïðîöåññîðîâ äàííîãî òèïà â òîé èëè èíîé ìåðå èäåíòè÷íû. Èíäèâèäóàëüíûå ðàçëè÷èÿ ìåæäó íèìè îïèñàíû îò-
äåëüíî â ñîîòâåòñòâóþùèõ ðàçäåëàõ.

Ãðàôîïîñòðîèòåëüíàÿ ïàíåëü. Äàííàÿ êðèâàÿ îòîáðàæàåò ïîðîãîâûé óðîâåíü è êîýôôèöèåíò êîìïðåññèè. Ãðàôè÷åñêèå ýëå-
ìåíòû, ôîðìèðóþùèå êðèâóþ ïåðåäâèãàþòñÿ ñ ïîìîùüþ ìûøè. Äàííàÿ êðèâàÿ îòîáðàæàåò èçìåíåíèÿ óðîâíÿ âûõîäíîãî ñèãíàëà. 

Ëèíèÿ ìàêñèìàëüíîãî óñèëåíèÿ. Ìàêñèìàëüíîå óñèëåíèå ñèãíàëà îáåñïå÷èâàåìîå äàííûì ïðîöåññîðîì ñîîòâåòñòâóåò 
+12 äÁ, êàê ïîêàçàíî íà ãðàôèêå. Ýòî îãðàíè÷åíèå ïðåäîòâðàùàåò âîçíèêíîâåíèå íåæåëàòåëüíûõ øóìîâûõ ìîäóëÿöèé èëè ñàìî-
âîçáóæäåíèÿ âûçûâàåìûõ ÷ðåçìåðíûì óñèëåíèåì ñëàáûõ ñèãíàëîâ. Ëèíèÿ ìàêñèìàëüíîãî óñèëåíèÿ ïîÿâëÿåòñÿ â ãðàôèêå â òîì
ñëó÷àå, åñëè ñèãíàë ïðåâûøàåò îãðàíè÷åíèå +12 äÁ.
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Êàíàë íå îáúåäèíåí



Èçìåðèòåëü ãðàôîïîñòðîèòåëüíîé ïàíåëè. Â ðåæèìå Live Mode äàííûé èçìåðèòåëü îòîáðàæàåò óðîâåíü âõîäíîãî è îòíîñè-
òåëüíîãî âûõîäíîãî ñèãíàëîâ. Èçìåðèòåëü ïîçâîëÿåò îñóùåñòâëÿòü âèçóàëüíûé êîíòðîëü çà âîçäåéñòâèåì ïðîöåññîðà íà òåêóùèé
ïðîãðàììíûé ìàòåðèàë. Ôóíêöèÿ èçìåðèòåëÿ ìîæåò áûòü îòêëþ÷åíà èëè âêëþ÷åíà âûáîðîì Options>Transfer Curve Meter â ìåíþ.
Óñòàíîâêà ïî óìîë÷àíèþ: èçìåðèòåëü âêëþ÷åí.

Ñëàéäåð ïîðîãà. Ïîçèöèÿ ïîðîãîâîãî ñëàéäåðà ñîîòâåòñòâóåò óñòàíîâêå ïîðîãîâîãî ðåãóëÿòîðà. Ñëàéäåð ìîæåò ïåðåäâèãàòüñÿ
âëåâî è âïðàâî ñ ïîìîùüþ ìûøè äëÿ óñòàíîâêè íåîáõîäèìîãî çíà÷åíèÿ.

Ñëàéäåð êîýôôèöèåíòà óñèëåíèÿ. Ïîçèöèÿ ñëàéäåðà êîýôôèöèåíòà ñîîòâåòñòâóåò óñòàíîâêå ðåãóëÿòîðà óñèëåíèÿ. Ñëàéäåð
ìîæåò ïåðåäâèãàòüñÿ ââåðõ è âíèç ñ ïîìîùüþ ìûøè äëÿ óñòàíîâêè íåîáõîäèìîãî óñèëåíèÿ.

Îñíîâíîé ñëàéäåð. Ïîçèöèÿ îñíîâíîãî ñëàéäåðà ñîîòâåòñòâóåò óñòàíîâêå îáùåãî óñèëåíèÿ.

Ñëàéäåð ìîæåò ïåðåäâèãàòüñÿ âëåâî è âïðàâî ñ ïîìîùüþ ìûøè äëÿ óñòàíîâêè íåîáõîäèìîãî çíà÷åíèÿ.

Èçìåðèòåëü ðåäàêöèè ñèãíàëà. Äàííûé èçìåðèòåëü îòîáðàæàåò îáùåå óâåëè÷åíèå èëè ïîíèæåíèå óñèëåíèÿ ïðè òåêóùèõ óñòà-
íîâêàõ ïðîöåññîðà. Äàííàÿ ôóíêöèÿ ìîæåò áûòü âêëþ÷åíà èëè âûêëþ÷åíà âûáîðîì Options>Gain Reduction Meter â ìåíþ. Óñòà-
íîâêà ïî óìîë÷àíèþ: èçìåðèòåëü âêëþ÷åí.

Ðåãóëÿòîðû óñèëåíèÿ. Äàííûå ðåãóëÿòîðû èñïîëüçóþòñÿ äëÿ óñòàíîâêè âõîäíîãî è âûõîäíîãî óñèëåíèÿ â ïðåäåëàõ îò –12 äÁ äî
+12 äÁ ñ øàãîì 0.5 äÁ. Óñòàíîâêà ðåãóëÿòîðîâ ïî óìîë÷àíèþ: 0 äÁ.

Èíäèêàòîð ïðåâûøåíèÿ ïîðîãîâîé âåëè÷èíû (Threshold Exceeded).
Äàííûé èíäèêàòîð ãîðèò æåëòûì öâåòîì åñëè óðîâåíü âõîäíîãî ñèãíàëà
ïðåâûøàåò óñòàíîâëåííóþ ïîðîãîâóþ âåëè÷èíó (ðèñóíîê ñïðàâà).

Ïàíåëü Threshold. Â äàííîé ïàíåëè îòîáðàæàåòñÿ ïîðîãîâîå çíà÷åíèå ñðàáàòûâàíèÿ ïðîöåññîðà, êîòîðîå ìî-
æåò áûòü óñòàíîâëåíî ñ ïîìîùüþ êëàâèàòóðû, íàæàòèåì íà êíîïêè âîçðàñòàíèÿ è óáûâàíèÿ èëè óñòàíîâêîé ïîðî-
ãîâîãî ñëàéäåðà íà ãðàôîïîñòðîèòåëüíîé ïàíåëè. Ðåãóëèðîâêà îñóùåñòâëÿåòñÿ â äèàïàçîíå îò –60 VU äî +20VU,
ñ øàãîì 0.5 VU. Óñòàíîâêà ïî óìîë÷àíèþ: 0 VU.

Ïàíåëü Ratio. Â äàííîé ïàíåëè îòîáðàæàåòñÿ ñîîòíîøåíèå óñèëåíèÿ âõîäíîãî è âûõîäíîãî ñèãíàëà. Ýòî îïðåäå-
ëÿåò óðîâåíü ðåäàêöèè ñèãíàëà ïðîöåññîðà. Óñòàíîâêà 4:1, ê ïðèìåðó, îçíà÷àåò, ÷òî óâåëè÷åíèå óðîâíÿ ïðî-
ãðàììíîãî ìàòåðèàëà íà 4 äÁ âëå÷åò çà ñîáîé óâåëè÷åíèå óðîâíÿ âûõîäíîãî ñèãíàëà ïðîöåññîðà íà 1 äÁ.

Öèôðîâîå çíà÷åíèå äàííîé ïàíåëè ìîæåò èçìåíÿòñÿ ñ ïîìîùüþ êëàâèàòóðû, íàæàòèåì íà êíîïêè âîçðàñòàíèÿ è óáûâàíèÿ èëè
ñëàéäåðîì êîýôôèöèåíòà óñèëåíèÿ â ïðåäåëàõ îò 1:1 äî 10:1, ñ øàãîì 0.1. Óñòàíîâêà ïî óìîë÷àíèþ: 2:1.

Ïàíåëü Attack. Â äàííîé ïàíåëè îòîáðàæàåòñÿ âðåìÿ àòàêè, èçìåíÿåìîå â ïðåäåëàõ îò 0.2 ñåê äî 3 ñåê. Óñòàíîâ-
êà ïî óìîë÷àíèþ: 2 ñåê.

Ïàíåëü Decay. Â äàííîé ïàíåëè îòîáðàæàåòñÿ âðåìÿ çàòóõàíèÿ, èçìåíÿåìîå â äèàïàçîíå îò 0.5 ñåê äî 5 ñåê. Óñ-
òàíîâêà ïî óìîë÷àíèþ: 5 ñåê.

Ïàíåëü Hinge. Çäåñü îòîáðàæåíà óñòàíîâêà ðåçóëüòèðóþùåãî óðîâíÿ AGC. Ñèãíàë, ìåíüøèé äàííîãî óðîâíÿ (íî
âûøå ïîðîãà), áóäåò óñèëèâàòüñÿ è, íàîáîðîò. Çíà÷åíèå äàííîé ïàíåëè ìîæåò èçìåíÿòñÿ ñ ïîìîùüþ êëàâèàòóðû,
íàæàòèåì íà êíîïêè âîçðàñòàíèÿ è óáûâàíèÿ èëè îñíîâíûì ñëàéäåðîì â äèàïàçîíå îò –60 VU äî +20 VU, ñ øàãîì

0.5 VU. Óñòàíîâêà ïî óìîë÷àíèþ: 0 VU.

Ïåðåêëþ÷àòåëü Default. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ èçìåíåííûå ïàðàìåòðû ïðîöåññîðà ìîãóò áûòü âîç-
âðàùåíû ê óñòàíîâêàì ïî óìîë÷àíèþ.

Ïåðåêëþ÷àòåëü Bypass. Äàííûì ïåðåêëþ÷àòåëåì îñóùåñòâëÿåòñÿ âêëþ÷åíèå ïðîöåññîðà â ðåæèì
bypass (èíäèêàòîð ïåðåêëþ÷àòåëÿ ãîðèò êðàñíûì öâåòîì). Óñòàíîâêà ïî óìîë÷àíèþ: ðåæèì bypass
îòêëþ÷åí (ðèñóíîê ñïðàâà).

Ïåðåêëþ÷àòåëè Snapshot. Äàííàÿ ôóíêöèÿ ïîçâîëÿåò ñîçäàòü ìîìåíòàëüíûé ñíèìîê êðèâîé ÷àñòîòíîé õàðàêòåðèñ-
òèêè ñèãíàëà (íàæàòèå êíîïêè Take) è ïîêàçàòü åå íà ýêðàíå (íàæàòèå êíîïêè Show).
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Компрессор/лимитер
Общие сведения
Ïðåäóñìîòðåíû ñëåäóþùèå òèïû ëèìèòå-
ðîâ è êîìïðåññîðîâ:

Soft Knee — (Ïðîöåññîðû ñ ïëàâíî ïåðåñò-
ðàèâàåìûì ïîðîãîì) — Äàííûé òèï ïðîöåñ-
ñîðîâ îáåñïå÷èâàåò ïëàâíûé ïåðåõîä îò íå-
êîìïðåññèðîâàííîãî ñèãíàëà ê êîìïðåññè-
ðîâàííîìó è çàäåéñòâóþò äëÿ ñâîåé ðàáîòû
áîëüøèé ïðîöåíò ðåñóðñîâ ÷åì îáû÷íûå
ïðîöåññîðû. 

Ñòåðåîïðîöåññîðû — Äàííûé òèï ïðîöåñ-
ñîðîâ ïîçâîëÿåò ñîõðàíÿòü ñòåðåîèìèäæ è ðàñïîëàãàþòñÿ â äâóõ êàíàëàõ â âèäå îòäåëüíûõ ñèíõðîííî ðàáîòàþùèõ áëîêîâ. Ñòå-
ðåîïðîöåññîðû òàêæå çàäåéñòâóþò áîëüøèé ïðîöåíò ðåñóðñîâ ÷åì ìîíîïðîöåññîðû.

Окно параметров
Îêíà ïàðàìåòðîâ ïðîöåññîðîâ äàííîãî òèïà â òîé èëè èíîé ìåðå èäåíòè÷íû. Èíäèâèäóàëüíûå ðàçëè÷èÿ ìåæäó íèìè îïèñàíû îò-
äåëüíî â ñîîòâåòñòâóþùèõ ðàçäåëàõ.

Ãðàôîïîñòðîèòåëüíàÿ ïàíåëü. Äàííàÿ êðèâàÿ îòîáðàæàåò óñòàíîâêè ïîðîãîâîãî óðîâíÿ è êîýôôèöèåíòà êîìïðåññèè â âèäå
ãðàôè÷åñêèõ ýëåìåíòîâ, êîòîðûå ìîãóò ïåðåäâèãàòüñÿ ñ ïîìîùüþ ìûøè. Äàííàÿ êðèâàÿ îòîáðàæàåò èçìåíåíèÿ óðîâíÿ âûõîäíîãî
ñèãíàëà. 

Èçìåðèòåëü ãðàôîïîñòðîèòåëüíîé ïàíåëè. Â ðåæèìå Live äàííûé èçìåðèòåëü îòîáðàæàåò óðîâåíü âõîäíîãî è îòíîñèòåëüíîãî
âûõîäíîãî ñèãíàëîâ. Èçìåðèòåëü ïîçâîëÿåò îñóùåñòâëÿòü âèçóàëüíûé êîíòðîëü çà âîçäåéñòâèåì ïðîöåññîðà íà òåêóùèé ïðî-
ãðàììíûé ìàòåðèàë. Ôóíêöèÿ èçìåðèòåëÿ ìîæåò áûòü îòêëþ÷åíà èëè âêëþ÷åíà âûáîðîì â ìåíþ Options>Transfer Curve Meter. Óñ-
òàíîâêà ïî óìîë÷àíèþ: èçìåðèòåëü âêëþ÷åí.

Ñëàéäåð ïîðîãà. Ïîçèöèÿ ïîðîãîâîãî ñëàéäåðà ñîîòâåòñòâóåò óñòàíîâêå ïîðîãîâîãî ðåãóëÿòîðà. Ñëàéäåð ìîæåò ïåðåäâèãàòüñÿ
âëåâî è âïðàâî ñ ïîìîùüþ ìûøè äëÿ óñòàíîâêè íåîáõîäèìîãî çíà÷åíèÿ.

Ñëàéäåð ñòåïåíè ðåäàêöèè. Ïîçèöèÿ ñëàéäåðà êîýôôèöèåíòà ñîîòâåòñòâóåò óñòàíîâêå ðåãóëÿòîðà óñèëåíèÿ. Ñëàéäåð ìîæåò
ïåðåäâèãàòüñÿ ââåðõ è âíèç ñ ïîìîùüþ ìûøè äëÿ óñòàíîâêè íåîáõîäèìîãî óñèëåíèÿ.

Èçìåðèòåëü èçìåíåíèÿ óñèëåíèÿ. Äàííûé èçìåðèòåëü îòîáðàæàåò îáùåå èçìåíåíèå óñèëåíèÿ âõîäíîãî ñèãíàëà ïðè òåêóùèõ
óñòàíîâêàõ ïðîöåññîðà. Äàííàÿ ôóíêöèÿ ìîæåò áûòü âêëþ÷åíà èëè âûêëþ÷åíà âûáîðîì Options>Gain Reduction Meter â ìåíþ. Óñ-
òàíîâêà ïî óìîë÷àíèþ: èçìåðèòåëü âêëþ÷åí.

Ðåãóëÿòîðû óñèëåíèÿ. Äàííûå ðåãóëÿòîðû èñïîëüçóþòñÿ äëÿ óñòàíîâêè âõîäíîãî è âûõîäíîãî óñèëåíèÿ â ïðåäåëàõ îò –12 äÁ äî
+12 äÁ ñ øàãîì 0.5 äÁ. Óñòàíîâêà ðåãóëÿòîðîâ ïî óìîë÷àíèþ: 0 äÁ.

Èíäèêàòîð ïðåâûøåíèÿ ïîðîãîâîé âåëè÷èíû (Threshold Exceeded). 

Äàííûé èíäèêàòîð ãîðèò æåëòûì öâåòîì åñëè óðîâåíü âõîäíîãî ñèãíàëà ïðå-
âûøàåò óñòàíîâëåííóþ ïîðîãîâóþ âåëè÷èíó.

Ïàíåëü Threshold. Â äàííîé ïàíåëè îòîáðàæàåòñÿ ïîðîãîâîå çíà÷åíèå ñðàáàòûâàíèÿ ïðîöåññîðà, êîòîðîå ìî-
æåò áûòü óñòàíîâëåíî ñ ïîìîùüþ êëàâèàòóðû, íàæàòèåì íà êíîïêè âîçðàñòàíèÿ è óáûâàíèÿ èëè óñòàíîâêîé ïîðî-
ãîâîãî ñëàéäåðà íà ãðàôîïîñòðîèòåëüíîé ïàíåëè. Ðåãóëèðîâêà îñóùåñòâëÿåòñÿ â äèàïàçîíå îò –60 VU äî +20VU,

ñ øàãîì 0.5 VU. Óñòàíîâêà ïî óìîë÷àíèþ: 0 VU.

Ïàíåëü Ratio. Â äàííîé ïàíåëè îòîáðàæàåòñÿ îòíîøåíèå óñèëåíèÿ âõîäíîãî è âûõîäíîãî ñèãíàëà. Ýòî èíäèöè-
ðóåò óðîâåíü ðåäàêöèè ñèãíàëà íà âûõîäå ïðîöåññîðà, îòíîñèòåëüíî âõîäíîãî óðîâíÿ. Óñòàíîâêà 4:1, ê ïðèìåðó,
îçíà÷àåò, ÷òî óâåëè÷åíèå óðîâíÿ ïðîãðàììíîãî ìàòåðèàëà íà 4 äÁ âëå÷åò çà ñîáîé óâåëè÷åíèå óðîâíÿ âûõîäíîãî
ñèãíàëà ïðîöåññîðà íà 1 äÁ.

Çíà÷åíèå äàííîé ïàíåëè ìîæåò èçìåíÿòñÿ ñ ïîìîùüþ êëàâèàòóðû, íàæàòèåì íà êíîïîê âîçðàñòàíèÿ è óáûâàíèÿ èëè ñëàéäåðîì êîýô-
ôèöèåíòà óñèëåíèÿ â ïðåäåëàõ îò 1:1 äî INF:1, ñ øàãîì 0.1. Óñòàíîâêà ïî óìîë÷àíèþ: 2:1 (äëÿ êîìïðåññîðîâ) è 10:1 (äëÿ ëèìèòåðîâ).
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P4800 îáåñïå÷èâàåò ñëåäóþùèå òèïû êîìïðåññîðîâ è ëèìèòåðîâ: 

Óðîâåíü ñèãíàëà ïðåâûøàåò ïîðîãîâîå çíà÷åíèå

Óðîâåíü ñèãíàëà íå ïðåâûøàåò ïîðîãîâîå çíà÷åíèå



Ïàíåëü Attack. Â äàííîé ïàíåëè îòîáðàæàåòñÿ âðåìÿ àòàêè, èçìåíÿåìîå â ïðåäåëàõ îò 1 ìñåê äî 200 ìñåê. Óñòà-
íîâêà ïî óìîë÷àíèþ: 5 ìñåê (äëÿ êîìïðåññîðîâ) è 2 ìñåê (äëÿ ëèìèòåðîâ).

Ïàíåëü Decay. Â äàííîé ïàíåëè îòîáðàæàåòñÿ âðåìÿ çàòóõàíèÿ, èçìåíÿåìîå â äèàïàçîíå îò 50 ìñåê äî 
1000 ìñåê. Óñòàíîâêà ïî óìîë÷àíèþ: 100 ìñåê (äëÿ êîìïðåññîðîâ) è 50 ìñåê (äëÿ ëèìèòåðîâ).

Ïàíåëü Knee. Â ïðîöåññîðàõ ñ ïëàâíî ïåðåñòðàèâàåìûì ïîðîãîì äàííàÿ
ïàíåëü ïîçâîëÿåò âûáðàòü ñòåïåíü ïëàâíîñòè ïåðåñòðîéêè (ìÿãêàÿ "Soft"
è æåñòêàÿ "Hard"). Óñòàíîâêà ïî óìîë÷àíèþ: "Soft".

Ïðèìå÷àíèå: â ñòàíäàðòíûõ êîìïðåññîðàõ è ëèìèòåðàõ äàííàÿ ïàíåëü
îòêëþ÷åíà.

Ïåðåêëþ÷àòåëü Default. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ èçìåíåííûå ïàðàìåòðû ïðîöåññîðà ìîãóò áûòü âîç-
âðàùåíû ê óñòàíîâêàì ïî óìîë÷àíèþ.

Ïåðåêëþ÷àòåëü Bypass. Äàííûì ïåðåêëþ÷àòåëåì îñóùåñòâëÿåòñÿ âêëþ÷åíèå ïðîöåññîðà â ðåæèì
bypass (èíäèêàòîð ïåðåêëþ÷àòåëÿ ãîðèò êðàñíûì öâåòîì). Óñòàíîâêà ïî óìîë÷àíèþ: ðåæèì bypass
îòêëþ÷åí.

Ïåðåêëþ÷àòåëè Snapshot. Äàííàÿ ôóíêöèÿ ïîçâîëÿåò ñîçäàòü ìîìåíòàëüíûé ñíèìîê êðèâîé ÷àñòîòíîé õàðàêòåðèñ-
òèêè ñèãíàëà (íàæàòèå êíîïêè Take) è ïîêàçàòü åå íà ýêðàíå (íàæàòèå êíîïêè Show).

Процессоры с плавно перестраиваемым порогом
Â äàííîì ðàçäåëå íà äèàãðàììàõ ïðåäñòàâëåíà ðàáîòà ïðîöåññîðîâ ñ ïëàâíî ïåðåñòðàèâàåìûì ïîðî-
ãîì â ìÿãêîì è æåñòêîì ðåæèìàõ êîìïðåññèè.

Ðåæèì ìÿãêîé êîìïðåññèè ïîëåçåí ïðè ðàáîòå ñ âûñîêèì êîýôôèöèåíòîì
êîìïðåññèè. Â ýòîì ñëó÷àå êîýôôèöèåíò êîìïðåññèè ïîñòåïåííî ïîâûøàåò-
ñÿ îò 1:1 (ïðèìåðíî íà 12 äÁ íèæå ïîðîãà) äî âûáðàííîãî êîýôôèöèåíòà
(ïðèìåðíî íà 20 äÁ âûøå ïîðîãà). 

Íà äèàãðàììå ñïðàâà èçîáðàæåíà êðèâàÿ æåñòêîãî íàðàñòàíèÿ. Â ýòîì ñëó÷àå
êîìïðåññèÿ íåìåäëåííî äîñòèãàåò óñòàíîâëåííîãî êîýôôèöèåíòà êîãäà óðî-
âåíü ñèãíàëà ïðåâûøàåò ïîðîãîâîå çíà÷åíèå. Ðåæèì æåñòêîé êîìïðåññèè
ïðåêðàñíî ïîäõîäèò äëÿ ðàáîòû ëèìèòåðà, ïðåäóïðåæäàÿ ïåðåãðóçêè îò âíå-

çàïíûõ ïèêîâûõ ñèãíàëîâ.

Ïðèìå÷àíèå: â ñëó÷àÿõ, ãäå òðåáóåòñÿ ïðèìåíåíèå ðåæèìà æåñòêîãî íàðàñòàíèÿ, äëÿ ýêîíîìèè ðåñóðñîâ DSP ìîæíî èñïîëüçî-
âàòü ñòàíäàðòíûé òèï ïðîöåññîðà.

Стереопроцессоры
Ñòåðåîïðîöåññîðû èìåþò òå æå ôóíêöèè è îñîáåííîñòè, ÷òî è ìîíîïðîöåññîðû ñ íåêîòîðûìè äîïîëíèòåëüíûìè âîçìîæíîñòÿìè
ñðåäè êîòîðûõ:

• Èçìåíåíèÿ óñòàíîâîê îäíîãî èç êàíàëîâ ñòåðåîïðîöåññîðà ïîâëåêóò çà ñîáîé èäåíòè÷íûå èçìåíåíèÿ â óñòàíîâêàõ äðóãîãî êàíàëà.

• Îáà êàíàëà ñòåðåîïðîöåññîðà ðåàãèðóþò íà ñèãíàë ñ èäåíòè÷íûì ïîíèæåíèåì óñèëåíèÿ ïðè ïîñòóïëåíèè íà èõ âõîäû ñèãíàëà
ïðåâûøàþùåãî óñòàíîâëåííûé ïîðîã.

• Èçìåðèòåëè ãðàôîïîñòðîèòåëüíîé ïàíåëè îêðàøåíû â êðàñíûé öâåò äëÿ êàíàëà À è â ñèíèé öâåò äëÿ êàíàëà Â.

• Èçìåðèòåëüíûå ñåëåêòîðû ïîçâîëÿþò êîíòðîëèðîâàòü èçîáðàæåíèå êðèâîé êàíàëà À, êàíàëà Â, îáîèõ êàíàëîâ îäíîâðåìåííî
èëè íè îäíîãî èç íèõ.

• Ïðåäóñìîòðåíû èíäèêàòîðû ïðåâûøåíèÿ ïîðîãîâîé âåëè÷èíû äëÿ îáîèõ êàíàëîâ.

Кроссовер/Сплиттер
Êðîññîâåðû ïîçâîëÿþò ðàçäåëèòü îäèí âõîäíîé ñèãíàë íà íåñêîëüêî ñ ðàç-
ëè÷íûì ÷àñòîòíûì äèàïàçîíîì.

Ñïëèòòåðû ïðåäíàçíà÷åíû äëÿ ðàçâåòâëåíèÿ îäíîãî ñèãíàëà íà íåñêîëüêî
èäåíòè÷íûõ.

Применение
Èñïîëüçóéòå êðîññîâåð äëÿ ðàçäåëåíèÿ ÷àñòîòíîãî äèàïàçîíà âõîäíîãî ñèã-
íàëà íà íåñêîëüêî ïîëîñ è çàòåì ðàçäåëåííîì âèäå ïîäàâàéòå èõ íà ðàçëè÷-
íûå òèïû óñèëèòåëåé è äèíàìèêîâ. Èñïîëüçóéòå ñïëèòòåð äëÿ ðàçäåëåíèÿ
ñèãíàëà è ïîäà÷è èõ íà âõîäû íåñêîëüêèõ óñèëèòåëåé. Äëÿ ñïëèòòåðîâ íå ïðå-
äóñìîòðåíî îêíà ïàðàìåòðîâ, ïîñêîëüêó íèêàêîé îáðàáîòêè ñèãíàëà, êðîìå åãî ðàçäåëåíèÿ â íèõ íå ïðîèñõîäèò. 

Êðîññîâåðû è ñïëèòòåðû ïðåäíàçíà÷åíû äëÿ ðàáîòû â âûõîäíûõ öåïÿõ, ïîýòîìó íå ìîãóò áûòü óñòàíîâëåíû âî âõîäíûå êàíàëüíûå
ëèíåéêè.

Окно параметров
Äëÿ îïèñàíèÿ îêíà ïàðàìåòðîâ â äàííîì ðàçäåëå èñïîëüçîâàí 4-ïîëîñíûé êðîññîâåð. Îñîáåííîñòè óñòàíîâîê äëÿ âñåõ êðîññîâå-
ðîâ îäèíàêîâûå, èñêëþ÷àÿ êîëè÷åñòâî ïîëîñ.

Ãðàôîïîñòðîèòåëüíàÿ ïàíåëü. Â äàííîé ÷àñòè îêíà ðàçìåùåíû àêòèâíûå ýëåìåíòû, ñ ïîìîùüþ êîòîðûõ îñóùåñòâëÿåòñÿ óñòà-
íîâêà ïàðàìåòðîâ ôèëüòðîâ è òî÷åê êðîññîâåðîâ. Ãðàôè÷åñêèå àêòèâíûå ýëåìåíòû ìîãóò ïåðåìåùàòüñÿ ñ ïîìîùüþ ìûøè.
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Ïðîöåññîð ñ
ïëàâíîïåðåñòðàèâàåìûì

ïîðîãîì Âûáåðèòå "Soft" èëè "Hard"

Ïàíåëü îòêëþ÷åíà
Ñòàíäàðòíûé

ïðîöåññîð

Bypass âêëþ÷åí

Bypass îòêëþ÷åí

Ïðåäóñìîòðåíû ñëåäóþùèå òèïû ïðîöåññîðîâ:



Ïîëîñû ïðîïóñêàíèÿ. Êàæäàÿ ïîëîñà èìååò óãëîâûå òî÷êè, êîòîðûå ìîãóò ïåðåìåùàòüñÿ âëåâî è âïðàâî çàõâàòîì ìûøè äëÿ èí-
äèâèäóàëüíîé óñòàíîâêè âåðõíåé è íèæíåé òî÷åê ÷àñòîò îáðåçàíèÿ. Â öåíòðå êàæäîé ïîëîñû èìååòñÿ òàêæå òî÷êà
äëÿ óñòàíîâêè óñèëåíèÿ ïîëîñû, ïåðåìåùàåìàÿ ââåðõ è âíèç ìûøüþ. Êðóòèçíà ôèëüòðà ìî-
æåò óñòàíàâëèâàòüñÿ ñ ïîìîùüþ ðàñïîëîæåííûõ â íèæíåé ÷àñòè îêíà ýëåìåíòîâ.

Òî÷êè êðîññîâåðà. Òî÷êè êðîññîâåðà âûïîëíåíû â âèäå ðóêîÿòîê, êîòîðûå ìîãóò ïåðåìåùàòüñÿ âïðàâî è
âëåâî ñ îäíîâðåìåííûì èçìåíåíèåì òî÷êè ïåðåñå÷åíèÿ êðèâûõ êðóòèçíû (ðèñóíîê ñïðàâà). Ïðè âûáîðå òî÷-
êà êðîññîâåðà îêðàøèâàåòñÿ â çåëåíûé öâåò. Îäíîâðåìåííî àêòèâèçèðóþòñÿ òî÷êè ÷àñòîòû îáðåçàíèÿ ñîîò-
âåòñòâóþùèõ ôèëüòðîâ.

Ìàðêèðîâêà âûõîäíîãî êàíàëà. Ìàðêèðîâî÷íàÿ ïàíåëü êàæäîãî êàíàëà îêðà-
øåíà â öâåò, ñîîòâåòñòâóþùèé öâåòó êðèâîé íà ãðàôè÷åñêîé ïàíåëè. Â òîæå âðå-
ìÿ äàííàÿ ïàíåëü óêàçûâàåò âûõîäíîé êàíàë íà êîòîðûé íàïðàâëåí îòôèëüòðî-
âàííûé ñèãíàë.

Ïåðåêëþ÷àòåëè Set and Show Gains Plot è Normalize Plot. Äàííûå ïåðåêëþ÷à-
òåëè (ðèñóíêè ñïðàâà) ïîçâîëÿþò óâèäåòü íà äèñïëåå ðåàëüíîå óñèëåíèå êàæäîé
ïîëîñû è íîðìàëèçîâàííîå. Óñòàíîâêà ïî óìîë÷àíèþ: ðåàëüíîå óñèëåíèå 
(Set and Show Gains on Plot).

Ïðè ðàçëè÷íûõ óñèëåíèÿõ òî÷êà êðîññîâåðà íàõîäèòñÿ â ñòîðîíå îò ñâîåãî åñòå-
ñòâåííîãî ïîëîæåíèÿ, êàê âèäíî èç ðèñóíêîâ. 

• Íàæìèòå êíîïêó Set and Show Gains on Plot äëÿ îòîáðàæåíèÿ è óñòàíîâêè íåîá-
õîäèìîãî óñèëåíèÿ ÷àñòîòíûõ ïîëîñ ñ ïîìîùüþ ðàñïîëîæåííûõ íà íèõ òî÷åê
äëÿ óñòàíîâêè óñèëåíèÿ.

• Íàæìèòå êíîïêó Normalize Plot äëÿ îòîáðàæåíèÿ òî÷íîãî ðàñïîëîæåíèÿ òî÷êè
êðîññîâåðà ïðè îäèíàêîâîì óñèëåíèè ïîëîñ. Âêëþ÷åíèå äàííîãî ðåæèìà íå
âëèÿåò íà ðåàëüíûå óñòàíîâêè óñèëåíèÿ.

Ïåðåêëþ÷àòåëü Default. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ âêëþ÷àþòñÿ ïàðàìåòðû ìîäóëÿ ïî óìîë÷àíèþ.

Ïåðåêëþ÷àòåëü Mute. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ ìüþòèðóåòñÿ âûõîäíîé êàíàë. Ïðè ýòîì
êíîïêà ãîðèò êðàñíûì öâåòîì. Óñòàíîâêà ïî óìîë÷àíèþ: ðåæèì îòêëþ÷åí.

Ïåðåêëþ÷àòåëü Polarity. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ îñóùåñòâëÿåòñÿ èíâåðòèðîâàíèå
ïîëÿðíîñòè ñèãíàëà. Óñòàíîâêà ïî óìîë÷àíèþ: íåèíâåðòèðîâàííûé ñèãíàë.

Ïàíåëü Low Corner Freq. Äàííàÿ ïàíåëü îòîáðàæàåò çíà÷åíèå íèæíåé òî÷êè ÷àñòîòû îáðåçíîãî ôèëüòðà. Äèàïà-
çîí äîñòóïíûõ ÷àñòîò ýòîé ïàíåëè âàðüèðóåòñÿ â çàâèñèìîñòè îò çíà÷åíèÿ âåðõíåé òî÷êè ÷àñòîòû îáðåçàíèÿ. Çíà-
÷åíèÿ ÷àñòîò ìîãóò

èçìåíÿòüñÿ ïîëüçîâàòåëåì ñ ïîìî-
ùüþ êëàâèàòóðû èëè íàæàòèåì êíî-
ïîê âîçðàñòàíèÿ è óáûâàíèÿ. Óñòà-
íîâêè ïî óìîë÷àíèþ äëÿ ðàçëè÷íûõ
÷àñòîòíûõ ïîëîñ êàæäîãî òèïà êðîñ-
ñîâåðà ïðèâåäåíû â òàáëèöå ñïðàâà.
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Ãðàôîïîñòðîèòåëüíàÿ
ïàíåëü

Íàçâàíèå 
âûõîäíîãî 

êàíàëà

Ðåãóëÿòîðû
ïîëîñû

ïðîïóñêàíèÿ

Òî÷êà
êðîññîâåðà

Ïîëîñà
ïðîïóñêàíèÿ

Óãëîâûå
òî÷êè

Òî÷êè
óñèëåíèÿ

Ìüþò âêëþ÷åí

Ìüþò âûêëþ÷åí

Ñèãíàë íå èíâåðòèðîâàí

Ñèãíàë èíâåðòèðîâàí



Ïàíåëü Low Filter Type/Upper Filter Type. Äàííàÿ
ïàíåëü îòîáðàæàåò êîýôôèöèåíò êðóòèçíû äëÿ
êàæäîãî ôèëüòðà. Âûáîð îñóùåñòâëÿåòñÿ â ðàçâî-

ðà÷èâàþùåìñÿ ìåíþ èç ñïèñêà ïðåäñòàâëåííîãî â òàáëèöå ñïðàâà.
Óñòàíîâêà ïî óìîë÷àíèþ: 24 äÁ/îêòàâó, ôèëüòð Ëèíêâèöà-Ðýéëè.

Ïàíåëü Upper Corner Freq. Äàííàÿ ïàíåëü îòîá-
ðàæàåò çíà÷åíèå âåðõíåé òî÷êè ÷àñòîòû îáðåçíîãî
ôèëüòðà. ng of the upper corner of the pass band.

Äèàïàçîí äîñòóïíûõ ÷àñòîò ýòîé ïàíåëè âàðüèðóåòñÿ â çàâèñèìîñòè
îò çíà÷åíèÿ íèæíåé òî÷êè ÷àñòîòû îáðåçàíèÿ. Çíà÷åíèÿ ÷àñòîò ìîãóò
èçìåíÿòüñÿ ïîëüçîâàòåëåì ñ ïîìîùüþ êëàâèàòóðû èëè íàæàòèåì êíîïîê âîçðàñòàíèÿ è óáûâàíèÿ. Óñòàíîâêè ïî óìîë÷àíèþ äëÿ
ðàçëè÷íûõ ÷àñòîòíûõ ïîëîñ êàæäîãî òèïà êðîññîâåðà ïðèâåäåíû â òàáëèöå íèæå.

Gain. Â äàííîé ïàíåëè îòîáðàæàåòñÿ òåêóùàÿ óñòàíîâêà êîýôôèöèåíòà óñèëåíèÿ ñîîòâåòñòâóþùåãî ôèëüòðà. Èçìåíåíèå çíà÷å-
íèé îñóùåñòâëÿåòñÿ â äèàïàçîíå îò –18 äÁ äî +12 äÁ ñ øàãîì 0.5 äÁ. Óñòàíîâêà ïî óìîë÷àíèþ: 0 äÁ.

Управление с помощью клавиатуры
Óïðàâëåíèå íåêîòîðûìè ïàðàìåòðàìè âîçìîæíî îñóùåñòâëÿòü ñ ïîìîùüþ êëàâèàòóðû. Äëÿ ýòîãî íåîáõîäèìî âûáðàòü ìûøüþ ñî-
îòâåòñòâóþùóþ òî÷êó íà äèàãðàììå (ðåãóëèðîâêè óñèëåíèÿ èëè îáðåçàíèÿ ÷àñòîòû) è èñïîëüçîâàòü êëàâèàòóðó äëÿ óñòàíîâêè
íåîáõîäèìûõ ïàðàìåòðîâ.

Обрезные и полочные фильтры
Применение
Äàííûå ìîäóëè ðåêîìåíäóåòñÿ ïðèìåíÿòü â ñîâîêóïíî-
ñòè ñ ýêâàëàéçåðàìè øèðîêîãî ïðèìåíåíèÿ. Êðóòèçíà
îáðåçíûõ ôèëüòðîâ ìîæåò èçìåíÿòüñÿ îò –6 äÁ/îêòàâó
äî 24 äÁ/îêòàâó. Âîçìîæåí òàêæå âûáîð êðóòèçíû ïî-
ëî÷íîãî ôèëüòðà (6 äÁ/îêòàâó èëè 12 äÁ/îêòàâó).

Окно параметров

Ãðàôîïîñòðîèòåëüíàÿ ïàíåëü. Â äàííîé ÷àñòè îêíà ïàðàìåòðîâ ðàçìåùåíû àêòèâíûå ýëåìåíòû, ñ ïîìîùüþ êîòîðûõ îñóùåñòâ-
ëÿåòñÿ óñòàíîâêà õàðàêòåðèñòèê îáðåçíîãî è ïîëî÷íîãî ôèëüòðîâ. Ïðè ïåðâè÷íîì îòêðûòèè îêíà âñå ýëåìåíòû ðàçìåùåíû â ñî-
îòâåòñòâèè ñ óñòàíîâêàìè ïî óìîë÷àíèþ. Èõ ïåðåìåùåíèå îñóùåñòâëÿåòñÿ ñ ïîìîùüþ ìûøè.

Äèàãðàììíàÿ ïàíåëü. Â äàííîé ïàíåëè îòîáðàæåíà ñóììàðíàÿ ÷àñòîòíàÿ äèàãðàììà ñôîðìèðîâàííàÿ ýëåìåíòàìè óïðàâëåíèÿ
ãðàôîïîñòðîèòåëüíîé ïàíåëè.

Ïðèìå÷àíèå: Äàííàÿ õàðàêòåðèñòèêà íå îòðàæàåò îáùåãî âîçäåéñòâèÿ íà ñèãíàë ïðîöåññîðîâ çâóêîâîãî òðàêòà.

Îáðåçíûå ôèëüòðû. Îáðåçíûå ôèëüòðû âûïîëíåíû ãðàôè÷åñêè â âèäå äâóõ ðóêîÿòîê ðàñïîëîæåííûõ â íèæíåé ÷àñòè ãðàôîïîñò-
ðîèòåëüíîé ïàíåëè. Âåðòèêàëüíûå ëèíèè îòðàæàþò èõ öåíòðàëüíûå ÷àñòîòû. Óñòàíîâêè ïî óìîë÷àíèþ: âûêëþ÷åíû, 6 äÁ/îêòàâó
Áàòòåðâîðòà.

Ïîëî÷íûå ôèëüòðû. Ãðàôè÷åñêîå èçîáðàæåíèå ïîëî÷íûõ ôèëüòðîâ ïðîõîäèò âäîëü ãîðèçîíòàëüíîé îñè ïàíåëè. Óñòàíîâêè ïî
óìîë÷àíèþ: âûêëþ÷åíû, 6 äÁ/îêòàâó.
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Ãðàôîïîñòðîèòåëüíàÿ
ïàíåëü

×àñòîòíàÿ
õàðàêòåðèñòèêà

Îáðåçíûå ôèëüòðû

Ïîëî÷íûå
ôèëüòðû

Ïðåäóñìîòðåíû ñëåäóþùèå òèïû ìîäóëåé ôèëüòðîâ:



Ïàíåëü Freq. Â äàííîé ïàíåëè îòîáðàæàåòñÿ ÷àñòîòà âûáðàííîé òî÷êè ôèëüòðà, êîòîðóþ ìîæíî èçìåíèòü íà-
æàòèåì êíîïîê âîçðàñòàíèÿ èëè óáûâàíèÿ èëè ñ ïîìîùüþ êëàâèàòóðû. Äèàïàçîí ÷àñòîò ðåãóëèðóåòñÿ â ïðåäå-

ëàõ 25 Ãö — 20 êÃö. Óñòàíîâêà ïî óìîë÷àíèþ: "OUT".

Ïàíåëü Type. Â äàííîé
ïàíåëè îòîáðàæàåòñÿ

òèï ôèëüòðà, âûáîð êîòîðîãî îñóùåñòâëÿåòñÿ â îòêðûâà-
þùåìñÿ ìåíþ ñîãëàñíî ïðèâåäåííîé òàáëèöå.

Ïàíåëü Gain. Â äàííîé ïàíåëè
îòîáðàæàåòñÿ òåêóùåå çíà÷åíèå êîýôôèöèåíòà óñèëåíèÿ âûáðàííîãî ïîëî÷íîãî ôèëüòðà. Ðåãóëèðîâêà óñè-
ëåíèÿ îñóùåñòâëÿåòñÿ â äèàïàçîíå îò –18 äÁ äî +18 äÁ ñ øàãîì 0.5 äÁ. Óñòàíîâêà ïî óìîë÷àíèþ: 0 äÁ.

Äàííàÿ ïàíåëü îòêëþ÷åíà â ñëó÷àå èñïîëüçîâàíèÿ îáðåçíîãî ôèëüòðà.

Ïåðåêëþ÷àòåëü Clear. Ïðè íàæàòèè íà äàííûé ïåðåêëþ÷àòåëü îòêðûâàåòñÿ äèàëîãîâîå îêíî, ïîçâîëÿþùåå âîññòà-
íîâèòü âñå èëè òîëüêî âûáðàííûå óñòàíîâêè ïàðàìåòðîâ ôèëüòðà ïî óìîë÷àíèþ.

Ïåðåêëþ÷àòåëü Bypass. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ îñóùåñòâëÿåòñÿ âêëþ÷å-
íèå ïðîöåññîðíîãî ìîäóëÿ â ðåæèì bypass (ãîðèò êðàñíûé èíäèêàòîð). Óñòàíîâêà ïî
óìîë÷àíèþ: ðåæèì îòêëþ÷åí.

Snapshot. Äàííàÿ ôóíêöèÿ ïîçâîëÿåò çàôèêñèðîâàòü èçîáðàæåíèå òåêóùåé ÷àñòîòíîé äèàãðàììû (íàæàòèå êíîïêè
Take) è çàòåì îòîáðàçèòü åãî íà çàäíåì ïëàíå äèñïëåÿ (íàæàòèå êíîïêè Show) äëÿ äàëüíåéøåãî ñðàâíåíèÿ. Ïðè îòî-
áðàæåíèè êàäðà ãîðèò çåëåíûé èíäèêàòîð êíîïêè.

Тонкая настройка параметров
Âîçìîæíà ïðåöèçèîííàÿ íàñòðîéêà ïàðàìåòðîâ âûáðàííîãî ôèëüòðà ñ èñïîëüçîâàíèåì ñëåäóþùèõ ìåòîäîâ:

• Ââåäåíèå ÷èñëîâûõ çíà÷åíèé â ïàíåëè ïàðàìåòðîâ.

• Íàæàòèå êíîïîê âîçðàñòàíèÿ è óáûâàíèÿ ïàíåëåé ïàðàìåòðîâ (èëè âûáîð èç ðàñêðûâàþùåãîñÿ âíèç ìåíþ).

• Èñïîëüçîâàíèå êëàâèàòóðû.

Управление с помощью клавиатуры
Ðåãóëèðîâêà ïàðàìåòðîâ âûáðàííîãî ôèëüòðà êëàâèøàìè êëàâèàòóðû îñóùåñòâëÿåòñÿ â ñîîòâåòñòâèè ñ ïðèâåäåííîé òàáëèöåé.

Копирование и вставка
Â îêíàõ îáðåçíûõ è ïîëî÷íûõ ôèëüòðîâ ìîæåò îñóùåñòâ-
ëÿòüñÿ êîïèðîâàíèå è âñòàâêà ïàðàìåòðîâ.

Äëÿ ýòîãî:

1. Âûáåðèòå ìûøüþ îäèí èëè íåñêîëüêî (÷åðåç íàæàòèå
êëàâèøè Ctrl êëàâèàòóðû) ìîäóëåé ôèëüòðîâ.

2. Âûáåðèòå êîìàíäó Edit>Copy â ìåíþ.

3. Îòêðîéòå îêíî îáðåçíîãî èëè ïîëî÷íîãî ôèëüòðà â êî-
òîðîå òðåáóåòñÿ âñòàâèòü ñêîïèðîâàííûå ïàðàìåòðû

4. Âûáåðèòå êîìàíäó Edit>Paste â ìåíþ.

Задержка
Ñèñòåìà îáåñïå÷èâàåò ñëåäóþùèå òèïû çàäåðæêè:

Применение
Çàäåðæêà èñïîëüçóåòñÿ äëÿ ñîãëàñîâàíèÿ çâó÷àíèÿ êîëîíîê, íà-
õîäÿùèõñÿ íà ðàññòîÿíèè äðóã îò äðóãà äëÿ îäíîâðåìåííîãî ïî-
ñòóïëåíèÿ çâóêîâûõ âîëí ê ñëóøàòåëþ. Çàäåðæêà ìîæåò òàêæå
áûòü èñïîëüçîâàíà äëÿ óñòðàíåíèÿ ïðîáëåì ôàçîâîãî ñîãëàñîâà-

íèÿ ìåæäó ðàçëè÷íûìè êîëîíêàìè. Çàäåðæêà ìîæåò áûòü ïîäñ÷èòàíà ñ ó÷åòîì âðåìåíè, ðàññòîÿíèÿ è òåìïåðàòóðû âîçäóõà. 

Ïðèìå÷àíèå: Êàæäûé ìîäóëü ïîòðåáëÿåò ìàêñèìàëüíóþ âðåìåííóþ ïàìÿòü â çàâèñèìîñòè îò òèïà çàäåðæêè, íåçàâèñèìî îò òîãî
êàêîå âðåìÿ çàäåðæêè èñïîëüçóåòñÿ. Â öåëÿõ ýêîíîìèè ðåñóðñîâ ñèñòåìíîãî ïðîöåññîðà èñïîëüçóéòå çàäåðæêè ñ ìàêñèìàëüíî-
áëèçêèì âðåìåíåì ê òðåáóåìîìó.

Окно параметров
Â êà÷åñòâå ïðèìåðà ïðèâåäåíî îêíî ïàðàìåòðîâ ìîäóëÿ DLY150. Îêíà
ïàðàìåòðîâ äðóãèõ ìîäóëåé èäåíòè÷íû ïðåäñòàâëåííîìó çà èñêëþ÷åíè-
åì ìàêñèìàëüíîãî âðåìåíè çàäåðæêè.

Ïàíåëü âðåìåíè. Â äàííîé ïàíåëè óñòàíàâ-
ëèâàåòñÿ âðåìÿ çàäåðæêè â ìèëëèñåêóíäàõ â
äèàïàçîíå îò 0 ìñåê äî ìàêñèìàëüíîãî âðå-

ìåíè çàäåðæêè ïðîöåññîðà (150 ìñåê â äàííîì ñëó÷àå). Óñòàíîâêà ïî
óìîë÷àíèþ: 0 ìñåê.

Ïàíåëü ðàññòîÿíèÿ. Â äàííîé ïàíåëè óñòàíàâ-
ëèâàåòñÿ çàäåðæêà ñ ó÷åòîì ðàññòîÿíèÿ â äþé-
ìàõ, ôóòàõ è ìåòðàõ. Óñòàíîâêà ïî óìîë÷àíèþ: 0 äþéìîâ.
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Ïàíåëü òåìïåðàòóðû âîçäóõà. Ïðè óñòàíîâêå çàäåðæêè ñ ó÷åòîì ðàññòîÿíèÿ â äàí-
íîé ïàíåëè óñòàíàâëèâàåòñÿ òåìïåðàòóðà âîçäóõà, ïîñêîëüêó åå èçìåíåíèÿ âëèÿþò íà
ïðîõîæäåíèå çâóêîâîãî ñèãíàëà. Óñòàíîâêà òåìïåðàòóðû ïî øêàëå Ôàðåíãåéòà èëè

Öåëüñèÿ îñóùåñòâëÿåòñÿ â äèàïàçîíå îò -13F äî 122F èëè îò -25C äî 50C. 

Ïåðåêëþ÷àòåëü Bypass. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ ìîäóëü âêëþ÷àåòñÿ â ðåæèì bypass
(èíäèêàòîð êíîïêè ãîðèò êðàñíûì öâåòîì). Óñòàíîâêà ïî óìîë÷àíèþ: ðåæèì îòêëþ÷åí.

Ïåðåêëþ÷àòåëü Clear. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ îñóùåñòâëÿåòñÿ âîçâðàò ê óñòàíîâêàì ïî óìîë÷àíèþ.

Цифровой подавитель самовозбуждения (DFR)
Äàííûé ïðîöåññîð (DFR) èñïîëüçóåò â ñâîåé ðà-
áîòå çàïàòåíòîâàííûé àäàïòèâíûé óçêîíàïðàâ-
ëåííûé óçêîïîëîñíûé ôèëüòð àâòîìàòè÷åñêè îï-
ðåäåëÿþùèé ÷àñòîòó ñàìîâîçáóæäåíèÿ è ïîäàâ-
ëÿþùèé åãî.

Применение
Äàííûé DFR-ïðîöåññîð ìîæíî èñïîëüçîâàòü êàê ïåðâè÷íûé ìîäóëü â ëþáîì âõîäíîì êàíàëå íà êîòîðûé ïîñòóïàåò ìèêðîôîííûé
ñèãíàë è âåëèêà âîçìîæíîñòü âîçíèêíîâåíèÿ ñàìîâîçáóæäåíèÿ. Ïðè îáíàðóæåíèè ýòîãî ýôôåêòà DFR àâòîìàòè÷åñêè àêòèâèðóåò
äèíàìè÷åñêèé ôèëüòð ñ íà÷àëüíûì âêëþ÷åíèåì â öåïü óçêîïîëîñíîãî óçêîïîëîñíûé ôèëüòðà (-3 dB, 1/10 îêòàâû) íà ÷àñòîòå ñà-
ìîâîçáóæäåíèÿ ñ ïîñëåäóþùèì óâåëè÷åíèåì êðóòèçíû äî -18 äÁ (ñ øàãîì 3 äÁ) äî ïðåêðàùåíèÿ ñàìîâîçáóæäåíèÿ. Âîçìîæíà
òàêæå óñòàíîâêà ôèêñèðîâàííûõ ôèëüòðîâ â îïðåäåëåííûõ òî÷êàõ ÷àñòîòíîãî äèàïàçîíà. Åñëè DFR îïðåäåëèò ñàìîâîçáóæäåíèå
íà ÷àñòîòå ôèêñèðîâàííîãî ôèëüòðà, òî îíî áóäåò ïîäàâëÿòüñÿ äèíàìè÷åñêèì ôèëüòðîì. 

Окно параметров
Â äàííîì ñëó÷àå, â êà÷åñòâå ïðèìåðà ïðèâåäåíî
èçîáðàæåíèå îêíà ïàðàìåòðîâ ìîäóëÿ DFR10. Îêíî
ïàðàìåòðîâ ìîäóëÿ DFR5 èäåíòè÷íî ïðåäñòàâëåí-
íîìó çà èñêëþ÷åíèåì êîëè÷åñòâà èñïîëüçóåìûõ óç-
êîïîëîñíûõ ôèëüòðîâ.

Ãðàôè÷åñêàÿ ïàíåëü. Íà ãðàôè÷åñêîé ïàíåëè
ïðåäñòàâëåíà ÷àñòîòíàÿ õàðàêòåðèñòèêà ìîäóëüíî-
ãî ïðîöåññîðà ïîëó÷åííàÿ ïîñëå óñòàíîâêè àêòèâ-
íûõ óçêîïîëîñíûõ ôèëüòðîâ (æåëòûå ñåãìåíòû èí-
äèêàòîðà).

Ïðèìå÷àíèå: Äàííàÿ êðèâàÿ íå îòðàæàåò ñóììàð-
íîé ÷àñòîòíîé õàðàêòåðèñòèêè âñåãî òðàêòà.

Ïàíåëü Freq. Â äàííîé ïàíåëè óñòàíàâëèâàåòñÿ ÷àñòîòà âûáðàííîãî ôèëüòðà â äèàïàçîíå îò 25 Ãö äî 20 êÃö
ñ ïîìîùüþ êíîïîê óâåëè÷åíèÿ èëè ïîíèæåíèÿ çíà÷åíèé èëè êëàâèàòóðû. Óñòàíîâêà ïî óìîë÷àíèþ: "OUT".

Ïàíåëü Depth. Â äàííîé ïàíåëè óñòàíàâëèâàåòñÿ êîýôôèöèåíò óñèëåíèÿ âûáðàííîãî ôèëüòðà â ïðåäå-
ëàõ îò 0 äÁ äî –18 äÁ ñ øàãîì 0.5 äÁ. Óñòàíîâêà ïî óìîë÷àíèþ: 0 äÁ.

Ïàíåëü Type. Â äàííîé ïàíåëè óñòàíàâëèâàåòñÿ òèï ÷àñòîòíîãî äèàïàçîíà ôèëüòðà. Âûáîð îñóùåñòâëÿ-
åòñÿ èç ðàñêðûâàþùåãîñÿ âíèç ìåíþ (High Q èëè Low Q). Óñòàíîâêà ïî óìîë÷àíèþ: Low Q.

Èíäèêàòîð âûáîðà ôèëüòðîâ. Âûáîð êîëè÷åñòâà äèíàìè÷åñêèõ ôèëüòðîâ îñóùåñòâëÿåòñÿ ïåðåìå-
ùåíèåì êðàñíîé ñêîáû âëåâî è âïðàâî ñ ïîìîùüþ ìûøè. Àêòèâíûå ôèëüòðû ïðåäñòàâëåíû â âèäå
æåëòûõ èíäèêàòîðîâ è èõ âëèÿíèå îòðàæåíî íà ÷àñòîòíîé õàðàêòåðèñòèêå ìîäóëÿ.

Ïåðåêëþ÷àòåëü Lock. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ ïðåäóïðåæäàåòñÿ âêëþ÷åíèå íîâûõ ôèëü-
òðîâ è äàëüíåéøåå ïîíèæåíèå óñèëåíèÿ âêëþ÷åííûõ ôèëüòðîâ. Äàííûé ðåæèì ðåêîìåíäóåòñÿ
âêëþ÷àòü ïðè èñïîëüçîâàíèè ìóçûêàëüíûõ ïðîãðàìì íåñóùèõ â ñåáå ýëåìåíòû ñàìîâîçáóæäåíèÿ
èëè áëèçêèå ê íåìó çâóêè (ãèòàðíûå ýôôåêòû, ñèíòåçàòîðíûå çâóêè è òàê äàëåå).

Ïåðåêëþ÷àòåëü Clear. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ îòêðûâàåòñÿ äèàëîãîâîå îêíî, ïîçâîëÿþùåå ÷àñòè÷íî
èëè ïîëíîñòüþ îòìåíèòü ïîëüçîâàòåëüñêèå óñòàíîâêè.

Ïåðåêëþ÷àòåëü Bypass. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ ìîäóëü âêëþ÷àåòñÿ â ðåæèì bypass
(èíäèêàòîð êíîïêè ãîðèò êðàñíûì öâåòîì). Óñòàíîâêà ïî óìîë÷àíèþ: ðåæèì îò-
êëþ÷åí.

Snapshot. Äàííàÿ ôóíêöèÿ ïîçâîëÿåò çàôèêñèðîâàòü èçîáðàæåíèå òåêóùåé ÷àñòîòíîé äèàãðàììû (íàæàòèå
êíîïêè Take) è çàòåì îòîáðàçèòü åãî íà çàäíåì ïëàíå äèñïëåÿ (íàæàòèå êíîïêè Show) äëÿ äàëüíåéøåãî ñðàâíå-
íèÿ. Ïðè îòîáðàæåíèè êàäðà ãîðèò çåëåíûé èíäèêàòîð êíîïêè.
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Основные установки DFRMпроцессора
Óñòàíîâêà ïàðàìåòðîâ DFR-ïðîöåññîðà äëÿ óñòðàíåíèÿ ñàìîâîçáóæäåíèÿ îñóùåñòâëÿåòñÿ äâóìÿ ñïîñîáàìè, êàæäûé èç êîòîðûõ
ðåêîìåíäóåòñÿ èñïîëüçîâàòü â ñîîòâåòñòâóþùèõ ñèòóàöèÿõ.

Ïðèìå÷àíèå: DFR-ïðîöåññîð ïîìîãàåò ñíèçèòü íî íå óñòðàíèòü îêîí÷àòåëüíî ýôôåêò ñàìîâîçáóæäåíèÿ. Ïðèìåíåíèå óçêîïî-
ëîñíûõ ôèëüòðîâ ïîçâîëÿåò óâåëè÷èòü óñèëåíèå íà 6 — 9 äÁ äî ñàìîâîçáóæäåíèÿ. Äëÿ ëó÷øèõ ðåçóëüòàòîâ íåîáõîäèìî èçìåíèòü
àêóñòè÷åñêèå óñëîâèÿ èëè êîíôèãóðàöèþ êîëîíîê.

Ñïîñîá 1

Óñòàíàâëèâàåòñÿ ïîâûøåííîå óñèëåíèå âõîäíîãî êàíàëà, ïðåâûøàþùåå íîðìàëüíûé óðîâåíü è ïîçâîëÿþùåå ñîçäàòü ýôôåêò ñà-
ìîâîçáóæäåíèÿ. Â ýòîì ñëó÷àå DFR-ïðîöåññîð àâòîìàòè÷åñêè óñòàíàâëèâàåò íåîáõîäèìûå ïàðàìåòðû ôèëüòðîâ. Ïîñëå óñòàíîâ-
êè ñîîòâåòñòâóþùåãî óñèëåíèÿ ñèñòåìà ðàáîòàåò óñòîé÷èâî è ãîäíà ê ýêñïëóàòàöèè.

Ïîñëåäîâàòåëüíîñòü óñòàíîâêè:

1. Óäàëèòå âñå àêòèâíûå ôèëüòðû íàæàòèåì ïåðåêëþ÷àòåëÿ Clear îêíà ïàðàìåòðîâ.

2. Âêëþ÷èòå âñå ìèêðîôîíû.

3. Ïðè îòêðûòîì îêíå ïàðàìåòðîâ DFR-ïðîöåññîðà ìåäëåííî ïîâûøàéòå óñèëåíèå ñèñòåìû. Ïðè îáíàðóæåíèè ñàìîâîçáóæäåíèÿ
DFR-ïðîöåññîð àâòîìàòè÷åñêè óñòàíîâèò íåîáõîäèìûå ôèëüòðû, êîòîðûå áóäóò îáîçíà÷åíû â îêíå ïàðàìåòðîâ â âèäå æåëòûõ
èíäèêàòîðîâ.

4. Ïðîäîëæàéòå ïîâûøàòü óñèëåíèå äî òåõ ïîð, ïîêà îíî íå ïðåâûñèò îáû÷íûé óðîâåíü íà 3 — 6 äÁ èëè íå áóäóò óñòàíîâëåíû 
4 — 8 ôèëüòðîâ. Ïîñëå ýòîãî óñòàíîâèòå îáû÷íûé óðîâåíü óñèëåíèÿ äëÿ ñòàáèëüíîé ðàáîòû ñèñòåìû.

5. Îïðåäåëèòå óñòàíîâëåííûå ôèëüòðû êàê ôèêñèðîâàííûå. Îñòàâøèåñÿ äèíàìè÷åñêèå ôèëüòðû áóäóò ââåäåíû â ðàáîòó ïî ìåðå
íåîáõîäèìîñòè â ïðîöåññå ýêñïëóàòàöèè.

Ïðèìå÷àíèå: Ôèêñèðîâàííûå ôèëüòðû ìîãóò áûòü ñêîïèðîâàíû è ïåðåíåñåíû â PEQ-áëîê äëÿ îáåñïå÷åíèÿ áîëüøåãî êîëè÷åñò-
âà äèíàìè÷åñêèõ ôèëüòðîâ â îêíå DFR-ïðîöåññîðà.

Ñïîñîá 2

Äëÿ ïðåäóïðåæäåíèÿ íåïðåäâèäåííîãî ñàìîâîçáóæäåíèÿ óñòàíîâèòå DFR-ïðîöåññîð â òðàêò êàíàëà áåç äîïîëíèòåëüíûõ óñòàíî-
âîê. Ýòîò ìåòîä ïðèìåíÿåòñÿ â óñòîé÷èâûõ ñèñòåìàõ è îáåñïå÷èâàåò çàùèòó îò ñëó÷àéíîãî âîçíèêíîâåíèÿ ñàìîâîçáóæäåíèÿ ïðè
èñïîëüçîâàíèè ïåðåìåùàåìûõ ìèêðîôîíîâ è íàëè÷èè âíåøíèõ ïîëüçîâàòåëüñêèõ ðåãóëÿòîðîâ óñèëåíèÿ è ÷óâñòâèòåëüíîñòè.

Режим Hold
Ðåæèì Hold ïîçâîëÿåò íàçíà÷àòü ïî óìîë÷àíèþ óñòàíîâêè òåêóùåãî äèíàìè÷åñêîãî ôèëüòðà. Â äàííîì ðåæèìå â ïðîöåññå ðàáîòû
ñèñòåìû DFR-ïðîöåññîð áóäåò îòìåíÿòü äèíàìè÷åñêèå è ôèêñèðîâàííûå ôèëüòðû ñîîòâåòñòâåííî èçìåíåíèÿì ïàðàìåòðîâ ñàìî-
âîçáóæäåíèÿ. Ïðè ïîñëåäóþùåì âêëþ÷åíèè ñèñòåìû óñòàíîâêè íàçíà÷åííûå â ðåæèìå Hold áóäóò âîññòàíîâëåíû.

Äëÿ ñîõðàíåíèÿ óñòàíîâîê ôèëüòðà â ðåæèìå Hold:

1. Íàñòðîéòå DFR-ïðîöåññîð èñêóññòâåííî ñîçäàâ ýôôåêò ñàìîâîçáóæäåíèÿ.

2. Âûáåðèòå êîìàíäó Options>Hold Mode â ìåíþ.

Размещение фильтров
Ïðåäóñìîòðåíî äâà ñïîñîáà ðàçìåùåíèÿ ôèëüòðîâ ñ ïîìîùüþ DFR-ïðîöåññîðà.

Ôèêñèðîâàííûé

×àñòîòà ôèêñèðîâàííîãî ôèëüòðà âûáèðàåòñÿ ïîëüçîâàòåëåì ñàìîñòîÿòåëüíî ïîñëå òîãî, êàê DFR-ïðîöåññîð àâòîìàòè÷åñêè óñ-
òàíîâèò äèíàìè÷åñêèé ôèëüòð. Ïàðàìåòðû ôèêñèðîâàííûõ ôèëüòðîâ îñòàþòñÿ íåèçìåííûìè íåçàâèñèìî îò âîçíèêíîâåíèÿ ñàìî-
âîçáóæäåíèÿ íà íîâûõ ÷àñòîòàõ.

Äèíàìè÷åñêèé

Â äàííîì ôèëüòðå ÷àñòîòà è ãëóáèíà îñëàáëåíèÿ ñèãíàëà óñòàíàâëèâàåòñÿ àâòîìàòè÷åñêè. Ãëóáèíà îñëàáëåíèÿ ñèãíàëà èçìåíÿåò-
ñÿ ñîîòâåòñòâåííî àìïëèòóäå ñàìîâîçáóæäåíèÿ, à ïðè îáíàðóæåíèè ñàìîâîçáóæäåíèÿ íà íîâîé ÷àñòîòå DFR-ïðîöåññîð ïåðåíà-
çíà÷àåò íîâûé äèíàìè÷åñêèé ôèëüòð èç íàèáîëåå ðàíåå íàçíà÷åííûõ.

DFR-ïðîöåññîð ïðåäóñìàòðèâàåò îïðåäåëåíèå ìàêñèìàëüíîãî ÷èñëà ôèêñèðîâàííûõ óçêîïîëîñíûõ è ïåðåíàçíà÷àåìûõ äèíàìè-
÷åñêèõ ôèëüòðîâ. Ðåêîìåíäóåòñÿ óñòàíàâëèâàòü íàèáîëüøåå êîëè÷åñòâî ôèêñèðîâàííûõ ôèëüòðîâ âî âõîäíûõ êàíàëàõ ñ ïîäêëþ-
÷åíèåì ñòàöèîíàðíûõ ìèêðîôîíîâ. Â ñâîþ î÷åðåäü, íàèáîëüøåå êîëè÷åñòâî äèíàìè÷åñêèõ ôèëüòðîâ ðåêîìåíäóåòñÿ óñòàíàâëè-
âàòü âî âõîäíûå êàíàëû ïðè èñïîëüçîâàíèè áåñïðîâîäíûõ è ïðîâîäíûõ ðó÷íûõ ìèêðîôîíîâ. 

Íàçíà÷åíèå íåîáõîäèìîãî êîëè÷åñòâà ôèëüòðîâ ñ èñïîëüçîâàíèåì äèàëîãîâîãî îêíà
Fixed/Dynamic Filter Options:

1. Âûáåðèòå êîìàíäó Options>Fixed filters allocation èç ìåíþ DFR-ïðîöåññîðà, ïîñëå ÷åãî îò-
êðîåòñÿ äèàëîãîâîå îêíî Fixed/Dynamic Filter Options (ñìîòðè ðèñóíîê ñïðàâà).

2. Óñòàíîâèòå êîëè÷åñòâî ôèêñèðîâàííûõ ôèëüòðîâ, êîòîðûå ïðåäïîëàãàåòñÿ óñòàíîâèòü. Â
ñîîòâåòñòâèè ñ ýòèì áóäåò îïðåäåëåíî êîëè÷åñòâî äèíàìè÷åñêèõ ôèëüòðîâ.

4. Íàæìèòå OK.

Ñìåíà ìåñòîïîëîæåíèÿ ôèëüòðà ñ ïîìîùüþ ìûøè:

1. Óñòàíîâèòå êóðñîð ìåæäó êðàñíûìè ñêîáêàìè êàê ïîêàçàíî íà ðèñóíêå
ñïðàâà.

2. Ìåòîäîì ïåðåòàñêèâàíèÿ ìûøüþ âëåâî èëè âïðàâî óñòàíîâèòå íóæíîå
÷èñëî ôèêñèðîâàííûõ è äèíàìè÷åñêèõ ôèëüòðîâ.
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Óñòàíîâèòå êóðñîð
çäåñü...

...èëè çäåñü



Фильтры High Q и Low Q
Â DFR-ïðîöåññîðå ïðåäóñìîòðåíî äâà âàðèàíòà óçêîïîëîñíûõ ôèëüòðîâ, êàê ïîêàçàíî íà ðè-
ñóíêå ñïðàâà. Ôèëüòðû High Q filters îáåñïå÷èâàþò îñëàáëåíèå óçêîé ÷àñòîòíîé ïîëîñû è âû-
ñîêîå êà÷åñòâî çâóêà.

Ôèëüòðû Low Q îõâàòûâàþò áîëåå øèðîêèé äèàïàçîí ÷àñòîò, ðàñøèðÿåìûé ñ óâåëè÷åíèåì àò-
òåíþàöèè ñèãíàëà â âûáðàííîé òî÷êå. Äàííûé ôèëüòð îáåñïå÷èâàåò áîëüøóþ ñòàáèëüíîñòü
ñèñòåìû çà ñ÷åò íåêîòîðîãî ñíèæåíèÿ êà÷åñòâà çâóêà, ïîýòîìó ðåêîìåíäóåòñÿ òîëüêî äëÿ îç-
âó÷èâàíèÿ ðå÷è.

Äëÿ èçìåíåíèÿ óñòàíîâîê òåêóùåãî ôèëüòðà:

• Âûáåðèòå ôèëüòð ùåë÷êîì ìûøè è èñïîëüçóéòå ðàñêðûâàþùååñÿ âíèç ìåíþ Type.

• Èñïîëüçóéòå ìåíþ Options äëÿ âûáîðà òèïà ôèëüòðà äëÿ âñåõ íîâûõ äèíàìè÷åñêèõ ôèëüòðîâ ïî ìåðå èõ íàçíà÷åíèÿ.

Добавление, модификация и удаление фильтров
Äëÿ ðó÷íîé óñòàíîâêè èëè ìîäèôèêàöèè ôèêñèðîâàííîãî óçêîïîëîñíîãî ôèëüòðà:

1. Âûáåðèòå àêòèâíûé ôèêñèðîâàííûé ôèëüòð (îêðàøåí â æåëòûé öâåò) èëè äëÿ àêòèâàöèè íîâîãî ôèëüòðà âûáåðèòå êðàéíèé
ñïðàâà îò àêòèâíîãî ôèëüòð.

2. Óñòàíîâèòå ÷àñòîòó, ãëóáèíó è òèï, åñëè ýòî íåîáõîäèìî.

Äëÿ óäàëåíèÿ âñåõ àêòèâíûõ óçêîïîëîñíûõ ôèëüòðîâ:

1. Íàæàòèåì êíîïêè Clear îòêðîéòå äèàëîãîâîå îêíî, êàê ïîêàçàíî íà ðèñóíêå.

2. Âûáåðèòå Clear All Filters è íàæìèòå OK.

Èëè

1. Âûáåðèòå êîìàíäó Edit>Select All â ìåíþ.

2. Íàæìèòå êëàâèøó DELETE êëàâèàòóðû.

Äëÿ óäàëåíèÿ âûáðàííûõ óçêîïîëîñíûõ ôèëüòðîâ:

1. Íàæìèòå íà èìèäæ ôèëüòðà (äëÿ âûáîðà íåñêîëüêèõ ôèëüòðîâ ñäåëàéòå ýòî ÷åðåç íàæàòèå êíîïêè Ctrl).

2. Íàæìèòå êëàâèøó DELETE êëàâèàòóðû

Èëè

Íàæàòèåì êíîïêè Clear îòêðîéòå äèàëîãîâîå îêíî Clear Options è âûáåðèòå îïöèþ Clear One Filter.

Копирование и вставка
Äëÿ êîïèðîâàíèÿ è âñòàâêè ôèëüòðîâ:

1. Âûáåðèòå íåîáõîäèìûé ôèëüòð èëè íåñêîëüêî ôèëüòðîâ (÷åðåç íàæàòèå êëàâèøè Ctrl êëàâèàòóðû èëè âûáîðîì êîìàíäû
Edit>Select All â ìåíþ).

2. Âûáåðèòå êîìàíäó Edit>Copy â ìåíþ.

3. îòêðîéòå îêíî DFR-ïðîöåññîðà â êîòîðûé òðåáóåòñÿ âñòàâèòü ñêîïèðîâàííûå óñòàíîâêè.

4. Âûáåðèòå êîìàíäó Edit>Paste â ìåíþ.

Ïðèìå÷àíèå: Ïðîãðàììíîå îáåñïå÷åíèå ïðåäîñòàâëÿåò âîçìîæíîñòü êîïèðîâàíèÿ óñòàíîâîê àêòèâíûõ ôèëüòðîâ DFR-ïðîöåññî-
ðà è èõ âñòàâêó â ïàðàìåòðè÷åñêèé ýêâàëàéçåð (PEQ èëè PEQ +CS). Ïåðåìåùåíèåì ôèêñèðîâàííûõ ôèëüòðîâ â ïàðàìåòðè÷åñêèé
ýêâàëàéçåð îáåñïå÷èâàåòñÿ áîëüøåå êîëè÷åñòâî íàçíà÷àåìûõ äèíàìè÷åñêèõ ôèëüòðîâ â DFR-ïðîöåññîðå.

Ïðèìå÷àíèå: Óñòàíîâêè ñêîïèðîâàííûõ â PEQ ôèëüòðîâ ìîãóò íåñêîëüêî îòëè÷àòüñÿ îò èñõîäíûõ.

Гейт/Ослабляющий Экспандер 

Применение
Äàííûå ïðèáîðû ïðåäíàçíà÷åíû äëÿ ñíèæåíèÿ íåæåëàòåëüíûõ ïî-
ñòîðîííèõ øóìîâ. Ïðè äîñòèæåíèè óðîâíÿ âõîäíîãî ñèãíàëà íèæå
ïîðîãîâîãî çíà÷åíèÿ ãåéò îñóùåñòâëÿåò ìüþòèðîâàíèå âûõîäíîãî
êàíàëà. Â ñâîþ î÷åðåäü îñëàáëÿþùèé ýêñïàíäåð îáåñ-
ïå÷èâàåò â ýòîé ñèòóàöèè ïîñòåïåííîå ñíèæåíèå óðîâ-
íÿ âûõîäíîãî ñèãíàëà.

Ðåêîìåíäóåòñÿ ïðèìåíÿòü ãåéò ïðè íåîáõî-
äèìîñòè óäàëåíèÿ íèçêîóðîâíåâûõ øóìîâ.
Îñëàáëÿþùèé ýêñïàíäåð ïðèìåíÿåòñÿ â òåõ
ñëó÷àÿõ, êîãäà ðåç-
êîå ìüþòèðîâàíèå
âûõîäíîãî ñèãíàëà
ìîæåò íåãàòèâíî ñêàçàòüñÿ íà îáùåé
ìóçûêàëüíîé ïðîãðàììå.

ООккнноо  ппааррааммееттрроовв

Ãðàôîïîñòðîèòåëüíàÿ ïàíåëü. Â äàííîé
ãðàôè÷åñêîé ïàíåëè îòîáðàæåíû ïîðîãîâàÿ
âåëè÷èíà è êîýôôèöèåíò êîìïðåññèè â âèäå
ãðàôè÷åñêèõ ýëåìåíòîâ, ïåðåìåùàåìûõ ñ
ïîìîùüþ ìûøè. 

Èçìåðèòåëü. Ïðè ðàáîòå â ðåæèìå Live
Mode äàííûé èçìåðèòåëü îòîáðàæàåò âõîä-
íîé è îòíîñèòåëüíûé âûõîäíîé óðîâíè ñèã-
íàëîâ, ÷òî ïîçâîëÿåò îöåíèòü âîçäåéñòâèå
äàííîãî ïðîöåññîðà íà ïðîãðàììíûé ìà-
òåðèàë. Èçìåðèòåëü ìîæåò áûòü îòêëþ÷åí
è âêëþ÷åí âûáîðîì îïöèè
Options>Transfer Curve Meter â ìåíþ. Óñòàíîâêà ïî óìîë÷àíèþ: èçìåðèòåëü âêëþ÷åí.
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Ïðåäóñìîòðåíû ñëåäóþùèå òèïû ïðîöåññîðîâ:

Ãðàôîïîñòðîèòåëüíàÿ
ïàíåëü

Ñëàéäåð ïîðîãà

Ñëàéäåð óñèëåíèÿ Èçìåðèòåëü

Èçìåðèòåëü óñèëåíèÿ

Ðåãóëÿòîðû
óñèëåíèÿ



Ñëàéäåð ïîðîãà. Ïîçèöèÿ äàííîãî ñëàéäåðà îòâå÷àåò ñîîòâåòñòâóþùåé óñòàíîâêå ïàíåëè ïîðîãà è ìîæåò ïåðåìåùàòüñÿ ñ ïîìî-
ùüþ ìûøè âëåâî è âïðàâî â âåðõíåé ÷àñòè ãðàôèêà äëÿ èçìåíåíèÿ ïîðîãîâîãî çíà÷åíèÿ.

Ñëàéäåð êîýôôèöèåíòà îñëàáëåíèÿ ñèãíàëà. Ïîçèöèÿ ýòîãî ñëàéäåðà îòâå÷àåò ñîîòâåòñòâóþùåé óñòàíîâêå ïàíåëè êîýôôè-
öèåíòà îñëàáëåíèÿ ñèãíàëà è ìîæåò ïåðåìåùàòüñÿ âëåâî è âïðàâî â íèæíåé ÷àñòè ãðàôèêà äëÿ èçìåíåíèÿ êîýôôèöèåíòà êîì-
ïðåññèè. 

Èçìåðèòåëü èçìåíåíèÿ êîýôôèöèåíòà óñèëåíèÿ. Äàííûé èçìåðèòåëü îòîáðàæàåò èçìåíåíèÿ êîýôôèöèåíòà óñèëåíèÿ îáåñ-
ïå÷èâàåìîãî òåêóùèìè óñòàíîâêàìè ïðîöåññîðà. Èçìåðèòåëü ìîæåò áûòü âêëþ÷åí èëè îòêëþ÷åí âûáîðîì îïöèè Options>Gain â
ìåíþ. Óñòàíîâêà ïî óìîë÷àíèþ: èçìåðèòåëü âêëþ÷åí.

Ðåãóëÿòîðû óñèëåíèÿ. Äàííûå ðåãóëÿòîðû ïðèìåíÿþòñÿ äëÿ óñòàíîâêè âõîäíîãî è âûõîäíîãî óñèëåíèÿ â äèàïàçîíå îò –12 äÁ äî
+12 äÁ ñ øàãîì 0.5 äÁ. Óñòàíîâêà ïî óìîë÷àíèþ: 0 äÁ.

Èíäèêàòîð Threshold Exceeded. Äàííûé èíäèêàòîð çàãîðàåòñÿ æåëòûì öâåòîì
åñëè óðîâåíü âõîäíîãî ñèãíàëà ïðåâûøàåò óñòàíîâëåííîå ïîðîãîâîå çíà÷åíèå.

Ïàíåëü Threshold. Â äàííîé ïàíåëè óñòàíàâëèâàåòñÿ ïîðîãîâîå çíà÷åíèå âõîäíîãî ñèãíàëà â äèàïàçîíå îò -80 VU äî
0 VU ñ øàãîì 0.5 VU. Ðåãóëèðîâêà îñóùåñòâëÿåòñÿ êíîïêàìè óâåëè÷åíèÿ è ïîíèæåíèÿ çíà÷åíèÿ, ñ ïîìîùüþ êëàâèàòó-
ðû èëè ïåðåìåùåíèåì ñëàéäåðà ïîðîãà. Óñòàíîâêà ïî óìîë÷àíèþ: –65 VU (ãåéò) è –40 VU (îñëàáëÿþùèé ýêñïàíäåð). 

Ïàíåëü Ratio. Â äàííîé ïàíåëè óñòàíàâëèâàåòñÿ êîýôôèöèåíò îñëàáëåíèÿ âûõîäíîãî ñèãíàëà ïî îòíîøåíèþ ê
óðîâíþ âõîäíîãî ñèãíàëà â äèàïàçîíå îò 1:1 äî ∞ :1, ñ øàãîì 0.1. Íàïðèìåð ñîîòíîøåíèå 4:1 îçíà÷àåò, ÷òî ïîíè-
æåíèå óðîâíÿ âõîäíîãî ñèãíàëà ïðîãðàììû íà 1 äÁ âëå÷åò çà ñîáîé îñëàáëåíèå âûõîäíîãî ñèãíàëà ïðîöåññîðà
íà 4 äÁ. Ðåãóëèðîâêà îñóùåñòâëÿåòñÿ êíîïêàìè óâåëè÷åíèÿ è ïîíèæåíèÿ çíà÷åíèÿ, ñ ïîìîùüþ êëàâèàòóðû èëè

ïåðåìåùåíèåì ñëàéäåðà íà ãðàôè÷åñêîé ïàíåëè. Óñòàíîâêà ïî óìîë÷àíèþ: ∞ :1 (ãåéò) è 4:1 (îñëàáëÿþùèé ýêñïàíäåð).

Ïàíåëü Attack. Â äàííîé ïàíåëè óñòàíàâëèâàåòñÿ âðåìÿ àòàêè â äèàïàçîíå îò 1 ìñåê äî 200 ìñåê. Óñòàíîâêà ïî
óìîë÷àíèþ: 2 ìñåê (ãåéò) è 20 ìñåê (îñëàáëÿþùèé ýêñïàíäåð). 

Ïàíåëü Decay. Â äàííîé ïàíåëè óñòàíàâëèâàåòñÿ âðåìÿ çàòóõàíèÿ, èçìåíÿåìîå â äèàïàçîíå îò 50 ìñåê 
äî 1000 ìñåê. Óñòàíîâêà ïî óìîë÷àíèþ: 100 ìñåê (ãåéò) è 50 ìñåê (îñëàáëÿþùèé ýêñïàíäåð). 

Ïàíåëü Hold. Â äàííîé ïàíåëè óñòàíàâëèâàåòñÿ âðåìÿ óäåðæèâàíèÿ â ïðåäåëàõ îò 0 ìñåê äî 500 ìñåê. Óñòàíîâêà
ïî óìîë÷àíèþ: 0 ìñåê.

Ïåðåêëþ÷àòåëü Default. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ îñóùåñòâëÿåòñÿ âîçâðàò ê óñòàíîâêàì ïî óìîë÷àíèþ.

Ïåðåêëþ÷àòåëü Bypass. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ îñóùåñòâëÿåòñÿ âêëþ÷åíèå ïðîöåññîð-
íîãî ìîäóëÿ â ðåæèì bypass (ãîðèò êðàñíûé èíäèêàòîð). Óñòàíîâêà ïî óìîë÷àíèþ: ðå-
æèì îòêëþ÷åí.

Snapshot. Äàííàÿ ôóíêöèÿ ïîçâîëÿåò ñîçäàòü ìîìåíòàëüíûé ñíèìîê êðèâîé ÷àñòîòíîé õàðàêòåðèñòèêè ñèãíàëà (íà-
æàòèå êíîïêè Take) è ïîêàçàòü åå íà ýêðàíå (íàæàòèå êíîïêè Show) äëÿ äàëüíåéøåãî ñðàâíåíèÿ. Ïðè îòîáðàæåíèè
êàäðà ãîðèò çåëåíûé èíäèêàòîð êíîïêè.

Графический эквалайзер
Применение
Îáùàÿ øèðèíà ïîëîñ ïðîöåññîðà èëè îòäåëüíûõ ôèëüòðîâ çàâè-
ñèò îò òèïà âûáðàííîãî ýêâàëàéçåðà. GEQ10 èìååò äåñÿòü îäíî-
îêòàâíûõ ôèëüòðîâ â äèàïàçîíå 31.5 Ãö — 16 êÃö, â òî âðåìÿ êàê
GEQ30 èìååò òðèäöàòü 1/3-îêòàâíûõ ôèëüòðîâ â äèàïàçîíå 
25 Ãö —  20 êÃö.

Окно параметров
Ïîëîñíûå ôåéäåðû. Ïåðåìåùåíèå ôåéäåðîâ ìîæåò îñóùå-
ñòâëÿòüñÿ êàê ìûøüþ, òàê è ñ ïîìîùüþ êëàâèàòóðû. Îáåñïå÷è-
âàåòñÿ îñëàáëåíèå èëè óñèëåíèå ïîëîñ â ïðåäåëàõ îò –18 äÁ
äî +12 äÁ, ñ øàãîì 0.5 äÁ. 

Ïàíåëü ÷àñòîòíîé õàðàêòåðèñòèêè.
Çäåñü îòîáðàæàåòñÿ ÷àñòîòíàÿ õàðàêòåðè-
ñòèêà ñîîòâåòñòâóþùàÿ óñòàíîâêå ïîëîñ-
íûõ ôåéäåðîâ, à òàêæå òèï âûáðàííîãî ôèëüòðà.

Ïðèìå÷àíèå: Äàííàÿ êðèâàÿ íå îòîáðàæàåò îáùåé ÷àñòîòíîé
õàðàêòåðèñòèêè âñåãî çâóêîâîãî òðàêòà.

Ïàíåëü Freq. Â äàííîé ïàíåëè îòîáðà-
æàåòñÿ ÷àñòîòíàÿ ïîëîñà ðåãóëèðóåìîãî
ôåéäåðà. Çäåñü ìîæíî âûáðàòü ðàçëè÷-

íûå ÷àñòîòíûå ïîëîñû íàæàòèåì íà êíîïêè óâåëè÷åíèÿ èëè ïî-
íèæåíèÿ çíà÷åíèé. Óñòàíîâêà ïî óìîë÷àíèþ: íèæíÿÿ ïîëîñà

÷àñòîò.

Ïàíåëü Gain. Â äàííîé ïàíåëè îòîáðà-
æàåòñÿ êîýôôèöèåíò óñèëåíèÿ âûáðàí-

íîé ïîëîñû ÷àñòîò. Ðåãóëèðîâêà îñóùåñòâëÿåòñÿ â äèàïàçîíå îò –18 äÁ äî +12 äÁ ñ øàãîì 0.5 äÁ. Óñòàíîâêà ïî óìîë÷àíèþ: 0 äÁ.
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Óðîâåíü ñèãíàëà ïðåâûøàåò ïîðîãîâîå çíà÷åíèå

Óðîâåíü ñèãíàëà íå ïðåâûøàåò ïîðîãîâîå çíà÷åíèå

Bypass âêëþ÷åí

Bypass îòêëþ÷åí

×àñòîòíàÿ
õàðàêòåðèñòèêà

Ïîëîñíûå ôåéäåðû

Ïðåäóñìîòðåíû ñëåäóþùèå òèïû ïðîöåññîðîâ:



Ïàíåëü Type. Â
äàííîé ïàíåëè
îñóùåñòâëÿåòñÿ

âûáîð òèïà ôèëüòðîâ äëÿ âñåõ ïîëîñ. Óñòàíîâ-
êà ïî óìîë÷àíèþ: êîìáèíèðîâàííûé.

Ïåðåêëþ÷àòåëü Bypass. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ îñóùåñòâëÿåòñÿ âêëþ÷åíèå ïðîöåññîð-
íîãî ìîäóëÿ â ðåæèì bypass (ãîðèò êðàñíûé èíäèêàòîð). Óñòàíîâêà ïî óìîë÷àíèþ: ðåæèì îòêëþ÷åí.

Ïåðåêëþ÷àòåëü Flat. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ îñóùåñòâëÿåòñÿ óñòàíîâêà óñèëåíèÿ âñåõ äè-
àïàçîíîâ ÷àñòîò íà 0 äÁ.

Snapshot. Äàííàÿ ôóíêöèÿ ïîçâîëÿåò ñîçäàòü ìîìåíòàëüíûé ñíèìîê êðèâîé ÷àñòîòíîé õàðàêòåðèñòèêè ñèãíàëà (íà-
æàòèå êíîïêè Take) è ïîêàçàòü åå íà ýêðàíå (íàæàòèå êíîïêè Show) äëÿ äàëüíåéøåãî ñðàâíåíèÿ. Ïðè îòîáðàæåíèè
ñíèìêà êàäðà ãîðèò çåëåíûé èíäèêàòîð êíîïêè.

Копирование и вставка
Äëÿ êîïèðîâàíèÿ è âñòàâêè óñòàíîâîê â ãðàôè÷åñêèå ýêâàëàéçåðû îäíîãî òèïà èñïîëüçóéòå Edit â ìåíþ.

Ïðèìå÷àíèå: Íåëüçÿ êîïèðîâàòü óñòàíîâêè èç ýêâàëàéçåðà GEQ10 â GEQ30 è íàîáîðîò.

Параметрический эквалайзер
Применение
Äàííûå ýêâàëàéçåðû îáåñïå÷èâàþò ïðåöèçèîííóþ íàñòðîéêó
áåç âîçäåéñòâèÿ íà ñîñåäíèå ÷àñòîòû. Âûáèðàéòå ýêâàëàéçå-
ðû ñ ìèíèìàëüíûì íåîáõîäèìûì êîëè÷åñòâîì ôèëüòðîâ äëÿ
ñîõðàíåíèÿ ñèñòåìíûõ ðåñóðñîâ.

Окно параметров
Ãðàôîïîñòðîèòåëüíàÿ ïàíåëü. Äàííàÿ ïàíåëü ñëóæèò äëÿ
ðàçìåùåíèÿ è íàñòðîéêè ïàðàìåòðè÷åñêèõ ôèëüòðîâ. Ïèêî-
âûå/óçêîíàïðàâëåííûå ôèëüòðû ïðåäñòàâëåíû ãðàôè÷åñêè â
âèäå ïåðåìåùàåìûõ òî÷åê, à îáðåçíûå/ïîëî÷íûå — â âèäå
êâàäðàòîâ. Íàæàòèåì íà òî÷êó èëè êâàäðàò ôèëüòðà ìîæíî
óâèäåòü åãî ÷àñòîòíóþ õàðàêòåðèñòèêó è ïðîèçâåñòè íåîáõî-
äèìûå íàñòðîéêè.

Ïàíåëü ÷àñòîòíîé õàðàêòåðèñòèêè.
Äàííàÿ ïàíåëü îòîáðàæàåò ÷àñòîòíóþ õà-
ðàêòåðèñòèêó, ñîîòâåòñòâóþùóþ ðàñïîëî-
æåíèþ ôèëüòðîâ íà ãðàôîïîñòðîèòåëüíîé
ïàíåëè.

Ïðèìå÷àíèå: Äàííàÿ êðèâàÿ íå îòîáðà-
æàåò îáùåé ÷àñòîòíîé õàðàêòåðèñòèêè
âñåãî çâóêîâîãî òðàêòà.

Ïèêîâûå/óçêîíàïðàâëåííûå ôèëüòðû.
Âûáðàâ òî÷êó íà-
æàòèåì ìûøè
ìîæíî èçìåíèòü
óñòàíîâêè äàííîãî ïèêîâîãî/óçêîíàïðàâ-
ëåííîãî ôèëüòðà.

Îáðåçíûå/ïîëî÷íûå ôèëüòðû. Êàæäûé
êâàäðàò íà ãðàôîïîñòðîèòåëüíîé ïàíåëè
ìîæåò áûòü âûáðàí êàê îáðåçíîé èëè ïî-
ëî÷íûé ôèëüòð. Ïðè èçíà÷àëüíîì îòêðû-
òèè îêíà äàííûå êâàäðàòû îïðåäåëåíû êàê
ïîëî÷íûå ôèëüòðû ñ
óñèëåíèåì 0 äÁ è ÷àñ-
òîòàìè 20 êÃö è 25 Ãö.

Ïàíåëü Freq. Â äàííîé ïàíåëè îòîáðàæàåòñÿ ÷àñòîòà âûáðàííîé òî÷êè ôèëüòðà. Çíà÷åíèå ìîæåò èçìå-
íÿòüñÿ â äèàïàçîíå 25 Ãö — 20 êÃö. Óñòàíîâêà ïî óìîë÷àíèþ: 1 êÃö (ïðè óñòàíîâêå íîâîé òî÷êè).

Ïàíåëü Width. Ðàáîòà äàííîé ïàíåëè
çàâèñèò îò òèïà íàñòðàèâàåìîãî
ôèëüòðà, â ñîîòâåòñòâèè ñ ïðèâåäåí-
íîé òàáëèöåé.

Ïàíåëü Gain. Â äàííîé ïàíåëè óñòàíàâëèâàåòñÿ êîýôôèöèåíò óñèëåíèÿ âûáðàííîãî ôèëüòðà â äèàïàçîíå
îò -18 äÁ äî +18 äÁ ñ øàãîì 0.5 äÁ. Óñòàíîâêà ïî óìîë÷àíèþ: 0 äÁ. Ïðè ðàáîòå ñ îáðåçíûì ôèëüòðîì
äàííàÿ ïàíåëü îòêëþ÷åíà.

Ïåðåêëþ÷àòåëü New. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ îñóùåñòâëÿåòñÿ äîáàâëåíèå íîâîãî ïèêîâî-
ãî/óçêîíàïðàâëåííîãî ôèëüòðà íà ãðàôîïîñòðîèòåëüíóþ ïàíåëü. Ïðè äîñòèæåíèè ìàêñèìàëüíîãî êîëè-
÷åñòâà óñòàíîâëåííûõ ôèëüòðîâ ïàíåëü îòêëþ÷àåòñÿ (ðèñóíîê ñïðàâà).

Ïåðåêëþ÷àòåëü Clear. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ îòêðûâàåòñÿ äèàëîãîâîå îêíî, â êîòîðîì ìîæíî îòìå-
íèòü âñå èëè íåêîòîðûå óñòàíîâêè.
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Bypass âêëþ÷åí

Bypass îòêëþ÷åí

Ïðåäóñìîòðåíû ñëåäóþùèå òèïû ïðîöåññîðîâ:

Ïðèìå÷àíèå: ×èñëî, óêàçàííîå â ìîäåëè ýêâàëàéçåðà ñîîòâåòñò-
âóåò ìàêñèìàëüíîìó êîëè÷åñòâó ïèêîâûõ/óçêîïîëîñíûõ ôèëüòðîâ.

Ãðàôîïîñòðîèòåëüíàÿ
ïàíåëü

×àñòîòíàÿ
õàðàêòåðèñòèêà

Âûáðàííûé ôèëüòð Òî÷êà ôèëüòðà

Êâàäðàò
ôèëüòðà



Ïåðåêëþ÷àòåëü Bypass. Íàæàòèåì äàííîãî ïåðåêëþ÷àòåëÿ îñóùåñòâëÿåòñÿ âêëþ÷å-
íèå ïðîöåññîðíîãî ìîäóëÿ â ðåæèì bypass (ãîðèò êðàñíûé èíäèêàòîð). Óñòàíîâêà ïî
óìîë÷àíèþ: ðåæèì îòêëþ÷åí.

Snapshot. Äàííàÿ ôóíêöèÿ ïîçâîëÿåò ñîçäàòü ìîìåíòàëüíûé ñíèìîê êðèâîé ÷àñòîòíîé õàðàêòåðèñòèêè ñèãíàëà (íà-
æàòèå êíîïêè Take) è ïîêàçàòü åå íà ýêðàíå (íàæàòèå êíîïêè Show) äëÿ äàëüíåéøåãî ñðàâíåíèÿ. Ïðè îòîáðàæåíèè êà-
äðà ãîðèò çåëåíûé èíäèêàòîð êíîïêè.

Работа с фильтрами
Äëÿ óñòàíîâêè íîâîé òî÷êè ôèëüòðà:

1. Íàæìèòå ïåðåêëþ÷àòåëü New.

2. Íîâàÿ òî÷êà ôèëüòðà ïîÿâèòñÿ íà îòìåòêå 0äÁ è ÷àñòîòå 1 êÃö ñ ïîëîñîé ïðîïóñêàíèÿ 2/3îêòàâû (ïî óìîë÷àíèþ).

Äëÿ óäàëåíèÿ âñåõ òî÷åê ôèëüòðîâ:

1. Íàæìèòå ïåðåêëþ÷àòåëü Clear èëè âûáåðèòå îïöèþ Edit>Clear Filters â ìåíþ îêíà ïàðàìåòðîâ.

2. Ïîñëå òîãî, êàê îòêðîåòñÿ äèàëîãîâîå îêíî Clear Options (ñìîòðè ðèñóíîê ñïðàâà), âûáåðèòå Clear All Filters è íàæìèòå OK.

Äëÿ óäàëåíèÿ êîíêðåòíûõ òî÷åê ôèëüòðîâ:

1. Âûáåðèòå ìûøüþ îäíó èëè íåñêîëüêî òî÷åê.

2. Íàæìèòå êëàâèøó Delete êëàâèàòóðû èëè íàæìèòå ïåðåêëþ÷àòåëü.

Ïðèìå÷àíèå: Êâàäðàòû, èçîáðàæàþùèå îáðåçíûå/ïîëî÷íûå ôèëüòðû íå óäàëÿþòñÿ ñ ãðàôîïî-
ñòðîèòåëüíîé ïàíåëè.

Настройка фильтров в графопостроительной панели
Äëÿ íàñòðîéêè óñèëåíèÿ è ÷àñòîòû:

1. Óñòàíîâèòå êóðñîð íàä òî÷êîé èëè êâàäðàòîì ôèëüòðà.

2. Ìåòîäîì ïåðåòàñêèâàíèÿ óñòàíîâèòå íà íóæíîé ÷àñòîòå ñ òðåáóåìûì óñèëåíèåì.

Ïðèìå÷àíèå: Íà ãðàôîïîñòðîèòåëüíîé ïàíåëè îòîáðàæàåòñÿ ÷àñòîòíàÿ êðèâàÿ âûáðàííîãî ôèëüòðà. Êîìáèíèðîâàííàÿ ÷àñòîò-
íàÿ êðèâàÿ îòîáðàæàåòñÿ íà ãðàôèêå íèæå.

Óñòàíîâêà øèðèíû ïîëîñû ïðîïóñêàíèÿ:

1. Ðàçìåñòèòå êóðñîð íàä îäíîé èç êðàéíèõ òî÷åê ïîëîñû ôèëüòðà íà ãðàôîïîñòðîèòåëüíîé ïàíåëè.

2. Ñ ïîìîùüþ ìûøè óñòàíîâèòå íåîáõîäèìóþ øèðèíó ïðîïóñêàíèÿ ôèëüòðà.

Тонкая настройка параметров
Äëÿ òîíêîé íàñòðîéêè ïàðàìåòðîâ ôèëüòðà ïðåäóñìîòðåíû ñëåäóþùèå ñïîñîáû:

• Ââåäåíèå ÷èñëîâîãî çíà÷åíèÿ â ïàíåëè ïàðàìåòðîâ.

• Èñïîëüçîâàíèå êíîïîê èçìåíåíèÿ çíà÷åíèÿ ïàíåëè ïàðà-
ìåòðîâ.

• Èñïîëüçîâàíèå êëàâèàòóðû â ñîîòâåòñòâèè ñ ïðèâåäåííîé
ñïðàâà òàáëèöåé.

Копирование, вырезание и вставка
Òî÷êè ôèëüòðîâ ìîãóò êîïèðîâàòüñÿ, âûðåçàòüñÿ è âñòàâ-
ëÿòüñÿ â äðóãèå îêíà ïàðàìåòðîâ ïàðàìåòðè÷åñêèõ ýêâàëàé-
çåðîâ ïðè ñîáëþäåíèè ñëåäóþùèõ óñëîâèé:

• Â îêíå, êóäà ïðåäïîëàãàåòñÿ âñòàâèòü ñêîïèðîâàííûå
ôèëüòðû äîëæíî áûòü äîñòàòî÷íîå êîëè÷åñòâî ñâîáîäíûõ
òî÷åê. 

• Óñòàíîâêè îáðåçíûõ/ïîëî÷íûõ ôèëüòðîâ ìîãóò êîïèðîâàòü-
ñÿ è âñòàâëÿòüñÿ òîëüêî â îêíà ïàðàìåòðîâ PEQ+CS-ïðî-
öåññîðîâ.

Äëÿ êîïèðîâàíèÿ è âñòàâêè ôèëüòðîâ:

1. Âûáåðèòå îäèí èëè íåñêîëüêî ôèëüòðîâ.

2. Âûáåðèòå êîìàíäó Edit>Copy â ìåíþ.

3. Îòêðîéòå îêíî ïàðàìåòðîâ ïàðàìåòðè÷åñêîãî ýêâàëàéçåðà äëÿ
âñòàâêè â íåãî ñêîïèðîâàííûõ ôèëüòðîâ.

4. Âûáåðèòå êîìàíäó Edit>Paste â ìåíþ.

Управляющие контакты
Óïðàâëÿþùèå êîíòàêòû, ðàñïîëîæåííûå íà òûëüíîé ñòîðîíå
P4800 ïðåäîñòàâëÿþò âîçìîæíîñòü óïðàâëåíèÿ âíåøíèìè
óñòðîéñòâàìè (íàïðèìåð íàñòåííîé ðåãóëèðîâî÷íîé
ïàíåëüþ). Äàííûé òèï èíòåðôåéñà ïîçâîëÿåò
ïîëüçîâàòåëþ âîçìîæíîñòü ïåðåêëþ÷åíèÿ ïðå-
ñåòîâ, ìüþòèðîâàíèÿ êàíàëîâ èëè ðåãóëèðîâêè
óñèëåíèÿ áåç ïðèâëå÷åíèÿ êîìïüþòåðà. Ëîãè÷åñêèé âû-
õîä ìîæåò áûòü ïîäêëþ÷åí ê èíäèêàòîðàì, ðåëå èëè
äðóãèì óñòðîéñòâàì ïðè íåîáõîäèìîñòè âíåøíå-
ãî êîíòðîëÿ çà ðàáîòîé ïðîöåññîðà P4800.

Внешнее управление
Âíåøíåå óïðàâëåíèå ïðîöåññîðîì ìî-
æåò îñóùåñòâëÿòüñÿ íà òðåõ ðàçëè÷íûõ
óðîâíÿõ, êàê ïîêàçàíî íà ðèñóíêå ñïðàâà. Â äàííîì ïðèìåðå óïðàâëÿþùèå âõîäû ñêîíôèãóðèðîâàíû äëÿ ïåðåêëþ÷åíèÿ òðåõ ïðå-
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ñåòîâ, ðåãóëèðîâêè îáùåé ãðîìêîñòè ïîòåíöèîìåòðîì è ìüþòèðîâàíèÿ âõîäíûõ êàíàëîâ. Ëîãè÷åñêèé âûõîä ñêîíôèãóðèðîâàí äëÿ
óïðàâëåíèÿ âíåøíèì óñòðîéñòâîì äëÿ èíäèêàöèè âêëþ÷åíèÿ ïðåñåòîâ è ìüþòèðîâàíèÿ âõîäíûõ êàíàëîâ.

Äëÿ îðãàíèçàöèè âíåøíåãî óïðàâëåíèÿ:

1. Íåîáõîäèìî îïðåäåëèòü êîëè÷åñòâî òðåáóåìûõ âíåøíèõ ñîåäèíåíèé ñ ðàçúåìàìè óïðàâëåíèÿ. Äëÿ äåòàëüíîé èíôîðìàöèè ïî
ðàñïàéêå óïðàâëÿþùèõ ðàçúåìîâ íåîáõîäèìî îáðàòèòüñÿ ê ñîîòâåòñòâóþùåìó ðàçäåëó è ñõåìàì ðàñïàéêè ðóêîâîäñòâà ïî àï-
ïàðàòíîé ÷àñòè.

2. Êîíôèãóðàöèÿ óïðàâëÿþùèõ êîíòàêòîâ îñóùåñòâëÿåòñÿ ñ ïîìîùüþ îêíà Control Pins (óïðàâëÿþùèõ êîíòàêòîâ) ïðîãðàììíîãî
èíòåðôåéñà. Äàííàÿ êîíôèãóðàöèÿ ñîõðàíÿåòñÿ â ãëîáàëüíûõ óñòàíîâêàõ ïðîöåññîðà P4800 è ìîæåò áûòü òàêæå ñîõðàíåíà â âè-
äå êîìïüþòåðíîãî ôàéëà. 

3. Ïîñëå òîãî, êàê ïðîöåññîð P4800 áûë ñêîíôèãóðèðîâàí äëÿ âíåøíåãî óïðàâëåíèÿ íåîáõîäèìî ñêîíôèãóðèðîâàòü âõîäíûå è âû-
õîäíûå êàíàëû èñïîëüçóÿ ñîîòâåòñòâóþùóþ ñåêöèþ ìàðøðóòèçàöèè îêíà óïðàâëÿþùèõ êàíàëîâ (Control Pins). Êàæäûé ïðåñåò
èëè ôàéë ñöåíû ñîäåðæèò ñîáñòâåííóþ ïðîöåññîðíóþ êàðòó.

Окно управляющих контактов 
Äîñòóï ê îêíó îñóùåñòâëÿåòñÿ âûáîðîì êîìàíäû Devices>Control Pins Configuration â ãëàâíîì ìåíþ.

Виды конфигурации 
Îêíî óïðàâëÿþùèõ êîíòàêòîâ ïðåäñòàâëåíî â äâóõ âèäàõ: óïðàâëÿþùèõ êîíòàêòîâ è ëîãè÷åñêîãî âûõîäà. Âûáîð âèäà îñóùåñòâëÿ-
åòñÿ íàæàòèåì íà Control In èëè Control Out, èëè ñîîòâåòñòâóþùèå êîíòàêòû ðàçúåìîâ. Íà ðèñóíêå ââåðõó ïðåäñòàâëåí âèä îêíà óï-
ðàâëÿþùèõ êîíòàêòîâ (CONTROL IN).

CONTROL IN

Ñ ïîìîùüþ äàííûõ êîíòàêòîâ ñ ïîìîùüþ âíåøíèõ óñòðîéñòâ îñóùåñòâëÿåòñÿ óïðàâëåíèå ôóíêöèÿìè:

1. Ïåðåêëþ÷åíèå ïðåñåòîâ.

2. Ìüþòèðîâàíèå êàíàëîâ.

3. Ðåãóëèðîâêà óñèëåíèÿ.

LOGIC OUT

Ñ ïîìîùüþ äàííûõ êîíòàêòîâ îñóùåñòâëÿåòñÿ êîíôèãóðàöèÿ âûõîäíûõ êîíòàêòîâ äëÿ ñëåäóþùèõ ôóíêöèé:

1. Èíäèêàöèÿ íîìåðà âêëþ÷åííîãî ïðåñåòà.

2. Èíäèêàöèÿ ìüþòèðîâàíèÿ âõîäíûõ èëè âõîäíûõ êàíàëîâ.

Панели установки параметров кодировки 

Ïàíåëü # Presets. Çäåñü íåîáõîäèìî óñòàíîâèòü íîìåð ïðåñåòà, êîòîðûé áóäåò óïðàâëÿòüñÿ âíåøíèì óñòðîéñòâîì.
Íîìåðà èçìåíÿþòñÿ â ïðåäåëàõ îò 0 äî 128. Óñòàíîâêà ïî óìîë÷àíèþ: 0.

Ïàíåëü Encoding Type. Â äàííîé ïàíåëè âûáèðàåòñÿ òèï êîäèðîâêè äëÿ óïðàâëåíèÿ ïðåñåòàìè. Äîñòóïíûå
çíà÷åíèÿ âàðüèðóþòñÿ â çàâèñèìîñòè îò êîëè÷åñòâà óïðàâëÿåìûõ ïðåñåòîâ, âûáðàííûõ â ïàíåëè #Presets.

Ïåðåêëþ÷àòåëü More Info. Íàæàòèåì äàííîé êíîïêè îñóùåñòâëÿåòñÿ âûçîâ äîïîëíèòåëüíîé âñïîìîãàòåëüíîé èí-
ôîðìàöèè. 

Секция конфигурации контактов
Äàííàÿ ñåêöèÿ èñïîëüçóåòñÿ äëÿ ïðàâèëüíîé êîíôèãóðàöèè ñèñòåìíîãî ïðîöåññîðà è ðàñïîçíàâàíèÿ âñåõ óïðàâëÿþùèõ ñîåäèíå-
íèé ñ âíåøíèìè óñòðîéñòâàìè.

Ïðèìå÷àíèå: Ïðè ðàáîòå â ðåæèìå Live íåâîçìîæíî îñóùåñòâèòü êàêèå áû íè áûëî èçìåíåíèÿ êîíôèãóðàöèè êîíòàêòîâ óïðàâëÿ-
þùèõ ñîåäèíåíèé. Äëÿ ñîçäàíèÿ íîâîé êîíôèãóðàöèè èëè èçìåíåíèÿ ñòàðîé íåîáõîäèìî ïåðåéòè â ðåæèì Design Mode. Äàííûå
èçìåíåíèÿ áóäóò ñîõðàíåíû íà óðîâíå ñèñòåìíîãî ïðîöåññîðà. Ïðè îòêëþ÷åííîì ïðîöåññîðå P4800 äàííûå óñòàíîâêè ìîæíî ñî-
õðàíèòü â âèäå êîìïüþòåðíîãî ôàéëà èëè çààðõèâèðîâàòü.
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Ìåíþ áëîêà ñîåäèíåíèé



Áëîê óïðàâëåíèÿ ïðåñåòàìè. Äàííûé áëîê ïîÿâëÿåòñÿ ïðè ââåäåíèè ïàðàìåòðîâ â ïàíåëè #Presets and Encoding Type. Ñîåäèíå-
íèÿ áëîêà ìîãóò áûòü âêëþ÷åíû è îòêëþ÷åíû íàæàòèåì ëåâîé êíîïêè ìûøè ïðè óñòàíîâëåííîì íà áëîê êóðñîðå èëè âûáîðîì êî-
ìàíäû Disable èç ðàçâîðà÷èâàþùåãîñÿ âíèç ìåíþ ñ ïðàâîé ñòîðîíû áëîêà. 

Ïðèìå÷àíèå: Ïîñëå êîíôèãóðàöèè ïðèáîðà äëÿ óïðàâëåíèÿ âíåøíèìè óñòðîéñòâàìè íåâîçìîæíî èçìåíèòü ïðåñåòû ñ êîìïüþòåð-
íîãî èíòåðôåéñà äî òåõ ïîð, ïîêà íå áóäåò îòìåíåí ðåæèì óïðàâëåíèÿ ïðåñåòàìè â îêíå Control Pins.

Áëîêè ñîåäèíåíèé. Êîëè÷åñòâî ïîÿâëÿþ-
ùèõñÿ â îêíå áëîêîâ çàâèñèò îò êîëè÷åñòâà
ñâîáîäíûõ êîíòàêòîâ. Íàçíà÷åíèå êîíòðîë-
ëåðîâ èëè ëîãè÷åñêîãî âûõîäà îñóùåñòâ-
ëÿåòñÿ âûáîðîì èç ðàçâîðà÷èâàþùåãîñÿ
ìåíþ ñ ïðàâîé ñòîðîíû áëîêà. 

Êîíòàêòíûå ñîåäèíåíèÿ ìîãóò áûòü âêëþ-
÷åíû è îòêëþ÷åíû íàæàòèåì ëåâîé êíîïêè
ìûøè íà áëîê èëè âûáîðîì êîìàíäû
Disable â ðàçâîðà÷èâàþùåìñÿ âíèç ìåíþ.

Секция процессорной маршруM
тизации

Processor Mapping. Íàæàòèåì íà ïóíêò îñóùåñòâëÿåòñÿ íàçíà-
÷åíèå ñîîòâåòñòâóþùåãî âõîäà èëè âûõîäà íà ðàçìåùåííûé
áëîê. Ïðè âûáîðå êâàäðàòíûé áëîê ïóíêòà çàïîëíÿåòñÿ ñèíèì

öâåòîì. Âîçìîæíî íàçíà÷åíèå íåñêîëüêèõ ïðîöåññîðîâ íà óïðàâëÿþùèå âõîäû è òîëüêî îäíîãî ïðîöåññîðà íà ëî-
ãè÷åñêèé âûõîä.

Êîëîíêà Mutes. Ìüþòèðîâàíèå êàíàëîâ ìîæåò óïðàâëÿòüñÿ ñ ïîìîùüþ ïåðåêëþ÷àòåëÿ è ìîæåò áûòü îòðàæåíî íà
èíäèêàòîðàõ, ïîäêëþ÷åííûõ ê ëîãè÷åñêîìó âûõîäó (ðèñóíîê ñïðàâà).

Êîëîíêà Gains (Òîëüêî äëÿ óïðàâëÿþùèõ âõîäíûõ êîíòàêòîâ). Óñèëåíèå ìîæåò óïðàâëÿòüñÿ
âíåøíèì óñòðîéñòâîì (ïîòåíöèîìåòðîì 20 êÎì). Ïðè ïîäêëþ÷åíèè áëîêà äëÿ óïðàâëåíèÿ ïîòåíöèî-
ìåòðîì ñîîòâåòñòâóþùèé åìó êâàäðàò îêðàøèâàåòñÿ ñèíèì öâåòîì. Ðåãóëèðîâêà îñóùåñòâëÿåòñÿ â
äèàïàçîíå îò –30 äÁ äî +30 äÁ. Óñòàíîâêà ïî óìîë÷àíèþ: äèàïàçîí îò –30 äÁ äî 0 äÁ.

Äëÿ óñòàíîâêè äèàïàçîíà ðåãóëèðîâêè óñèëåíèÿ ïîòåíöèîìåòðîì:

Конфигурация контактов
Ñåêöèÿ êîíôèãóðàöèè êîíòàêòîâ ÿâëÿåòñÿ ïðîãðàììíîé ìîäåëüþ ñîåäèíåíèé ñ âíåøíèìè óñòðîéñòâàìè, êîòîðàÿ ìîæåò áûòü ñî-
õðàíåíà â ïàìÿòè ïðîöåññîðà P4800 èëè â êîìïüþòåðå (ñ äàëüíåéøåé çàãðóçêîé â P4800).

Ïðèìå÷àíèå: Èçìåíåíèÿ êîíôèãóðàöèè îñóùåñòâëÿþòñÿ â ðåæèìå Design Mode.

Ñîçäàíèå íîâûõ êîíôèãóðàöèé êîíòàêòîâ

1. Âêëþ÷èòå ðåæèì Design Mode.

2. Âûáåðèòå îïöèþ Devices>Control Pin Configuration â ãëàâíîì ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ îêíî óïðàâëÿþùèõ êîíòàêòîâ (Control Pins).

3. Âûáåðèòå âèä êîíôèãóðàöèè (Control In èëè Logic Out).

4. Ñêîíôèãóðèðóéòå óïðàâëåíèå ïðåñåòîì.

a) Ââåäèòå íîìåð ïðåñåòà â ïàíåëè # Presets.

b) Âûáåðèòå òèï êîäèðîâêè â ðàçâîðà÷èâàþùåìñÿ ìåíþ Encoding Type, ïîñëå ÷åãî ïîÿâèòñÿ áëîê ïðåñåòà óïðàâëÿþùèõ êîíòàêòîâ
â ñåêöèè êîíôèãóðàöèè êîíòàêòîâ.

c) Ïðè èñïîëüçîâàíèè ïðèîðèòåòíîé êîäèðîâêè äëÿ óïðàâëÿþùèõ êîíòàêòîâ ââåäèòå ñîîòâåòñòâóþùèå íîìåðà ïðåñåòîâ â ñòðîêè,
ðàñïîëîæåííûå ïîä áëîêîì óïðàâëåíèÿ ïðåñåòàìè.

6. Ñêîíôèãóðèðóéòå îñòàâøèåñÿ êîíòàêòû äëÿ âíåøíèõ êîíòðîëëåðîâ èëè ëîãè÷åñêèõ âûõîäîâ îñóùåñòâèâ âûáîð èç ðàçâîðà÷èâà-
þùåãîñÿ ìåíþ êàæäîãî áëîêà ðàñïîëîæåíèÿ êîíòàêòîâ.

7. Âûáåðèòå îïöèþ Configuration>Store to Device â ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ äèàëîãîâîå îêíî âûáîðà ïðèáîðîâ (Select Devices).

8. Âûáåðèòå ïðèáîð è íàæìèòå OK.

Ñîõðàíåíèå êîíôèãóðàöèè â êîìïüþòåðå

1. Ñëåäóéòå øàãàì 1 — 6, îïèñàííûì âûøå.

2. Âûáåðèòå îïöèþ Configuration>Save To PC â ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ äèàëîãîâîå îêíî Save Config As.

4. Âûáåðèòå äèðåêòîðèþ, ââåäèòå èìÿ ôàéëà è íàæìèòå OK. 

5. Êîíôèãóðàöèÿ áóäåò ñîõðàíåíà â âèäå ôàéëà ñ ðàñøèðåíèåì .PIN.

Ðåäàêöèÿ êîíôèãóðàöèè êîíòàêòîâ

1. Âêëþ÷èòå ðåæèì Design Mode.

2. Âûáåðèòå Devices>Control Pin Configuration èç ãëàâíîãî ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ îêíî óïðàâëÿþùèõ êîíòàêòîâ (Control Pins).

3. Âûáåðèòå îïöèþ Configuration>Recall From Device â ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ îêíî âûáîðà ïðèáîðîâ (Select Devices).

4. Âûáåðèòå ïðèáîð è íàæìèòå OK.

5. Ïðîèçâåäèòå íåîáõîäèìûå èçìåíåíèÿ â îêíå êîíòàêòîâ (Control Pins).

6. Âûáåðèòå îïöèþ Configuration>Store To Device â ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ äèàëîãîâîå îêíî Select Devices.

7. Âûáåðèòå ïðèáîð è íàæìèòå OK.
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Îòêëþ÷åííîå
ñîåäèíåíèå

Îòêëþ÷åííîå
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Òèï êîíòðîëëåðà: Íåò Ïîòåíöèîìåòð 20 êÎì Ïåðåêëþ÷àòåëü Êíîïêà

Ïóíêò âûáðàí äëÿ ìàðøðóòèçàöèè

Ïóíêò íå âûáðàí äëÿ ìàðøðóòèçàöèè

1. Óñòàíîâèòå êóðñîð íà øêàëå è íàæìèòå ëåâóþ êíîïêó ìûøè, ïîñëå ÷åãî îòêðîåòñÿ
äèàëîãîâîå îêíî, êàê ïîêàçàíî íà ðèñóíêå ñïðàâà.

2. Ââåäèòå ñîîòâåòñòâóþùèé äèàïàçîí ðåãóëèðîâêè óñèëåíèÿ äëÿ ïîäêëþ÷åííîãî ïî-
òåíöèîìåòðà.

4. Íàæìèòå OK.



Типы кодировки
Ïðåäóñìîòðåíî òðè âèäà êîäèðîâêè äëÿ óïðàâëÿþùåãî âõîäà è äâà âèäà äëÿ âûõîäà. Âûáèðàéòå òèï êîäèðîâêè â çàâèñèìîñòè îò
òèïà óïðàâëÿþùåãî îáîðóäîâàíèÿ, êîëè÷åñòâà óïðàâëÿåìûõ ïðåñåòîâ è êîëè÷åñòâà êîíòàêòîâ, íåîáõîäèìûõ äëÿ óïðàâëåíèÿ äðó-
ãèìè ôóíêöèÿìè.

Ïðèîðèòåòíàÿ êîäèðîâêà

Ìàêñèìàëüíîå êîëè÷åñòâî óïðàâëÿåìûõ ïðåñåòîâ: 8

Êîëè÷åñòâî çàäåéñòâîâàííûõ êîíòàêòîâ: îò 1 äî 8 (ïî îäíîìó íà êàæäûé ïðåñåò)

Äàííûé âèä êîäèðîâêè ïðåäóñìàòðèâàåò óïðàâëåíèå êàæäûì ïðåñåòîì ÷åðåç îòäåëüíûé êîí-
òàêò. Ïîä êàæäûì áëîêîì êîíòàêòà èìååòñÿ ïàíåëü ñ íîìåðîì ïðåñåòà, ïðèîðèòåòíîñòü êîòî-
ðûõ èçìåíÿåòñÿ ñëåâà íà ïðàâî (ñìîòðè ðèñóíîê). Äàííûå óñòàíîâêè ìîãóò áûòü èçìåíåíû
ââåäåíèåì íîâîãî ÷èñëîâîãî çíà÷åíèÿ îò 1 äî 128 â ïàíåëü íîìåðà ïðåñåòà. 

Äâîè÷íàÿ êîäèðîâêà

Ìàêñèìàëüíîå êîëè÷åñòâî óïðàâëÿåìûõ ïðåñåòîâ: 128

Êîëè÷åñòâî çàäåéñòâîâàííûõ êîíòàêòîâ: ñîîòâåòñòâåííî ïðèâåäåííîé òàá-
ëèöå

Äàííûé âèä êîäèðîâêè óñòàíàâëèâàåòñÿ ïî óìîë÷àíèþ ïðè ââîäå áîëåå 9
ïðåñåòîâ â ïàíåëü # Presets.

• Ëîãè÷åñêèé 0 = êîíòàêò ðàçîìêíóò

• Ëîãè÷åñêàÿ 1 = êîíòàêò çàçåìëåí

Êîäèðîâêà ñ ïðèìåíåíèåì ñàìîñòîÿòåëüíî èçãîòîâëåííîãî ïåðåêëþ÷àòåëÿ (òîëüêî äëÿ âõîäíûõ êîíòàêòîâ)

Ìàêñèìàëüíîå êîëè÷åñòâî óïðàâëÿåìûõ ïðåñåòîâ: 10

Êîëè÷åñòâî çàäåéñòâîâàííûõ êîíòàêòîâ: 1

Äàííûé ìåòîä ïðåäóñìàòðèâàåò èñïîëüçîâàíèå ïåðåêëþ÷àòåëÿ ñ ðàçëè÷íûìè íîìèíàëàìè ðåçèñòîðîâ äëÿ óïðàâëåíèÿ ïðåñåòà-
ìè. Íîìèíàëû ðåçèñòîðîâ è îñîáåííîñòè ïîäêëþ÷åíèÿ ïåðåêëþ÷àòåëÿ ïðåäîñòàâëåíû â ðóêîâîäñòâå ïî àïïàðàòíîé ÷àñòè P4800.

Типы соединений
Êîíòàêòû, íåçàäåéñòâî-
âàííûå äëÿ óïðàâëåíèÿ
ïðåñåòàìè ìîãóò áûòü
èñïîëüçîâàíû äëÿ óï-
ðàâëåíèÿ äðóãèìè
ôóíêöèÿìè, â ñîîòâåò-
ñòâèè ñ ïðåäñòàâëåííîé
ñïðàâà òàáëèöå.

Карта маршрутиM
зации 
Äëÿ âíåøíåãî óïðàâëåíèÿ êàæäûé ïðåñåò ïðîöåññîðà äîëæåí áûòü íàçíà÷åí íà ñîîòâåòñòâóþùèé óïðàâëÿþùèé êîíòàêò. Êàðòà
ìàðøðóòèçàöèè ñîõðàíÿåòñÿ â êàæäîì ïðåñåòå èëè ñöåíå. 

Äëÿ ìàðøðóòèçàöèè ïðåñåòà:

1. Ñîçäàéòå øàáëîí.

2. Îòêðîéòå êàæäûé ïðåñåò è äîáàâüòå â íåãî êàðòó ìàðøðóòèçàöèè.

3. Îòêðîéòå êàæäûé ôàéë ñöåíû è äîáàâüòå â íåãî êàðòó ìàðøðóòèçàöèè.

Ïðèìå÷àíèå: Ïåðåä ñîçäàíèåì êàðòû ìàðøðóòèçàöèè íåîáõîäèìî ñêîíôèãóðèðîâàòü óïðàâëÿþùèå êîíòàêòû.

Создание шаблона карты маршрутизации
Äàííûé øàáëîí ìîæåò ñîõðàíÿòü â ñåáå íàçâàíèÿ êàíàëîâ, ìàðøðóòèçàöèþ è äðóãèå îñîáåííîñòè ïðåñåòà.

Äëÿ ñîçäàíèÿ øàáëîíà:

1. Â ðåæèìå Design Mode ïðèñâîéòå íàçâàíèå âõîäíîìó è âûõîäíîìó êàíàëàì.

2. Âûáåðèòå Devices>Control Pin Configuration â ãëàâíîì ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ îêíî Control Pins.

3. Çàãðóçèòå ñîîòâåòñòâóþùóþ êîíôèãóðàöèþ êîíòàêòîâ îäíèì èç ñëåäóþùèõ ñïîñîáîâ:

• Ïðè îòêëþ÷åííîì ïðîöåññîðå P4800 âûáåðèòå îïöèþ Configuration>Open From PC â ìåíþ.

• Ïðè ïîäêëþ÷åííîì ïðîöåññîðå P4800 âûáåðèòå îïöèþ Configuration>Recall From Device â ìåíþ.

4. Â ñåêöèè ïðîöåññîðíîé ìàðøðóòèçàöèè ïîÿâÿòñÿ âõîäíîé è âûõîäíîé êàíàëû.

5. Äëÿ êàæäîãî áëîêà ñîåäèíåíèé íàæìèòå ïóíêòû ïðîöåññîðíîé ìàðøðóòèçàöèè, ðàñïîëîæåííûå ñðàçó ïîñëå êàíàëîâ.

6. Çàêðîéòå îêíî Control Pins.

7. Ñîõðàíèòå ôàéë ñöåíû â êîìïüþòåðå.

8. Èñïîëüçóéòå ñîçäàííûé øàáëîí äëÿ êàæäîãî ïðåñåòà ïðîöåññîðà P4800.

Создание карты пресета или файла сцены
Ìîãóò áûòü ñîçäàíû êàðòû óæå èìåþùèõñÿ ïðåñåòîâ ïîñëå òîãî, êàê îíè áûëè ñîõðàíåíû â ïðîöåññîðå P4800 èëè â êîìïüþòåðå.

Äëÿ ñîçäàíèÿ êàðòû óæå èìåþùåãîñÿ ïðåñåòà â ðåæèìå Live Mode:

1. Âêëþ÷èòå ðåæèì Live Mode ñ èñïîëüçîâàíèåì ïðîöåññîðà P4800.

2. Âûáåðèòå ïðåñåò.

3. Îñíîâíîå îêíî âêëþ÷èòñÿ â ðåæèì ïðåäâàðèòåëüíîãî ïðîñìîòðà.

4. Óáåäèòåñü, ÷òî âûáðàí íóæíûé ïðåñåò è íàæìèòå Load, ïîñëå ÷åãî âûáðàííûé ïðåñåò àêòèâèðóåòñÿ.
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5. Âûáåðèòå Devices>Control Pin Configuration â ãëàâíîì ìåíþ.

6. Îòêðîåòñÿ îêíî Control Pins ñî ñïèñêîì âõîäíûõ è âõîäíûõ êàíàëîâ.

7. Äëÿ êàæäîãî ðàçìåùåííîãî áëîêà ñîåäèíåíèé íàæìèòå ïóíêòû ñîçäàíèÿ êàðòû.

Äëÿ ñîçäàíèÿ êàðòû óæå èìåþùåãîñÿ ïðåñåòà â ðåæèìå Design Mode:

8. Âêëþ÷èòå ðåæèì Design Mode.

9. Íàæìèòå Open â ïàíåëè óïðàâëåíèÿ ãëàâíîãî ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ äèàëîãîâîå îêíî Open Scene.

10. Âûáåðèòå ôàéë ñöåíû è íàæìèòå OK.

11. Âûáåðèòå Devices>Control Pin Configuration â ãëàâíîì ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ îêíî Control Pins.

12. Çàãðóçèòå íóæíóþ êîíôèãóðàöèþ êîíòàêòîâ èñïîëüçóÿ îäèí èç ñëåäóþùèõ ñïîñîáîâ:

• Ïðè îòêëþ÷åííîì ïðîöåññîðå P4800 âûáåðèòå îïöèþ Configuration>Open From PC â ìåíþ.

• Ïðè ïîäêëþ÷åííîì ïðîöåññîðå P4800 âûáåðèòå îïöèþ Configuration>Recall From Device â ìåíþ.

13. Äëÿ êàæäîãî ðàçìåùåííîãî áëîêà ñîåäèíåíèé íàæìèòå ïóíêòû ñîçäàíèÿ êàðòû.

14. Âåðíèòåñü â ãëàâíîå îêíî.

15. Ñîõðàíèòå ôàéë ñöåíû â êîìïüþòåðå.

Защита
Çàùèòà ÿâëÿåòñÿ îïöèîíàëüíîé ôóíêöèåé, ïîçâîëÿþùåé îãðàíè÷èòü äîñòóï êîíå÷íîãî ïîëüçîâàòåëÿ ê óñòàíîâêàì ïðîöåññîðà ÷å-
ðåç êîìïüþòåð.

Первый уровень
Íà ýòîì óðîâíå êîíå÷íûé ïîëüçîâàòåëü èìååò íåîãðàíè÷åííûé äîñòóï ê ôóíêöèÿì ïðîöåññîðà P4800 çà èñêëþ÷åíèåì äâóõ çàùè-
ùåííûõ ïàðîëåì ôóíêöèé: óñòàíîâêà óðîâíÿ çàùèòû è èçìåíåíèå àäìèíèñòðàòîðñêîãî ïàðîëÿ.

Второй уровень
Îáåñïå÷èâàåò îãðàíè÷åííûé ïîëüçîâàòåëüñêèé äîñòóï, îïðåäåëÿåìûé àäìèíèñòðàòîðîì. Âòîðîé óðîâåíü çàùèòû ïðåäóñìàòðèâàåò:

• Ñìåíó ïðåñåòîâ ÷åðåç êîìïüþòåð.

• Èçìåíåíèå ñõåìû ìàðøðóòèçàöèè â ìàòðè÷íîì ìèêøåðå.

• Äîñòóï ê ìîäèôèêàöèè óñòàíîâîê ïðîöåññîðíûõ ìîäóëåé íå çàáëîêèðîâàííûõ àäìèíèñòðàòîðîì.

Третий уровень
Äàííûé óðîâåíü çàùèòû îáåñïå÷èâàåò òîëüêî ïîëüçîâàòåëüñêèé äîñòóï äëÿ ÷òåíèÿ òåêóùåãî ïðåñåòà.

Ïðèìå÷àíèå: Çàùèòà îãðàíè÷èâàåò äîñòóï òîëüêî ñ ïðîãðàììíîãî èíòåðôåéñà. Äîñòóï ê óïðàâëåíèþ ïðîöåññîðîì âíåøíèìè
óñòðîéñòâàìè íå îãðàíè÷èâàåòñÿ.

Установка защиты
Ñîçäàíèå ïàðîëÿ

1. Âêëþ÷èòå ðåæèì Live Mode ñ ïîäêëþ÷åííûì ïðîöåññîðîì P4800.

2. Âûáåðèòå Security>Set Password â ãëàâíîì ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ äèàëîãîâîå îêíî
Create Password, êàê ïîêàçàíî íà ðèñóíêå ñïðàâà

4. Ââåäèòå ïàðîëü â ñòðîêó Administrator Password.

5. Ïîäòâåðäèòå ïàðîëü â ñòðîêå Confirm Password.

6. Çàïîëíèòå ñòðîêè Administrator Name è Phone èëè Contact info.

Ïðèìå÷àíèå: Êîëè÷åñòâî áóêâ êàæäîãî ñëîâà íå äîëæíà ñîñòàâëÿòü áîëåå 15 ñèìâîëîâ.

Установка уровня пользовательского доступа
Äëÿ óñòàíîâêè óðîâíÿ äîñòóïà:

1. Âêëþ÷èòå ðåæèì Live Mode ñ ïîäêëþ÷åííûì ïðîöåññîðîì P4800.

2. Âûáåðèòå Security>Level â ãëàâíîì ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ îêíî Password Required,
êàê ïîêàçàíî íà ðèñóíêå.

3. Ââåäèòå ïàðîëü è íàæìèòå OK.

4. Îòêðîåòñÿ äèàëîãîâîå îêíî Set Security, êàê ïîêàçàíî íà ðèñóíêå ñïðàâà

5. Óñòàíîâèòå íåîáõîäèìûé óðîâåíü.

6. Ïðè íåîáõîäèìîñòè óñòàíîâèòå äîïîëíèòåëüíûå îïöèè.

7. Íàæìèòå OK.

Изменение параметров защиты
Ñìåíà ïàðîëÿ

1. Âêëþ÷èòå ðåæèì Live ñ ïîäêëþ÷åííûì ïðîöåññîðîì P4800.

2. Âûáåðèòå Security>Set Password â ãëàâíîì ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ äèàëîãîâîå îê-
íî Set Password, êàê ïîêàçàíî íà ðèñóíêå.

3. Ââåäèòå òåêóùèé ïàðîëü.

4. Ââåäèòå íîâûé ïàðîëü â ñòðîêå Administrator Password.

5. ïîäòâåðäèòå íîâûé ïàðîëü â ñòðîêå Confirm Password.

6. Ïðè íåîáõîäèìîñòè âíåñèòå èçìåíåíèÿ â ñòðîêàõ Administrator Name è Phone or Contact
info.

7. Íàæìèòå OK.
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Ñíÿòèå çàùèòû

1. Âêëþ÷èòå ðåæèì Live ñ ïîäêëþ÷åííûì ïðîöåññîðîì P4800.

2. âûáåðèòå Security>Set Password â ãëàâíîì ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ äèàëîãîâîå îêíî Set Password.

3. Ââåäèòå òåêóùèé ïàðîëü â ñòðîêó Old Password è íàæìèòå OK.

4. Ïðè íåîáõîäèìîñòè óäàëèòå èíôîðìàöèþ èç ñòðîê Administrator Password è Confirm Password.

5. Íàæìèòå OK.

Индивидуальная защита
Îïöèÿ èíäèâèäóàëüíîé çàùèòû ïðåäóñìàòðèâàåò îãðàíè÷åíèå äîñòóïà ê îäíîìó, íåñêîëüêèì èëè âñåì ïðîöåññîðíûì áëîêàì
ïðåñåòà.

Äëÿ îãðàíè÷åíèÿ äîñòóïà ê ïðîöåññîðíûì áëîêàì:

1. Âêëþ÷èòå ðåæèì Live Mode ñ ïîäêëþ÷åííûì ïðîöåññîðîì P4800.

2. Óáåäèòåñü, ÷òî â P4800 óñòàíîâëåí ïåðâûé óðîâåíü çàùèòû.

3. Âûäåëèòå îäèí èëè íåñêîëüêî ïðîöåññîðíûõ áëîêîâ.

4. Âûáåðèòå Security>Level 2>Lock Selected â ãëàâíîì ìåíþ.

5. Óñòàíîâèòå âòîðîé óðîâåíü çàùèòû P4800.

Распечатка данных
Ïðîãðàììíîå îáåñïå÷åíèå P4800 ïðåäóñìàòðèâàåò îïöèþ ðàñïå÷àòêè íà ïðèíòåðå èíôîðìàöèè î ñîõðàíåííûõ ïðåñåòàõ è óñòà-
íîâêàõ. 

Äëÿ ðàñïå÷àòêè äàííûõ:

1. Âûáåðèòå File>Print â ãëàâíîì ìåíþ, ïîñëå ÷åãî îòêðîåòñÿ äèàëîãîâîå îêíî Choose Report,
êàê ïîêàçàíî íà ðèñóíêå.

2. Âûáåðèòå íóæíûé òèï îò÷åòà, ïîñëå ÷åãî îòêðîåòñÿ ñîîòâåòñòâóþùåå îêíî.

3. Îïðåäåëèòå èíôîðìàöèþ äëÿ ðàñïå÷àòêè.

4. Íàæìèòå OK.
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